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1 Getting Started

What Is Simulink Design Verifier?

Simulink Design Verifier is a product that extends Simulink by performing
exhaustive formal analyses of your models to confirm that they behave
correctly.

Simulink Design Verifier allows you to perform the following tasks:
® Generate test cases that achieve model coverage and custom objectives

you specify in a model.

® Prove properties that you specify in a model, and identify examples of any
property violations.

® Detect unreachable design elements in a model, such as inaccessible
subsystems, illegal switch conditions, and unachievable states.

® Produce detailed reports regarding test case generation and property proofs.



Before You Begin

Before You Begin

What You Need to Know

Getting started with Simulink Design Verifier requires that you have some
experience using model coverage, as well as building and running models
in Simulink.

To learn more about these topics, see the following:

e “Using Model Coverage” in the Simulink Verification and Validation User’s
Guide

® QGetting Started with Simulink and Using Simulink

Required Products

You must have the following products installed to use Simulink Design
Verifier:

e MATLAB®
e Simulink

e Simulink Verification and Validation

If you want to use Simulink Design Verifier with Stateflow® charts, then
Simulink Design Verifier requires the following software product:

e Stateflow

1-3



1 Getting Started

Starting Simulink Design Verifier
Simulink Design Verifier is part of your MATLAB installation.
To open the Simulink Design Verifier block library:

® On Microsoft Windows, type simulink at the MATLAB prompt to display
the Simulink Library Browser, and then select the Simulink Design
Verifier entry in the contents tree.

E!Simulink Library Browser =10] x|

File Edit Wiew Help

O S 4 84 |

Yerification Subsystem: Groups Design Verifier blocks into a subsystem whose
contents are excluded from the code Real-Time Workshop generatesz. Thiz
subsyztem can include other blocks that compute input zignals for the Design
Yerifier blocks.

- Nl simulink R

EJ Real-Time Workshop Veiification Subsystem
- Wl Simulink Design Yerifier

- N Simulink Extras Agsumption

----- W@ Simulink Verification and Yalidation

----- B stakeflow Froof Objective

- Tl irtual Reality Toolbo::

Test Candition

Test Objective

Ready v

¢ On any other platform, type sldvlib at the MATLAB prompt to display
the Simulink Design Verifier library.



Starting Simulink Design Verifier

E!Lihrary: sldvlib

File Edit wiew Format Help

=10l x|

DS EHE| BB E2 4|22 nEE

ine

Ready

Test Objective: Specify signal values for
test generation

Test Condition: Canstrain signal walues
during test generation

Froof Objective: Specify signal values for
property proving

Froof Aszumption: Constrain signal values
during property proving

erification Subsystem

[100%

|Locked

A




1 Getting Started

1-6

Running a Demo Model

® “About This Demo” on page 1-6

® “Opening the Model” on page 1-6

® “Generating Test Cases” on page 1-7

e “Exploring the Test Harness” on page 1-9

¢ “Interpreting the Simulink Design Verifier Report” on page 1-12

About This Demo

The sections that follow describe a demo model, Flip Flop Test Generation
Example, which illustrates how Simulink Design Verifier can be used to
generate test cases that achieve complete model coverage. This demo will
help you understand how to analyze models with Simulink Design Verifier
and interpret the results.

Opening the Model

To open the Flip Flop Test Generation Example model, enter
sldvdemo_flipflop at the MATLAB prompt.

Simulink displays the Flip Flop Test Generation Example model.



Running a Demo Model

E!sldvdemu_ﬂipﬂup ;Iglll

File Edit VYiew Simulation Format Tools Help

D|D”E§|¥:E|<}=='.>{H9Q PII'I INormaI j|@

Simulink Design Verifier
Flip Flop Test Generation Example

D e L L
bLx l—picm u
L Flip-Flop .
ICLR

This model is configured to generate test cases that achieve complete model
coverage. Each outcome of each model coverage point is a test ohjective.
Ifyou configure Simulink Design Yerifier to generate the fewest test

caszes itwill satisfy as many objectives as possible in each test case.

Run Yiew Options
{double-click) {double-click)

Run Simulink Design Yerifier View Simulink Design Verifier Options

Ready 100% Fixedstephiscrete
A

Generating Test Cases

To generate test cases for the Flip Flop Test Generation Example model, in
the model window double-click the block labeled Run.

Simulink Design Verifier begins analyzing the model to generate test cases.
During its analysis, Simulink Design Verifier displays the following log
window:
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E! simulink Design ¥erifier log: sldvdemo_Fipflop x|

Poges:

Objectives proceszed 12412

Satizfied 12
Falsified 0
Elapzed time 05

02-4pr-2007 17:14:04
Starting test generation for madel “'zgldvwdermao_flipflop"

Carnpiling maodel...done
Tranzlating model...done
Generating tests. ..

== T agt generation objective S atisfied ##5* —
PATH: zldvdemo_flipflop/D Flip-Flop/D Flip-Flop
LABEL: SubSyztem "D Flip-Flop™ Condition 1, F

== T agt generation objective S atisfied ##5*
PATH: zldvdemo_flipflopsD Flip-Flop/D Flip-Flop
LABEL: SubSystem "D Flip-Flop': trigger edge occuned while enabled, falze

=== Tagh generation objective 5 atigfied ==~
PATH: zldvdemo_flipflop/D Flip-Flop/T Flip-Flop
LABEL: SubSysztem "D Flip-Flop': Condition 1. T

=== T gt generation objective 5 atigfied =
PATH: zldvdemo_flipflop/D Flip-Flop/T Flip-Flop
LABEL: SubSysztem "D Flip-Flop': Condition 2, F

El
Stop |

The log window updates you on the progress of Simulink Design Verifier as it
analyzes the model. Also, the log window includes a Stop button that you can
click to terminate the analysis at anytime.

When Simulink Design Verifier completes its analysis, it displays the
following items:

® Test harness model named sldvdemo_flipflop_harness.mdl

® Report named sldvdemo flipflop report.html

The sections that follow describe each of these items.
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Exploring the Test Harness

Simulink Design Verifier creates a test harness model when it completes its
analysis. The test harness for the Flip Flop Test Generation Example model
appears as follows:

E!sldvdemu_ﬂipﬂup_harness 101 =l
File Edit VYiew Simulation Format Tools Help
D|D”E§|%E|<}==i>{r|fﬁfl|r II'I INormaI j|@|§
Size-Type
u] u}
0
] CLK CLK o
ICLR ICLR o———»{( 2 )
i}
Inputs Test Unit (copied from sldvdemao_flipflap)
[
Loc
Text
Test Case Explanation
Ready [100% | [ |FixedstepDiscrete G

1 The block labeled Test Case Explanation is a DocBlock that documents the
test cases Simulink Design Verifier generated. Double-click the Test Case
Explanation block to view a description of each test case in terms of the
objectives that it satisfies.
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‘B Editor - C:\TEMP',docblock-2254-00061035.kxt ] 73
File Edt Text Go Cell Tools Debug Desktop ‘Window Help ] | A X
DS EH| I RR o oS Aed i B8 ADE BB | st | BODB =0
1 Test Case 1 (2 Objectives)

2 1. SubSystem "D Flip-Flop": trigger edge occurred while enabled, false @T=0

3 2. SubSystem "D Flip-Flop™: Condition 1, F @T=0

4

5 Test Case 2 (3 Chjectiwves)

[ 1. Sub3ystem "D Flip-Flop", MCDC trigger edge occurred while enabled with Condition Z, F @T=0

7 2, SubSystem "D Flip-Flop™: Condition 2, F @T=0

8 3. Jub3ystem "D Flip-Flop": Condition 1, T BT=0

a

10 Test Case 3

11 1. Sub3ystem "D Flip-Flop", MCDC crigger edge occurred while enabled with Condition 1, F T=0.1
12

13 Test Case 4 (5 Objectives)

14 1. Logic "Logic™: Condition 1, F @T=0.1

15 2. Zub3ystem "D Flip-Flop": Condition 2, T BT=0.1

18 3. SubSystem "D Flip-Flop"™, MCDC trigger edge occurred while enabled with Condition 1, T @T=0.1
17 4, Sub3vstem "D Flip-Flop", MCDC trigger edge occurred while enabled with Condition 2, T BT=0.1
15 5. SubSystem "D Flip-Flop™: trigger edge occurred while enabled, true BT=0.1

19

20 Test Case 5

21 1. Logic "Logic™: Condition 1, T @T=0.1

| plain text file: In 4 Gl 1 [oVR

2 The block labeled Test Unit is a Subsystem block that contains a copy of

the original model Simulink Design Verifier analyzed. Double-click the
Test Unit block to view its contents and confirm that it is a copy of the Flip

Flop Test Generation Example model.

3 The block labeled Inputs is a Signal Builder block that contains the test

case signals Simulink Design Verifier generated. Double-click the Inputs
block to open the Signal Builder dialog box and view the test case signals.

4 Look at the signal values for a particular test case. In the Signal Builder

dialog box, select the tab associated with a test case. For example, select

Test Case 4.

The Signal Builder dialog box displays the signal values for Test Case 4.

1-10




Running a Demo Model

) signal Builder {sldvdemo_flipflop_harness/Inputs) i [m] B3]
File Edit Group Signal Axes Help ]
FH| B o o |~ FREE] >y o= G R
Test Case 1 ){Test Case 2 ‘Test Caze 3 )/Test Case 4 Y\Test Case 5 \ | |
. E—— — —_—— '
e T R R i
—— - I [ S I |
ST S S A 5
R N . .
-1 ——— - jromoeeees - S B [foroetoe] |
1 ICLR YT R R EE R dooiooooes
T e
o I I I — i oo [rrooeeee roooeee- [rooomo |
0 .02 0.04 0.05 n0.os 01 012 014 0.16 018 0.2
Time (sec)
LLeft Point Right; Point
CLE {shotm)
Hame, | T: | | ICLR {showm)
Index: I 'l ‘|":| "|":|
|
Click to select signal

In Test Case 4 at 0.1 seconds,

® The D signal transitions from 0 to 1.

® The CLK signal transitions from -1 to O.
® The !CLR signal transitions from 0 to 1.

This group of signals achieves the test objectives described in the Test
Case Explanation block.

5 To confirm that Simulink Design Verifier achieved complete model

coverage, simulate the test harness using all the test cases. In the Signal
all

Builder dialog box, click the Run all button i}
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1 Getting Started

Simulink simulates the test harness using all the test cases, collects model
coverage information, and displays a coverage report with the following

summary:

Summary
Model Hierarchy/Complesxity: Test 1
01 c1 MCcOC

1. sldvdemo flipflop harness 2 100% DI 100% I 1009
2. ... Test Unit(eopied from sldvdeme flipflopy 2 100% ———" . 100 —— 00% —
[ JE L Flip-Flo 2 100% D 100% . 100
do L Flip-Flop 2 100% e 100% ——_— 100%

The coverage report indicates Simulink Design Verifier generated test
cases that achieve complete coverage for the Flip Flop Test Generation
Example model.

Interpreting the Simulink Design Verifier Report

Simulink Design Verifier creates an HTML report that summarizes its
analysis results. The report includes the following Table of Contents whose
items you can click to navigate to particular chapters and sections:

Table of Contents

1. Summary
2. Test/Proof Objectives

otatus
sldvdermo_flipflap

D Flip-Flop
3. Test Cases f Counterexarmples

Test Case 1
Test Caze 2
Test Case 3
Test Casze 4
Test Case 5

4. Approximations

1 In the Table of Contents, click Summary.

The report displays its Summary chapter, as shown here.

1-12



Running a Demo Model

Chapter 1. Summary

Input Model

File: chmatlabMoolboxtsldisdvdermosisldvdermao_flipflap. mdl
“ersion: 1.12

Time Stamp: Sat Mar 3 02:53:36 2007

Authar:

Analysis Information

Design YWerifier Wersion: 1.0

Total Analysis Time: 0.46 secs

Status: Completed narmally
Approximations: 1

Objectives Satisfied: 12

DObjectives Proven Unsatisfiable: 0
Objectives Producing Errors: 0

Output Files

Harness model: chsldv_outputisldvdemo_flipflopisldvdemo_flipflop_harness.mdl
Data file: chsldy_outputisldvdemo_flipflopisldvdemo_flipflop_sldvdata. mat
Report: chsldy_outputisldvdemo_flipflophsldvdemo_flipflop_report. html

The Summary chapter provides an overview of the Simulink Design
Verifier analysis. For instance, the chapter includes information about the
model it analyzed, the results it obtained, the files it generated, and the
options it used.

2 Under Analysis Information, click Objectives Satisified.

The report displays the following table under its Test/Proof Objectives
chapter:

1-13
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Chapter 2. Test/Proof Objectives

Tahle of Contents

Status

sldvderno_flipflap

O Flip-Flap

Status

Tahle 2.1. Objectives Satisfied

#: Type Model Item Description

1 Condition Logic Logic "Lagic", Condition 1, T

2 Condition Logic Logic "Lagic", Condition 1, F

3 Condition D Flip-Flop SubSystem "D Flip-Flop", Condition 1, T

4 Condition D Flip-Flop SubSystem "D Flip-Flop", Condition 1, F

=3 Condition D Flip-Flop SubSystem "D Flip-Flop", Condition 2, T

a1 Condition D Flip-Flop SubSystem "D Flip-Flop", Condition 2, F

. . SubSystem "D Flip-Flop”, trigger edge
z Decisian D Flip-Fla occurred while enabled, F
. . SubSystem "D Flip-Flop”, trigger edge

g Decisian D Flip-Fla occurred while enabled, T
. SubSystem "D Flip-Flop”, trigger edge

= Mcde D Flip-Fla occurred while enabled with Condition 1, T
. SubSystem "D Flip-Flop”, trigger edge

10 Mcde D Flip-Fla occurred while enabled with Condition 1, F
. SubSystem "D Flip-Flop", trigger edge

1 Mede D Flip-Flo occurred while enabled with Condition 2, T
. SubSystem "D Flip-Flop", trigger edge

12 Mede D Flip-Flo occurred while enabled with Condition 2, F

The Objectives Satisfied table lists model coverage objectives that
Simulink Design Verifier satisfied. That is, Simulink Design Verifier
generated test cases that achieve each of the model coverage objectives

shown here.

3 Under the # column of the Objectives Satisfied table, click objective 5.

The report displays the following table under its Test/Proof Objectives

chapter:
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sldvdemo_flipflop

Objectives of: D Flip-Flap

#: Status Test Cases Description

3 Satisfied TC 2 Condition 1, T

4 Satisfied TC 1 Condition 1, F

a Satisfied TC 4 Condition 2, T

4] Satisfied TC 2 Condition 2, F

7 Satisfied TC1 trigger edge occurred while enabled, F

& Satisfied Tc4 trigger edge accurred while enabled, T

9 Satisfied TC 4 trigger edge occurred while enabled with Condition 1, T
10 Satisfied TC3 trigger edge occurred while enabled with Condition 1, F
11 Satisfied TC 4 trigger edge occurred while enabled with Condition 2, T
12 Satisfied TCc2 trigger edge occurred while enabled with Condition 2, F

This table lists all the model coverage objectives associated with the D
Flip-Flop subsystem in the demo model. It displays a description and
status for each objective, as well as the test case that achieves the objective.
Objective 5 applies only to the D Flip-Flop subsystem, so it is listed here.

4 Under the Test Cases column of the table, click TC 4.

The report displays its Test Case 4 section under the Test Cases /
Counterexamples chapter, as shown here.

1-15
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Test Case 4
Summary
Length: 0.2 Seconds (3 sample periods)

Objective Count: 5
Objectives Reached At:

Step Time Objectives

L I [ w R | O ]

=y
—

Generated Input Data.

Time |0 0.1
Step |1 2
B 0 1
CLK -1 0
ICLR 0 1

This section provides details about a test case that Simulink Design
Verifier generated. For example, Test Case 4 satisfies five model coverage

objectives. In this test case, the following signal values achieve objectives 2,
5,8,9, and 11:

¢ The D signal transitions from 0 to 1 at 0.1 seconds.
¢ The CLK signal transitions from -1 to 0 at 0.1 seconds.

¢ The !CLR signal transitions from 0 to 1 at 0.1 seconds.
This information matches what you see in the test harness model.
Specifically, the Inputs block depicts identical signal values for Test Case 4,

and the Test Case Explanation block lists five objectives that Test Case 4
achieves (see “Exploring the Test Harness” on page 1-9).

1-16
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Basic Workflow for Using Simulink Design Verifier

The Simulink Design Verifier User’s Guide is organized on the basis of
workflow that you follow when generating tests for your model or proving
its properties. This workflow is described in the following steps, which cite
locations in the documentation that you can refer to for more information:

Step | Action See...
1 Check the compatibility of your model. Chapter 2, “Ensuring Compatibility with
Simulink Design Verifier”
2 Optionally, prepare your model for Chapter 3, “Working
analysis. with Block Replacements”
Chapter 4, “Specifying Parameter
Configurations”
3 Set Simulink Design Verifier options. Chapter 5, “Configuring Simulink Design
Verifier”
4 Generate test cases for your model or Chapter 6, “Generating Test Cases”
prove its properties.
Chapter 7, “Proving Properties of a Model”
5 Interpret the results. Chapter 8, “Reviewing the Results”

1-17
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Learning More
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® “Next Step” on page 1-18
¢ “Product Help” on page 1-18

o “The MathWorks Online” on page 1-18

Next Step

To begin learning how to use Simulink Design Verifier, see Chapter 2,
“Ensuring Compatibility with Simulink Design Verifier”. Also see the
following topics to continue your exploration of Simulink Design Verifier:

FOI‘...

See...

Exercise that walks you through the
process of generating test cases for
a model

“Generating Test Cases Example” on
page 6-4

Exercise that walks you through the
process of proving a model property

“Proving Model Properties Example”
on page 7-4

Product Help

More information is available with your product installation. In MATLAB,

click for help, and then click the product name in the Contents pane.
For... See...
List of blocks Blocks — Alphabetical List

Tutorials

Examples in Documentation

More product demonstrations

Simulink Design Verifier Demos

What’s new in this product

Release Notes

The MathWorks Online

Point your internet browser to the MathWorks Web site for additional

information and support at



Learning More

http://www.mathworks.com/products/sldesignverifier/
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Ensuring Compatibility
with Simulink Design
Verifier

Simulink Design Verifier supports a broad range of Simulink and Stateflow
features. However, there are features that Simulink Design Verifier does not
support. Therefore, you must avoid using particular features in models that
you plan to analyze with Simulink Design Verifier. The following sections
identify the unsupported features and describe how to check whether your
model is compatible for use with Simulink Design Verifier.

Unsupported Simulink Features Lists the Simulink features that

(p. 2-2) Simulink Design Verifier does not
support.

Unsupported Stateflow Features Lists the Stateflow features that

(p. 2-3) Simulink Design Verifier does not
support.

Checking Model Compatibility Describes how to check whether your

(p. 2-5) model is compatible with Simulink

Design Verifier.



2 Ensuring Compatibility with Simulink Design Verifier

Unsupported Simulink Features

e “List of Unsupported Simulink Features” on page 2-2

¢ “Limitations of Simulink Block Support” on page 2-2

List of Unsupported Simulink Features

Simulink Design Verifier does not support the following Simulink features.
Avoid using these unsupported Simulink features in models that you analyze
with Simulink Design Verifier.

Feature Not Supported

Remarks

Variable-step solvers

Simulink Design Verifier supports only
fixed-step solvers (see “Choosing a Fixed-Step
Solver” in Using Simulink).

Complex signals

Simulink Design Verifier supports only real
signals (for contrast, see “Complex Signals” in
Using Simulink).

Fixed-point data types

Simulink Design Verifier supports only the
built-in data types that Simulink recognizes
(see “Data Types Supported by Simulink” in
Using Simulink).

Limitations of Simulink Block Support

Simulink Design Verifier provides various levels of support for Simulink
blocks. That is, Simulink Design Verifier either fully or partially supports
particular blocks, while it does not support others. Refrain from using
unsupported Simulink blocks in models that you analyze with Simulink
Design Verifier. Similarly, specify only the block parameters that Simulink
Design Verifier recognizes for blocks that it partially supports. See Chapter
12, “Simulink Block Support” for a list of Simulink blocks and details
regarding whether Simulink Design Verifier provides support.
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Unsupported Stateflow Features

Simulink Design Verifier does not support the following Stateflow features.
Avoid using these unsupported Stateflow features in models that you analyze
with Simulink Design Verifier.

Feature Not Supported

Remarks

ml namespace operator,
ml function, ml
expressions

Simulink Design Verifier does not support calls
to MATLAB functions or access to MATLAB
workspace variables, which Stateflow allows
(see “Using MATLAB Functions and Data in
Actions” in the Stateflow and Stateflow Coder
User’s Guide).

Embedded MATLAB
functions

Simulink Design Verifier does not support
Embedded MATLAB functions, which Stateflow
allows (see “Using Embedded MATLAB
Functions” in the Stateflow and Stateflow Coder
User’s Guide).

C math functions

Simulink Design Verifier does not support calls
to C math functions, which Stateflow allows
(see “Calling C Functions in Actions” in the
Stateflow and Stateflow Coder User’s Guide).

Recursion

Simulink Design Verifier does not support
recursive functions, which Stateflow allows
you to implement using graphical functions
(see “Using Functions to Extend Actions”

in the Stateflow and Stateflow Coder User’s
Guide). Also, Simulink Design Verifier does
not support recursion that Stateflow allows
you to implement using a combination of event
broadcasts and function calls.

Fixed-point data types

Simulink Design Verifier does not support
fixed-point data types, which Stateflow allows
(see “Using Fixed-Point Data in Stateflow”

in the Stateflow and Stateflow Coder User’s
Guide).
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Feature Not Supported

Remarks

Custom C or C++ code

Simulink Design Verifier does not support
custom C or C++ code, which Stateflow allows
(see “Integrating Custom Code with Stateflow
Targets” in the Stateflow and Stateflow Coder
User’s Guide).

Machine-parented data
and events

Simulink Design Verifier does not support
machine-parented data and events (i.e.,
defined at the level of the Stateflow machine
in the Stateflow hierarchy), which Stateflow
allows (see “Defining Events and Data” in the
Stateflow and Stateflow Coder User’s Guide).
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Checking Model Compatibility

Simulink Design Verifier provides a mechanism that checks whether your
model is compatible for analysis. To check the compatibility of your model,
from the Tools menu of your Simulink model, select Design Verifier >
Check Model Compatibility.

E!sldvdemu_cruise_cunl:rul,.-"l:unl:rullEr
File Edit Miew Simulation Formak | Tools Help

b Sirnulink. Deb L
0| H & | & B i< >minsoeuess o | |05 [ &
Fixed-Point Setkings. ..

Model Advisor,..

enable ——  Model Dependency Viewer, ..

1 -
Lookup Table Editor. .. lctive Control

E L # ANL Data Class Designet. ..

brake '
Bus Editor. ..

the
“ Coverage Setkings. .. e
Requirements k
Active last ste
l Inspect Logaed Signals. ..
Signal & Scope Manager, ..
() oy
speed Data Object \Wizard
Design Yerifier Check Model Compatibilicy
(3
sat Generate Tests
mj\ Prove Properties
: —

Simulink Design Verifier displays a log window that confirms whether your
model is compatible for analysis.
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=1 simulink Design Yerifier log: sldvdemo_cruise x|

24-]an-2007 17:09:13
Checking compatibility of model "sldvdemo_cruize_control*

Compiling model... done
Checking compatibility. .. done

kodel 'sldvdemo_cruize_control” i compatible with Simulink, Dezign YVerifier,

Save Log Cloze

Otherwise, Simulink Design Verifier alerts you to any incompatibilities that
it identifies in your model. For example, suppose that the preceding model
specifies the use of an incompatible feature, such as a variable-step solver.
When checking the compatibility of your model in this case, Simulink Design
Verifier displays incompatibility errors in the Simulation Diagnostics Viewer
(see “Simulation Diagnostics Viewer” in Using Simulink).
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1 Simulink Design Yerifier Errors: sldydemo_cruise_control - |EI|£|
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Using the information that the Simulation Diagnostics Viewer displays, you
can determine the cause of an incompatibility and correct it.

Note Simulink Design Verifier checks the compatibility of a model
incrementally. When it detects an incompatibility, it displays an error message
and stops the check without completing all the steps. If you receive an error,
correct the problem and then recheck whether your model is compatible.

Alternatively, you can use the sldvcompat function to run the compatibility
checker programmatically at the command line or in an M-file program.
See sldvcompat in Chapter 9, “Functions — Alphabetical List” for more
information.
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Working with Block
Replacements

Simulink Design Verifier allows you to define rules that replace blocks
automatically in your model. For example, you can work around an
incompatibility by creating a rule that replaces an unsupported Simulink
block in your model with a supported block that is functionally equivalent.
Or you can customize blocks for analysis by creating a rule that adds
constraints or objectives to particular blocks in your model. The following
sections introduce block replacements and illustrate a process for writing
block replacement rules.

About Block Replacements (p. 3-2) Brief overview of block replacements.

Built-In Block Replacements (p. 3-3) Describes the factory default block
replacement rules and library.

Template for Block Replacement Introduces a template for creating
Rules (p. 3-6) custom block replacement rules.
Creating Custom Block Outlines a process for creating
Replacements (p. 3-7) custom block replacements.
Executing Block Replacements Describes how to execute block

(p. 3-14) replacements.
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About Block Replacements

Simulink Design Verifier can perform block replacements automatically

in a model. That is, it can replace instances of a particular block in your
model with an entirely different block. When performing block replacements,
Simulink Design Verifier copies your model and replaces blocks in the copy,
leaving your original model unaltered. In this way, you can easily customize a
model for analysis with Simulink Design Verifier.

Simulink Design Verifier replaces blocks automatically in a model using

e Libraries of replacement blocks
¢ Rules that define which blocks to replace and under what conditions
Block replacements are extensible, allowing you to define your own libraries

of replacement blocks and custom block replacement rules. This capability is
beneficial if you need to

¢ Work around an incompatibility, such as the presence of unsupported
blocks in your model.

e Customize a block for analysis, such as adding constraints to its input
signals or objectives to its output signals.



Built-In Block Replacements

Built-In Block Replacements

Simulink Design Verifier provides a set of block replacement rules and

a corresponding library of replacement blocks. These built-in block
replacements are useful when analyzing models with Simulink Design
Verifier. Moreover, they serve as examples that you can examine to learn how
to create your own block replacements.

The following table lists the factory default block replacement rules, available
in the matlabroot\toolbox\sldv\sldv\private directory.

File Name Description
blkrep_rule lookup_normal.m A rule that replaces Lookup Table blocks with
blkrep_rule lookup_configss.m an implementation that includes test objectives

for each breakpoint and interval specified by the
Vector of input values parameter.

blkrep _rule lookup2D normal.m A rule that adds Test Condition/Proof Assumption
blkrep_rule_lookup2D_configss.m blocks to the input ports of Lookup Table (2-D)
blocks. Each Test Condition/Proof Assumption
block constrains signal values to the interval
specified by the corresponding breakpoint vector.

blkrep_rule mpswitch2 normal.m A rule that adds a Test Condition/Proof
blkrep_rule mpswitch2 configss.m Assumption block to the control input port

of Multiport Switch blocks whose Number

of inputs parameter specifies 2. The Test
Condition/Proof Assumption block constrains
signal values to the interval [1, 2] (or [0, 1] if the
block uses zero-based indexing).

blkrep_rule mpswitch3 normal.m A rule that adds a Test Condition/Proof
blkrep_rule mpswitch3 configss.m Assumption block to the control input port

of Multiport Switch blocks whose Number

of inputs parameter specifies 3. The Test
Condition/Proof Assumption block constrains
signal values to the interval [1, 3] (or [0, 2] if the
block uses zero-based indexing).
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File Name

Description

blkrep_rule_mpswitch4_normal.m
blkrep_rule_mpswitch4_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the control input port

of Multiport Switch blocks whose Number

of inputs parameter specifies 4. The Test
Condition/Proof Assumption block constrains
signal values to the interval [1, 4] (or [0, 3] if the
block uses zero-based indexing).

blkrep_rule_mpswitch5_normal.m
blkrep_rule_mpswitch5_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the control input port

of Multiport Switch blocks whose Number

of inputs parameter specifies 5. The Test
Condition/Proof Assumption block constrains
signal values to the interval [1, 5] (or [0, 4] if the
block uses zero-based indexing).

blkrep_rule_switch_normal.m
blkrep_rule_switch_configss.m

A rule that replaces Switch blocks with an
implementation that includes test objectives,
requiring each switch position to be exercised
when the values of the first and third input ports
differ.

blkrep_rule_selector
IndexVecPort_normal.m

blkrep_rule_selector
IndexVecPort_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the index port of Selector
blocks whose Index Option parameter specifies
Index vector (port). The Test Condition/Proof
Assumption block constrains signal values to an
interval whose endpoints are derived from the
values of the Selector block’s Input port size and
Index mode parameters.

blkrep_rule_selector
StartingIdxPort_normal.m

blkrep_rule_selector
StartingIdxPort_configss.m

A rule that adds a Test Condition/Proof
Assumption block to the index port of Selector
blocks whose Index Option parameter
specifies Starting index (port). The Test
Condition/Proof Assumption block constrains
signal values to an interval whose endpoints are
derived from the values of the Selector block’s
Input port size, Qutput size, and Index mode
parameters.
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The library of replacement blocks that corresponds to the factory default
rules resides at

matlabroot/toolbox/sldv/sldv/sldvblockreplacementlib.mdl

Note Simulink Design Verifier provides two implementations of each factory
default block replacement rule. Rules whose file names end with _normal.m
replace blocks with Subsystem blocks. Rules whose file names end with
_configss.m replace blocks with Configurable Subsystem blocks. See
“Writing Block Replacement Rules” on page 3-10 for more information.
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Template for Block Replacement Rules

To help you create block replacement rules, Simulink Design Verifier provides
an annotated M-file template containing a skeleton implementation of the
requisite callbacks. The template resides at

matlabroot/toolbox/sldv/sldv/sldvblockreplacetemplate.m

To create a block replacement rule, make a copy of the template and edit the
copy as necessary to reflect the desired behavior of the rule you are creating.
The comments in the template help to explain how to implement your rule.
See “Writing Block Replacement Rules” on page 3-10 for information about
using the template to write custom block replacement rules.
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Creating Custom Block Replacements

This section demonstrates how to create custom block replacements in
Simulink Design Verifier. The process consists of two tasks, constructing

a replacement block and writing a block replacement rule. The following
sections guide you through the process of creating a custom block replacement:

Constructing Replacement Blocks Describes how to construct
(p. 3-7) replacement blocks.

Writing Block Replacement Rules Describes how to write block
(p. 3-10) replacement rules.

Constructing Replacement Blocks

Simulink Design Verifier imposes several restrictions on replacement blocks.
Replacement blocks must

¢ Use a masked Subsystem block that contains other Simulink blocks.

¢ Reside in a block library that is available on your MATLAB search path.

¢ Contain Inport and Outport blocks whose block names specify default
values (e.g., In1 and Out1).

Note Be sure that you have read “Creating Block Masks” in Using Simulink
before constructing a replacement block.

To create a replacement block:

1 Create a block library for your replacement block (see “Creating a Library”
in Using Simulink). For example, from the File menu of the Simulink
library window, select New > Library.

2 In your library, create a subsystem that represents your replacement block
(see “Creating Subsystems” in Using Simulink).

This example uses a subsystem named myReplacementBlock, which
contains a
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e Multiport Switch block whose Number of inputs parameter specifies 2

¢ Test Condition block whose Values parameter specifies {[1, 2]}

[JLibrary: untitled * =10l x|

File Edit Wiew Format Help

DEE&E + 28 &2 ¢ |0 nEBE

Ini
InZ Outl p
In3
.’ .
" myReplacementBlodk N

. .
. .
. .
. ~
. .
. .
. .
- LN
Ready o 100%s Unlocked &
’ 3
. .
. [N
, ~
0.
.
In1
[ 2 % 5 e 1 ]
InZ Outt
2 >
In2
hultiport
Sitch

3 Create a mask for your subsystem (see “Masking a Subsystem” in Using
Simulink).

In this example, the mask dialog box of the subsystem displays a mask
parameter that controls the Require all data port inputs to have the
same data type parameter of the underlying Multiport Switch block. The
masked subsystem includes the following specifications in its Mask Editor:
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¢ The Parameters pane defines a mask parameter named InputSameDT,
which replicates the behavior of the Require all data port inputs
to have the same data type parameter of the underlying Multiport
Switch block.

Mask Editor : myReplacementBlock 10l =l

Icon Parameters | Initialization | Decumentation |

Dialog parameters

Prompk ‘tariable Type Evaluate | Tunable
Require all data port inputs t... |InputSameDT checkbox - [ '

X
2
k4

~Opkions For selected parameter

Popups {one per ine):  In dialod: 17 show parameter [+ Enable parameter

Dialog
callback:

Unmask. | QK | Cancel | Help | Apply |

Note When creating mask parameters that control the behavior of
parameters associated with their underlying blocks, specify actual
parameter names as dialog variables in the Mask Editor. For instance,
InputSameDT is the actual parameter name that controls the Require
all data port inputs to have the same data type parameter of
the Multiport Switch block; hence, it specifies the name of the dialog
variable in this example.
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¢ The Initialization pane defines the following commands in the
Initialization commands field:

maskInputSameDT = get_param(gcb, 'InputSameDT');
blkName = sprintf('/Multiport\nSwitch')

targetBlock = [gcb, blkName];

set_param(targetBlock, 'InputSameDT',maskInputSameDT);

4 Save your block library, e.g., as custom_rule.mdl, in a directory that is
available on your MATLAB search path (see “Search Path” in the MATLAB

documentation).

After constructing your replacement block, you are ready to write a custom
block replacement rule, which the next section describes.

Writing Block Replacement Rules

Simulink Design Verifier imposes the following restrictions on block
replacement rules:

¢ The M-file that represents a block replacement rule must include particular
callbacks. The MathWorks recommends that you use the block replacement
rule template as a starting point for writing a custom rule (see “Template

for Block Replacement Rules” on page 3-6).

® The M-file that represents a block replacement rule must be available on

the MATLAB search path.

® You cannot create a rule that replaces Inport, Output, or Subsystem blocks

in your model.

To write a rule for the replacement block you created in the previous section
(see “Constructing Replacement Blocks” on page 3-7):

1 Make a copy of the block replacement rule template

matlabroot/toolbox/sldv/sldv/sldvblockreplacetemplate.m

saving it with an appropriate file name, e.g., custom_rule switch.m.
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Note In the remaining steps, you edit the copy of the template that you
saved.

Rename the function, as defined on the first line of the M-file. The function
name should be the same as its file name, without the .m extension.
Optionally, you can edit the comments that follow the function declaration
to create your own M-file help for this rule.

In this example, the first few lines of custom_rule switch.m declare the
function and its M-file help, which appear as follows:

function rule = custom_rule_switch
%CUSTOM_RULE_SWITCH Custom block replacement rule for
%Simulink Design Verifier

o°

o°

This block replacement rule identifies Multiport
Switch blocks whose "Number of inputs" parameter
specifies '2' and "Use zero-based indexing" parameter
specifies 'off'. It replaces such blocks with an
implementation that includes a Test Condition block
on the control input signal.

d® o° o° o°

o°

Identify the type of block that you wish to replace in your model by
specifying its BlockType parameter as the rule.blockType object.
Consider using the get_param function to obtain the value of the BlockType
parameter for the block you intend to replace. Alternatively, you can
determine this value by referring to “Block-Specific Parameters” in the
Simulink Reference.

This example replaces Multiport Switch blocks, so the rule.blockType
object specifies the appropriate BlockType parameter:

%% Target Block Type

o°

rule.blockType = 'MultiPortSwitch';
Identify the replacement block by specifying its full block path name as the

rule.replacementPath object. Consider using the gcb function to get the
full block path name.
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This example replaces Multiport Switch blocks with the replacement
block developed in “Constructing Replacement Blocks” on page 3-7, so the
rule.replacementPath object specifies the full block path name:

%% Replacement Library

o°

rule.replacementPath = sprintf('custom_rule/myReplacementBlock');

5 Identify the type of subsystem that Simulink Design Verifier uses when
replacing blocks by specifying a value for the rule.replacementMode
object. Valid values include:

® Normal — When using this rule, Simulink Design Verifier replaces blocks
with a copy of the subsystem specified by the rule.replacementPath
object.

® ConfigurableSubSystem — When using this rule, Simulink Design
Verifier replaces blocks with a Configurable Subsystem block (see
Configurable Subsystem in the Simulink Reference). The Configurable
Subsystem block allows you to choose whether it represents the
subsystem specified by the rule.replacementPath object, or the original
block before its replacement.

This example replaces Multiport Switch blocks with an ordinary Subsystem
block:

%% Replacement Mode

o°

rule.replacementMode = ‘Normal’;

6 Identify parameter values that the replacement blocks inherit from the
blocks being replaced. You achieve inheritance by mapping the parameter
names in a structure. Each field of the structure represents a parameter
that the replacement block inherits. Specify the value of each field using
the token $original.parameter$, where parameter is the name of the
parameter that belongs to the original block. You can determine block
parameter names by referring to “Model and Block Parameters” in the
Simulink Reference.

The following example defines a structure named parameter that maps the

InputSameDT parameter from the original Multiport Switch blocks to their
replacement blocks:
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%% Parameter Handling

o°

parameter.InputSameDT = '$original.InputSameDT$';

% Register the parameter mapping for the rule
rule.parameterMap = parameter;

7 Customize the subfunction named replacementTestFunction by
specifying conditions under which Simulink Design Verifier replaces blocks
in your model.

The following example instructs Simulink Design Verifier to replace
only the Multiport Switch blocks whose NumInputPorts and zeroidx
parameters specify 2 and off, respectively:

function out = replacementTestFunction(blockH)
Specify the logic that determines when Simulink Design
Verifier replaces a block in your model. For example,
restrict replacements to only the blocks whose parameters
specify particular values.
out = false;
numInputPorts = eval(get_param(blockH, 'NumInputPorts'));
zeroldx = eval(get_param(blockH, 'zeroidx'));
if numInputPorts==2 && zeroIdx=='off',

out = true;

o® o° o°

o°

end

After constructing a replacement block and writing its corresponding block
replacement rule, you are ready to execute your custom block replacement
(see “Executing Block Replacements” on page 3-14).
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Executing Block Replacements

You can execute block replacements from the MATLAB command line or an
M-file program, or from the Simulink GUI. The following sections describe
how to configure block replacement options, execute block replacements, and
interpret the output that block replacements generate.

Configuring Block Replacements Describes how to configure block
(p. 3-14) replacement options.

Replacing Blocks in a Model (p. 3-15) Describes how to execute block
replacements in your model and
interpret the output messages.

Configuring Block Replacements

You must configure block replacement options before executing block
replacements in your model. To specify block replacement options using the
Simulink GUI:

1 From the Tools menu of your Simulink model, select Design
Verifier > Options.

The Configuration Parameters dialog box displays the Simulink Design
Verifier options.

2 In the Select tree of the Configuration Parameters dialog box, click the
Block Replacements category.

The Configuration Parameters dialog box displays the Block
replacements pane.

3 Enable block replacements by checking the Apply block replacements
option.

Enabling this option provides access to the List of block replacement
rules and File path of the output model options.

4 In the List of block replacement rules box, enter file names of the
block replacement rules that you wish to execute. You can specify multiple
rules as a list delimited by spaces, commas, or carriage returns. Simulink
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Design Verifier executes the rules in the order that you list them. For
example, to execute a subset of the factory default rules (see “Built-In Block
Replacements” on page 3-3) followed by the custom block replacement
example from “Creating Custom Block Replacements” on page 3-7, enter
the following file names:

blkrep_rule_mpswitch4_normal
blkrep_rule_lookup_normal
custom_rule_switch

Note Simulink Design Verifier replaces a block in your model only once. If
multiple rules apply to the same block, Simulink Design Verifier replaces
the block using the rule with the highest priority.

5 In the File path of the output model box, specify a directory to which
Simulink Design Verifier saves the model that results after applying the
block replacement rules.

6 Click the OK button to apply the changes and close the Configuration
Parameters dialog box.

Alternatively, you can use the sldvoptions function at the command

line to specify the block replacement options associated with a Simulink
Design Verifier options object. See sldvoptions in Chapter 9, “Functions —
Alphabetical List” for more information.

Replacing Blocks in a Model

After enabling the Apply block replacements option (see “Configuring
Block Replacements” on page 3-14), you can execute block replacements in
your model by starting a Simulink Design Verifier analysis. For example, to
trigger block replacements from the Configuration Parameters dialog box, on
the Design Verifier pane, click the Analyze Model button.

When performing block replacements, Simulink Design Verifier copies your

model and replaces blocks in the copy, leaving your original model unaltered.
Upon completing its analysis, Simulink Design Verifier generates a report
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that displays information about the block replacements it executed (see
“Understanding Simulink Design Verifier Reports” on page 8-6).

Alternatively, you can use the sldvblockreplacement function to execute
block replacements from the command line or an M-file program. The syntax
of the function is

status = sldvblockreplacement('system')

where system is the name of the model whose blocks you aim to replace. See
sldvblockreplacement for more information.

If you execute block replacements programmatically, Simulink Design Verifier
displays in the MATLAB Command Window a table that lists available block
replacement rules:

Configuration of available block replacement rules:

Type: Registration M-File name: Block types: Priority: Active:
Built-in blkrep_rule_mpswitch2_normal.m MultiPortSwitch 5 0
Built-in blkrep_rule_mpswitch2_configss.m MultiPortSwitch 4 0
Built-in blkrep_rule_mpswitch3_normal.m MultiPortSwitch 3 0
Built-in blkrep_rule_mpswitch3_configss.m MultiPortSwitch 6 0
Built-in blkrep_rule_mpswitch4_normal.m MultiPortSwitch 1 1
Built-in blkrep_rule_mpswitch4_configss.m MultiPortSwitch 7 0
Built-in blkrep_rule_mpswitch5_normal.m MultiPortSwitch 2 0
Built-in blkrep_rule_mpswitch5_configss.m MultiPortSwitch 8 0
Built-in blkrep_rule_lookup_normal.m Lookup 1 1
Built-in blkrep_rule_lookup_configss.m Lookup 2 0
Built-in blkrep_rule_switch_normal.m Switch 1 0
Built-in blkrep_rule_switch_configss.m Switch 2 0
Built-in blkrep_rule_lookup2D_normal.m Lookup2D 1 0
Built-in blkrep_rule_lookup2D_configss.m Lookup2D 2 0
Built-in blkrep_rule_selectorIndexVecPort_normal.m Selector 1 0
Built-in blkrep_rule_selectorIndexVecPort_configss.m Selector 2 0
Built-in blkrep_rule_selectorStartingIdxPort_normal.m Selector 3 0
Built-in blkrep_rule_selectorStartingIdxPort_configss.m Selector 4 0
Custom custom_rule_switch.m MultiPortSwitch 2 1

The list of available block replacement rules includes all built-in rules and any
custom rules that you specified using the List of block replacement rules
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option (see “Configuring Block Replacements” on page 3-14). The columns of
the preceding table identify the following information:

Type — the type of rule, either built-in or custom
Registration M-File name — the name of the M-file that expresses the rule

Block types — the BlockType parameter value of the block that the rule
replaces

Priority — the priority of execution when multiple rules target the same
type of block for replacement

Active — a flag that indicates whether the rule is active (1) or ignored (0)

Also, Simulink Design Verifier displays information about the block
replacements that it performed. For example, the following message indicates
that Simulink Design Verifier used the custom_rule switch.m rule to replace
a Multiport Switch block (of the same name) at the top level of the model:

Performed block replacements:

Replacement rule M-file name: Replaced block:
custom_rule_switch.m ./Multiport Switch
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Specifying Parameter
Configurations

Simulink Design Verifier allows you to treat block parameters in your model
as variables in its analysis. The following sections introduce parameter
configurations and illustrate a process for specifying constraints on block

parameters.
About Parameter Configurations Brief overview of parameter
(p. 4-2) configurations.
Template for Parameter Introduces the template for creating
Configurations (p. 4-3) a parameter configuration file.

Defining Parameter Configurations  Describes how to define parameter
(p. 4-4) configurations.

Parameter Configuration Example Provides an example that walks you
(p. 4-7) through the process of specifying a
parameter configuration.
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About Parameter Configurations

Simulink Design Verifier can treat block parameters in your model as
variables during its analysis. For example, suppose you specify a variable that
is defined in the MATLAB workspace as the value of a block parameter in
your model. You can instruct Simulink Design Verifier to treat that parameter
as another input variable in its analysis. This allows you to

¢ Extend the results of a proof to consider the impact of additional parameter
values.

® Generate comprehensive test cases for situations in which parameter
values must vary to achieve more complete coverage results (for an
example, see “Parameter Configuration Example” on page 4-7).
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Template for Parameter Configurations

To help you create a parameter configuration file, Simulink Design Verifier
provides an annotated M-file template. The template resides at

matlabroot/toolbox/sldv/sldv/sldv_params_template.m

Alternatively, you can access the template from the Parameters pane in the
Simulink Design Verifier options (see “Parameters Pane” on page 5-8).

To create a parameter configuration file, make a copy of the template and
edit the copy. The comments in the template explain the syntax for defining
parameter configurations. For more information about defining parameter
configurations, see “Defining Parameter Configurations” on page 4-4.
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Defining Parameter Configurations

This section describes how to define parameter configurations and outlines
the required syntax for their definition.

1 Define parameter configurations in an M-file function.

Simulink Design Verifier provides an annotated template for an M-file
function that you can use as a starting point (see “Template for Parameter
Configurations” on page 4-3).

2 Specify parameter configurations using a structure whose fields share the
same names as the parameters that you treat as input variables.

For example, suppose you wish to constrain the Gain and Constant value
parameters, m and b, which appear in the following model:

In1 Cut1

b |Constant

In your parameter configuration file, use the following names for the fields
of the structure:

params.m
params.b

3 Constrain parameters by assigning values to the fields of the structure.

Specify points using the S1ldv.Point constructor, which accepts a single
value as its argument. Specify intervals using the Sldv.Interval
constructor, which requires two input arguments, i.e., a lower bound and
an upper bound for the interval. Optionally, you can provide one of the
following strings as a third input argument that specifies inclusion or
exclusion of the interval endpoints:

e '()' — Defines an open interval.
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® '[1' — Defines a closed interval.
e '(]' — Defines a left-open interval.
e '[)' — Defines a right-open interval.

Note By default, Simulink Design Verifier considers an interval to be
closed if you omit its two-character string.

The following example constrains m to 3 and b to any value in the closed
interval [0, 10]:

params.m = Sldv.Point(3);
params.b = Sldv.Interval(0, 10);

If the parameters are scalar, you can omit the constructors and instead
specify single values or two-element vectors. For instance, you can
alternatively specify the previous example as:

params.m = 3;
params.b [0 10];

Use cell arrays to specify multiple constraints for a single parameter.

You can specify multiple constraints for a single parameter by using a
cell array. In this case, Simulink Design Verifier combines the constraints
using a logical OR operation during its analysis.

The following example constrains m to either 3 or 5, and it constrains b to
any value in the closed interval [0, 10]:

params.m = {3, 5};
params.b [0 10];

Use a 1-by-n structure to specify n sets of parameters.

You can specify several sets of parameters by expanding the size of your
structure.

For instance, the following example uses a 1-by-2 structure to define two
sets of parameters:
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params(1).m = {3, 5};
params(1).b = [0 10];
params(2).m = {12, 15, Sldv.Interval(50, 60, '()')};

params(2).b = 5;

The first parameter set constrains m to either 3 or 5, and it constrains

b to any value in the closed interval [0, 10]. The second parameter set
constrains m to either 12, 15, or any value in the open interval (50, 60), and
it constrains b to 5.
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Parameter Configuration Example

To understand how to specify parameter configurations for use with Simulink
Design Verifier, you build a simple Simulink model and generate test cases
that achieve complete decision coverage. The following sections guide you
through the process of completing this example:

Constructing the Example Model
(p. 4-7)

Parameterizing the Constant Block
(p. 4-9)

Specifying a Parameter
Configuration (p. 4-11)

Analyzing the Example Model
(p. 4-12)

Simulating the Test Cases (p. 4-14)

Guides you through Task 1 of the
example, in which you construct the
example model.

Guides you through Task 2 of the
example, in which you specify a
variable as the value of a Constant
block parameter.

Guides you through Task 3 of the
example, in which you constrain
the value of the variable that the
Constant block specifies.

Guides you through Task 4 of the
example, in which you generate test
cases for your model and interpret
the results.

Guides you through Task 5 of the
example, in which you simulate the
test cases and measure the resulting
decision coverage.

Constructing the Example Model

This section presents Task 1 of the process that describes how to specify
parameter configurations in Simulink Design Verifier. In this task, you
construct a simple Simulink model that you use throughout the remaining
tasks. To complete this task, perform the following steps:

1 Create an empty Simulink model (see “Creating an Empty Model” in Using

Simulink for help with this step).

4-7
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2 Copy the following blocks into your empty model window (see “Adding
Blocks” in the Simulink documentation for help with this step):

® Two Inport blocks to initiate the input signals, from the Sources library

¢ A Multiport Switch block to provide simple logic, from the Signal
Routing library

® A Constant block to control the switch, from the Sources library

® An Outport block to receive the output signal, from the Sinks library

3 In your model window, double-click the Multiport Switch block to access its
dialog box and specify its Number of inputs option as 2.

4 In your model window, connect the blocks so that your model looks like this
(see “Connecting Blocks” in Using Simulink for help with this step):

1

Constant
R
D »
In1 — Outd
hultipart
Switch
In2

5 In your model window, select Simulation > Configuration Parameters.
Simulink displays the Configuration Parameters dialog box.

6 In the Select tree on the left side of the Configuration Parameters dialog
box, click the Solver category (if not already selected). Under Solver
options on the right side, set the Type option to Fixed-step, and then set
the Solver option to discrete (no continuous states).

The Configuration Parameters dialog box appears as follows:
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#4, Configuration Parameters: example /Configuration {Active) il

Seleck — Simnulation time
- Solver Stark time: IEI.EI Stop time: I'I 0.0
- Data Import/Export
I:I!:utlmlzat.lun — Solver optiohz
[=- Diagnostics
E""Sample Tirne Type:l Fired-step LI Su:ulver:l discrete [no continuous states] LI
i Data W alidity - ) ) -
Type Conversion Periodic zample time constraint: I Unconstrained LI
i Connectivity Fixed-step size [fundamental sample time]: Iautu:u
i Compatibility . e .
. Tazking mode for penodic zample tmes: | Auto -
- Model Referencing = P P I —I
--Hardware Implementation [~ Higher pricrity value indicates higher task priority
- Model Referencing I~ Automatically handle data tansters between tasks

Cancel Help Apply

7 Click the OK button to apply your changes and close the Configuration
Parameters dialog box.

8 Save your model as param_example.mdl (see “Saving a Model” in Using
Simulink for help with this step).

What to do next: Now you are ready to begin Task 2 of this example,
“Parameterizing the Constant Block” on page 4-9.

Parameterizing the Constant Block

This section presents Task 2 of the process that describes how to specify
parameter configurations in Simulink Design Verifier. In this task, you
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parameterize the Constant block in the model that you created in the previous
task (see “Constructing the Example Model” on page 4-7). In particular,

you specify a variable as the value of the Constant block’s Constant value
parameter. To complete this task, perform the following steps:

1 In your model window, double-click the Constant block.
The Constant block parameter dialog box appears.
2 In the Constant value box, enter A.

The Constant block parameter dialog box appears as follows:

=1 source Block Parameters: Constant x|

Congtant

Output the conztant zpecified by the 'Canstant value' parameter. [f 'Constant valug' iz
a vector and 'Interpret vectar parameters az 1-0° is on, reat the constant value az a
1-D array. Otherwize, output a matrix with the zame dimensions az the conztant

b it | Signal Data Typesz

Constant walue:
[

¥ Interpret vector parameters as 1-0

Sampling mode: ISampIe bazed ;I

Sample time:

inf

k. Cancel | Help

3 Click the OK button to apply your change and close the Constant block
parameter dialog box.

4 In the MATLAB Command Window, enter

A= 1;
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This command defines in the MATLAB workspace a variable named A
whose value is 1. Simulink resolves the Constant value parameter to this
variable, initializing its value for simulation.

What to do next: Now you are ready to begin Task 3 of this example,
“Specifying a Parameter Configuration” on page 4-11.

Specifying a Parameter Configuration

This section presents Task 3 of the process that describes how to specify
parameter configurations in Simulink Design Verifier. In this task, you
customize the parameter configuration file template so that it constrains
the variable that you specified in the previous task (see “Parameterizing the
Constant Block” on page 4-9). To complete this task, perform the following
steps:

1 In your Simulink model window, select Tools > Design Verifier >
Options.

Simulink Design Verifier displays its options in the Configuration
Parameters dialog box.

2 In the Select tree on the left side of the Configuration Parameters
dialog box, click the Design Verifier > Parameters category. In the
Parameters pane on the right side, ensure that the Apply parameters
option is enabled.

Enabling the Apply parameters option provides access to the Parameter
configuration file option.

3 Click the Edit button next to the Parameter configuration file option.
Simulink Design Verifier opens sldv_params_template.min an editor.
4 Edit the template’s text so that it appears as follows:

function params = param_example_function
% This function defines a parameter configuration for the
% example model that the documentation discusses.

params.A = [1 2];
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The preceding code renames the function as params_example_function
and constrains parameter A to the closed interval [1 2].

5 Save your changes to the template as params_example function.m in the
same directory as the example model.

6 In the Configuration Parameters dialog box, click the Browse button
next to the Parameter configuration file option, and then select your
parameter configuration file, params_example function.m.

7 Click the OK button to apply your change and close the Configuration
Parameters dialog box.

What to do next: Now you are ready to begin Task 4 of this example,
“Analyzing the Example Model” on page 4-12.

Analyzing the Example Model

This section presents Task 4 of the process that describes how to specify
parameter configurations in Simulink Design Verifier. In this task, you
execute the Simulink Design Verifier analysis, which uses the parameter
configuration file you customized in the previous task (see “Specifying a
Parameter Configuration” on page 4-11). Simulink Design Verifier generates
test cases and produces results for you to interpret. To complete this task,
perform the following steps:

1 In your Simulink model window, select Tools > Design Verifier >
Generate Tests.

Simulink Design Verifier begins analyzing your model to generate test
cases. When Simulink Design Verifier completes its analysis, it generates
the following items:

® Simulink Design Verifier report — Simulink Design Verifier displays an
HTML report named param_example report.html.

® Test harness — Simulink Design Verifier displays a harness model
named param_example harness.mdl.

2 In the Simulink Design Verifier report Table of Contents, click Test
Case 1.
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The report displays its Test Case 1 section, which appears as follows:

Test Case 1

Summary

Length: 0.2 Jeconds (2 sample periods)
Ohjecttve Count: 1

Parameters:

Parameter|Value
A 1

Ohjectives Reached At:

Step|Time Objectives
1 0 2

Generated Input Data.

(=]

Time
~tep

Inl |-
In2 |-

[

This section provides details about Test Case 1 that Simulink Design
Verifier generated to satisfy a coverage objective in the model. In this test
case, a value of 1 for parameter A satisfies the objective.

3 Go to the Test Case 2 section in the Test Cases / Counterexamples
chapter.

The Test Case 2 section of the report appears as follows:
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Test Case 2

Summary

Length: 0.2 Zeconds (2 sample periods)
Objective Count: 1

Parameters:

Parameter|Value
A 2

Ohjectives Reached At:

&tep | Time Objectives
1 0 1

Generated Input Data.

(=]

Time
~tep

Inl |-
Inz |-

[

This section provides details about Test Case 2, which satisfies another
coverage objective in the model. In this test case, a value of 2 for parameter
A satisfies the objective.

What to do next: Now you are ready to begin Task 5 of this example,
“Simulating the Test Cases” on page 4-14.

Simulating the Test Cases

This section presents Task 5 of the process that describes how to specify
parameter configurations in Simulink Design Verifier. In this final task,
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you simulate the test cases that Simulink Design Verifier generated in the
previous task (see “Simulating the Test Cases” on page 4-14). Also, you review
the coverage report that results from the simulation. To complete this task,
perform the following steps:

1 Open the test harness model named param_example_harness.mdl (if it
is not already open).

The test harness model appears as follows:

_lalx]
File Edit Wiew Simulation Format Tools Help
DEEHES| B2 (&4 =2y sho (BB @
Size-Type
In1 In1
—"" Dut1
[ In InZ
Inputs Test Unit (copied fram param_gxample)
[
Lac
Text
Tast Case Explanation
Ready [100% | | [FixedstepDiscrete L

2 The block labeled Inputs in the test harness model is a Signal Builder
block that contains the test case signals. Double-click the Inputs block to
view the test case signals.

The Signal Builder dialog box appears as follows:
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) Signal Builder {param_example_harness;/Inputs} - |EI|£|
File Edit Group Signal Axes Help w

FH| BB o o |— I 0

fod ot T [

ar i ¥o LN

j{Test Case 1 \{\TE‘:ST Case 2 \ | |
1 T T N S
LIRS N N A
0 : : : : : : : : : :
-1 T
L e R o
0 : : : : : : : : : :
4 i i i i i i i i i |
0 0.02 0,04 0,065 003 0.1 012 014 0145 013 0.2
Time (sec)
et Point Right; Foint
Inz {=hown
Hame: | T I T I
Index: . Y: ¥: hd
[ | | Al | ,|—|

Click to select signal |

all
3 In the Signal Builder dialog box, click the Run all button |

Simulink simulates each of the test cases in succession, collects coverage
data for each simulation, and displays a report of the combined coverage
results at the end of the last simulation.

4 In the model coverage report, review the Summary section:
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Summary
Model Hierarchy/Complexity: Test1
D1
1. param_example harness 2 100% ——

2. ... Test Unit (copied from param _example) 1 100% S—

This section summarizes the coverage results for the harness model and its
Test Unit subsystem. Observe that the subsystem achieves 100% decision
coverage.

5 In the Summary, click the Test Unit subsystem.

The report displays detailed coverage results for the Test Unit subsystem.
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2. Subsystem "Test Unit {copied from param_example}"

Parent: fparam_example_harness

Metric Coverage (this ohject) Coverage (inc. descendants)
Cyclomatic Complexity 0 1

Decision (D1) A 100% (2/2) decision outcomes

Mpswitch block "Multiport Switch™

Parent: param_example_harnessTest Unit (copied from param_example)
Metric Coverage

Cyclomatic Complexity 1

Decision (DO1) 100% (252 decision outcomes

Decisions analyzed:

truncated input value 100%
=1 {output is from input port 2) A1102
=2 [output is from input port 3) 514102

This section reveals that the Multiport Switch block achieves complete
decision coverage because the test cases exercise each of its switch
pathways.



Configuring Simulink
Design Verifier

This chapter provides an overview of the Simulink Design Verifier options
that you specify typically with the Configuration Parameters dialog box. The
following sections step you through the Simulink Design Verifier dialog panes
and describe its options.

Viewing Simulink Design Verifier Explains how to view the options

Options (p. 5-2) that control Simulink Design
Verifier.

Configuring Simulink Design Describes the options that control

Verifier Options (p. 5-5) Simulink Design Verifier.

Saving Simulink Design Verifier Discusses how Simulink Design

Options (p. 5-15) Verifier saves its options.
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Viewing Simulink Design Verifier Options

Simulink Design Verifier provides numerous options that control its behavior
when analyzing models. To view its options, from the Tools menu of your
Simulink model, select Design Verifier > Options.

E!sldvdemu_cruise_cunl:rul,.-"l:unl:ruller
File Edit Miew Simulation Format | Tools Help

& |E’v [ §| W ) | o Simulink Debugger... I'IEI.EI | 0

Fixed-Point Settings...
Model Advisor, .,
enable ——  Model Dependencies r
1) I
Lookup Table Editar. .. Active Control
E L # ANL Data Class Designer. ..
LT Bus Editor
the
m Coverage Settings... Cctive
Requirements +
Active last ste
l Inspect Logaed Siamals.. .
Signal & Scope Managet. ..
(1) o
speed Draka Object Wizard
Design Verifier Check Maodel Compatibility:
(3
sat aenerate Tests
Prove Properties
RO

Simulink Design Verifier displays its options in the Configuration Parameters
dialog box.
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#4, Configuration Parameters: sldvdemo_cruise_control/Configuration (Active) il

Select: | — Analyziz option
- Solver -
b ode: Test generation -
- Data Impoart/E=part I _I
- Optimization b awimLim analyziz tirme: IEEI
- Diagnostics ¥ Dizplay unsatisfiable test objectives
i Sample Time
i Diata v alidity — Output
Type Conversion )
- Connectivity Output directory: zldv_output/thodel amed
Campatibility [~ Make output file names unique by adding a suffix
i Model Feferencing
- Hardware [mplementation Check Model Compatibility |
- Maodel Referencing
=- 1 erifier Analyze Model |

Black Replacements
Parameters

Test Generation

i Property Proving
Results

‘e Report

(1] I Cancel Help Apply

Typically, you specify values for these options using the Configuration
Parameters dialog box. See “Configuration Parameters Dialog Box” in the
“Running Simulations” chapter of Using Simulink for more information about
working with this interface.
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Note By default, Simulink Design Verifier options do not appear in a
model’s Configuration Parameters dialog box. If you select Design Verifier
> Options from a model’s Tools menu, Simulink Design Verifier associates
its options with that model. Afterward, you can access those options directly
from the Configuration Parameters dialog box or Model Explorer (see “The
Model Explorer” in Using Simulink).

Alternatively, you can use the sldvoptions function to view Simulink Design
Verifier options at the command line. Use the following syntax to access and
view programmatically the Simulink Design Verifier options associated with
the Simulink model system:

opts = sldvoptions('system');
get(opts)

See sldvoptions in Chapter 9, “Functions — Alphabetical List” for more
information.
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Configuring Simulink Design Verifier Options

This section describes the options that control Simulink Design Verifier.
Groupings of options appear on panes of the Configuration Parameters dialog
box. See the following sections for information on how to set specific Simulink
Design Verifier options associated with those panes:

® “Design Verifier Pane” on page 5-5

¢ “Block Replacements Pane” on page 5-6

e “Parameters Pane” on page 5-8

® “Test Generation Pane” on page 5-9

e “Property Proving Pane” on page 5-10

e “Results Pane” on page 5-12

e “Report Pane” on page 5-14

Design Verifier Pane

The Design Verifier pane allows you to specify analysis options and
configure Simulink Design Verifier output.

— Analyziz ophion

b ode: IT ezt generation j

t aximurn analyzis time: IEEIEI

¥ Display unsatisfisble test objsctives

— Output

Clutput directory: ghdv_output/thdodelM amed

v tdake output file names unigue by adding & sulfis

Check Model Compatibility

Analyze Model

The Design Verifier pane contains the following groups of options:
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® “Analysis options” on page 5-6

® “Output” on page 5-6

Analysis options
This group contains controls that enable you to specify how Simulink Design
Verifier analyzes Simulink models. It contains the following controls.

Mode. Specifies the mode in which Simulink Design Verifier operates, either
Test generation (the default) or Property proving.

Maximum analysis time. Specifies the maximum time (in seconds) that
Simulink Design Verifier spends analyzing the model.

Display unsatisfiable test objectives. If selected, this option causes
Simulink Design Verifier to display a warning message in the Simulation
Diagnostics Viewer when it is unable to satisfy a test objective. See
“Simulation Diagnostics Viewer” in Using Simulink for more information.

Output
This group contains controls that enable you to configure Simulink Design
Verifier output. It contains the following controls.

Output directory. Specifies a directory to which Simulink Design Verifier
writes its output. Enter a path that is either absolute or relative to the
current directory.

The default value is sldv_output/$ModelName$, where $ModelName$ is a
token that represents the model name.

Make output file names unique by adding a suffix. If selected, this
option causes Simulink Design Verifier to append an incremental numeric
suffix to output file names. Selecting this option prevents Simulink Design
Verifier from overwriting existing files that have the same name.

Block Replacements Pane

The Block Replacements pane allows you to specify options that control
how Simulink Design Verifier preprocesses the models it analyzes.
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—Block replacements

[~ &pply block replacements

Lizt of block replacement miles [in order of priority];

—Output model

File path of the output model;

Block replacements

This group contains controls that enable you to specify block replacement
options. It contains the following controls.

Apply block replacements. If selected, this option causes Simulink Design
Verifier to replace blocks in the model before its analysis (see Chapter 3,
“Working with Block Replacements”). By default, this option is disabled.
Enabling this option provides access to the List of block replacement rules
and File path of the output model options.

List of block replacement rules. Specifies a list of block replacement rules
that Simulink Design Verifier processes before analyzing the model. This
option is accessible only if Apply block replacements is selected. Simulink
Design Verifier processes the block replacement rules in the order that you
list them.

Specify block replacement rules as a list delimited by spaces, commas, or
carriage returns (see “Configuring Block Replacements” on page 3-14).
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The default value is <FactoryDefaultRules>. If you specify the default value,
Simulink Design Verifier uses its factory default block replacement rules (see
“Built-In Block Replacements” on page 3-3).

File path of the output model. Specifies a directory to which Simulink
Design Verifier saves the model that results after applying the block
replacement rules. Enter a pathname that is either absolute or relative to the
pathname specified as the Qutput directory. This option is accessible only if
Apply block replacements is selected.

The default value is $ModelName$ replacement, where $ModelName$ is a
token that represents the model name.

Parameters Pane

The Parameters pane allows you to specify options that control how Simulink
Design Verifier uses parameter configurations when analyzing models.

Parameter

¥ fpply parameters

Parameter configuration file: | zldv_params_template.m Browze. . Edit...

Parameters

This group contains controls that enable you to specify parameter
configurations. It contains the following controls.

Apply parameters. If selected (the default), this option causes Simulink
Design Verifier to use parameter configurations when analyzing a model.
Enabling this option provides access to the Parameter configuration file
option.

Parameter configuration file. Specifies an M-file function that defines
parameter configurations for a model. Click the Browse button to select an
existing M-file function using a file chooser dialog box. Click the Edit button
to open the specified M-file function in an editor.
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The default value is sldv_params_template.m, a template that you can edit
and save. The comments in the template explain the syntax you use to specify
parameter configurations.

Tip See the Parameter Identification Example demo for an illustration of how
to use parameter configurations when generating tests cases for a Simulink
model.

Test Generation Pane

The Test Generation pane allows you to specify options that control how
Simulink Design Verifier generates tests for the models it analyzes.

— T est generation

Model coverage objectives: I MCDC

Test conditions: I Enable all

Ll L] L

Test objectives: I Enable all

b awimum test case steps: IEEIEI

L]

Teszt suite optimization: I Combined objectives

Test generation

This group contains controls that enable you to specify test generation options.
It contains the following controls.

Model coverage objectives. Specifies the type of model coverage that
Simulink Design Verifier attempts to achieve. Select either Decision,
Condition Decision, MCDC, or None.

Test conditions. This option allows you to enable or disable Test Condition
blocks in the current model either globally or locally. Select one of the
following options:
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® Use local settings — Enables or disables Test Condition blocks based
on the value of the Enable parameter of each block. If a block’s Enable
parameter is selected, the block is enabled; otherwise, the block is disabled.

® Enable all — Enables all Test Condition blocks in the model regardless of
the settings of their Enable parameters.

® Disable all — Disables all Test Condition blocks in the model regardless
of the settings of their Enable parameters.

Test objectives. This option allows you to enable or disable Test Objective
blocks in the current model either globally or locally. Select one of the
following options:

® Use local settings — Enables or disables Test Objective blocks based
on the value of the Enable parameter of each block. If a block’s Enable
parameter is selected, the block is enabled; otherwise, the block is disabled.

® Enable all — Enables all Test Objective blocks in the model regardless of
the settings of their Enable parameters.

® Disable all — Disables all Test Objective blocks in the model regardless
of the settings of their Enable parameters.

Maximum test case steps. Specifies the maximum number of simulation
steps Simulink Design Verifier takes when attempting to satisfy a test
objective.

Test suite optimization. This option allows you to specify whether each of
the test cases generated by Simulink Design Verifier maps to a single test
objective or multiple test objectives. Select one of the following options:

® Combined objectives — Generates test cases that can address more than
one test objective.

® Individual objectives — Generates test cases that each address only
one test objective.

Property Proving Pane

The Property Proving pane allows you to specify options that control how
Simulink Design Verifier proves properties for the models it analyzes.
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—Property proving

Agzertion blocks: I Enable all ;I
Froof azsumptions: I Enable all ;I
Stratequ: I Find wiolation ﬂ

b axirnurm violation steps: |2EI

Property proving

This group contains controls that enable you to specify property proving
options. It contains the following controls.

Assertion blocks. This option allows you to enable or disable Assertion
blocks in the current model either globally or locally. Select one of the
following options:

® Use local settings — Enables or disables Assertion blocks based on
the value of the Enable assertion parameter of each block. If a block’s
Enable assertion parameter is selected, the block is enabled; otherwise,
the block is disabled.

® Enable all — Enables all Assertion blocks in the model regardless of the
settings of their Enable assertion parameters.

® Disable all — Disables all Assertion blocks in the model regardless of the
settings of their Enable assertion parameters.

Proof assumptions. This option allows you to enable or disable Proof
Assumption blocks in the current model either globally or locally. Select one of
the following options:

® Use local settings — Enables or disables Proof Assumption blocks based
on the value of the Enable parameter of each block. If a block’s Enable
parameter is selected, the block is enabled; otherwise, the block is disabled.

® Enable all — Enables all Proof Assumption blocks in the model regardless
of the settings of their Enable parameters.

® Disable all — Disables all Proof Assumption blocks in the model
regardless of the settings of their Enable parameters.
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Strategy. Specifies the strategy Simulink Design Verifier uses when proving
properties. Select one of the following options:

® Find violation — If this strategy is selected, Simulink Design Verifier
searches for property violations within the number of simulation steps
specified by the Maximum violation steps option. Enabling this option
provides access to the Maximum violation steps option.

® Prove — If this strategy is selected, Simulink Design Verifier performs
property proofs.

® Prove with violation detection — This strategy combines the Find
violation and Prove strategies. If selected, Simulink Design Verifier
searches for property violations within the number of simulation steps
specified by the Maximum violation steps option; then it attempts to
prove properties for which it failed to detect a violation. Enabling this
option provides access to the Maximum violation steps option.

Maximum violation steps. Specifies the maximum number of simulation
steps over which Simulink Design Verifier searches for property violations.
Simulink Design Verifier does not search beyond the maximum number of
simulation steps that you specify; it does not identify violations that occur
later in a simulation. This option is accessible only if Strategy specifies
either Find violation or Prove with violation detection.

Results Pane

The Results pane allows you to specify options that control how Simulink
Design Verifier handles the results that it generates.

—Harnesz model options

[+ Sawve test harmess as model

Harnezs model file name: |$M odelMamed_hamess

—Data file optionz

[v Save test data ta file

[ ata file name: |$h-1 odelM amed_sldvdata
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The Results pane contains the following groups of options:

¢ “Harness model options” on page 5-13

e “Data file options” on page 5-13

Harness model options

This group contains controls that enable you to specify how Simulink Design
Verifier handles the test harness it produces. It contains the following
controls.

Save test harness as model. If selected, this option causes Simulink
Design Verifier to save the test harness it generates as a model file. Enabling
this option provides access to the Harness model file name option.

Harness model file name. Specifies a file name with which Simulink
Design Verifier saves the test harness it generates. Enter a pathname that is
either absolute or relative to the pathname specified by Output directory.
This option is accessible only if Save test harness as model is selected.

The default value is $Mode1lName$_harness, where $ModelName$ is a token
that represents the model name.

Data file options

This group contains controls that enable you to specify how Simulink Design
Verifier handles the MAT-file it produces. It contains the following controls.

Save test data to file. If selected, this option causes Simulink Design
Verifier to save the test data it generates to a MAT-file. Enabling this option
provides access to the Data file name option.

Data file name. Specifies a file name with which Simulink Design Verifier
saves the MAT-file it generates. Enter a pathname that is either absolute
or relative to the directory specified by Output directory. This option is
accessible only if Save test data to file is selected.

The default value is $ModelName$ sldvdata, where $ModelName$ is a token
that represents the model name.
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Report Pane

The Report pane allows you to specify options that control how Simulink
Design Verifier reports its results.

— Repart

¥ Display report

W Generate report of the results

Repart file narme; |$I'v1 odelM amet_repart

™ Include screen shots and plots

Report
This group contains controls that enable you to specify report options. It
contains the following controls.

Generate report of the results. If selected, this option causes Simulink
Design Verifier to save the HTML report it generates. Enabling this option
provides access to the Report file name, Include screen shots and plots,
and Display report options.

Report file name. Specifies a file name with which Simulink Design Verifier
saves the HTML report it generates. Enter a pathname that is either absolute
or relative to the directory specified by Output directory. This option is
accessible only if Generate report of the results is selected.

The default value is $ModelName$ report, where $ModelName$ is a token that
represents the model name.

Include screen shots and plots. If selected, this option causes Simulink
Design Verifier to capture and include images in the HTML report it
generates after completing its analysis. This option is disabled by default. It
is accessible only if Generate report of the results is selected.

Display report. If selected, this option causes Simulink Design Verifier to
display the HTML report it generates after completing its analysis. This
option is enabled by default. It is accessible only if Generate report of the
results is selected.
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Saving Simulink Design Verifier Options

Simulink Design Verifier stores its options as a configuration set component
attached to your model file (see “Configuration Sets” in Using Simulink). To
save the values of Simulink Design Verifier options that you specified for your
model, simply save your model (see “Saving a Model” in Using Simulink).
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Generating Test Cases

This chapter describes how you can use Simulink Design Verifier to generate
test cases for your model. The following sections introduce the notion of test
case generation and present an example in which you generate test cases
for a simple Simulink model:

About Test Case Generation (p. 6-2) Brief overview of test case generation
with Simulink Design Verifier.

Basic Workflow for Generating Test = Outlines a process for generating

Cases (p. 6-3) test cases for your model.
Generating Test Cases Example Provides an example that walks you
(p. 6-4) through the process of generating

test cases for a model.
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About Test Case Generation

Simulink Design Verifier can generate test cases that satisfy your model’s
coverage objectives, including decision coverage, condition coverage, and
modified condition/decision coverage (MC/DC). Test cases assist you in
confirming that a model behaves correctly by demonstrating how its blocks
execute in different modes. When generating test cases, Simulink Design
Verifier performs a formal analysis of your model. After completing its
analysis, Simulink Design Verifier produces a report that details its results
and a test harness model that contains test cases. Simply review the report
and simulate the test harness model to confirm that the test cases achieve
your model’s coverage objectives.

Simulink Design Verifier provides two blocks that allow you to customize
test cases for your Simulink models. Use the Test Objective block to define
the values of a signal that a test case must satisfy. Use the Test Condition
block to constrain the values of a signal during the analysis Simulink Design
Verifier conducts. For more information about these blocks, see Chapter 10,
“Blocks — Alphabetical List”.

Simulink Design Verifier also provides two functions that extend the
Stateflow action language, allowing you to customize test cases for your
Stateflow charts. These functions behave identically to the Test Objective and
Test Condition blocks. Use the following syntax to invoke these functions

in a Stateflow chart:

dv.test(expr, "{values}")
dv.condition(expr, "{values}")

where expr represents the objective or condition, e.g., x > 0, and the optional
argument values specifies the intervals that comprise the test objective or
condition. For more information about the values argument, see “Specifying
Test Objectives” on page 10-19 and “Specifying Test Conditions” on page 10-13.
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Basic Workflow for Generating Test Cases
Here is the recommended workflow for generating test cases for your model:

1 Ensure that your model is compatible for use with Simulink Design Verifier
(for an example, see “Checking Compatibility of the Example Model” on

page 6-6).

2 Optionally, instrument your model with blocks that specify test objectives
and test conditions (for an example, see “Customizing Test Generation” on
page 6-20).

3 Specify Simulink Design Verifier options that control how it generates test
cases for your model (for an example, see “Configuring Test Generation

Options” on page 6-9).

4 Execute the Simulink Design Verifier analysis and review its results
(for examples, see “Analyzing the Example Model” on page 6-12 and
“Reanalyzing the Example Model” on page 6-24).

See “Generating Test Cases Example” on page 6-4 for an exercise that
demonstrates this workflow.
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Generating Test Cases Example

To understand the test generation capabilities of Simulink Design Verifier,
you build a simple Simulink model and generate test cases by completing a
series of incremental tasks. The following sections guide you through the
process of completing this example:

Constructing the Example Model Guides you through Task 1 of the

(p. 6-4) test generation example, in which
you construct the example model.

Checking Compatibility of the Guides you through Task 2 of the test

Example Model (p. 6-6) generation example, in which you

ensure your model’s compatibility
with Simulink Design Verifier.

Configuring Test Generation Options Guides you through Task 3 of the

(p. 6-9) test generation example, in which
you configure Simulink Design
Verifier to generate tests.

Analyzing the Example Model Guides you through Task 4 of the

(p. 6-12) test generation example, in which
you generate test cases for your
model and interpret the results.

Customizing Test Generation Guides you through Task 5 of the

(p. 6-20) test generation example, in which
you add a Test Condition block to
customize test generation.

Reanalyzing the Example Model Guides you through Task 6 of the test

(p. 6-24) generation example, in which you
generate test cases for your modified
model and interpret the results.

Constructing the Example Model

This section presents Task 1 of the process that describes how to generate test
cases with Simulink Design Verifier. In this task, you construct a simple
Simulink model that you use throughout the remaining tasks. To complete
this task, perform the following steps:
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1 Create an empty Simulink model (see “Creating an Empty Model” in the
Simulink documentation for help with this step).

2 Copy the following blocks into your empty model window (see “Adding
Blocks” in the Simulink documentation for help with this step):
® An Inport block to initiate the input signal, from the Sources library
® A Switch block to provide simple logic, from the Signal Routing library

* Two Constant blocks to serve as Switch block data inputs, from the
Sources library

® An Outport block to receive the output signal, from the Sinks library

3 Double-click one of the Constant blocks in your model and specify its
Constant value parameter as 2.

4 Connect the blocks such that your model appears similar to the following

(see “Connecting the Blocks” in the Simulink documentation for help with
this step):

1

Constant
.
) 4
In1 — dutl
Switch
2
Canstant

5 Save your model as example.mdl (see “Saving a Model” in the Simulink
documentation for help with this step).

What to do next: Now you are ready to begin Task 2 of this example,
“Checking Compatibility of the Example Model” on page 6-6.
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Checking Compatibility of the Example Model

This section presents Task 2 of the process that describes how to generate test
cases with Simulink Design Verifier. In this task, you ensure that a model is
compatible for use with Simulink Design Verifier. Specifically, you check the
compatibility of the simple Simulink model that you created in the previous
task (see “Constructing the Example Model” on page 6-4). To complete this
task, perform the following steps:

1 In your Simulink model window, select Tools > Design Verifier > Check
Model Compatibility.

Simulink Design Verifier displays the following log window, which indicates
that your model is incompatible:

=1 simulink Design Yerifier log: example x|

17-Apr-2007 18:08:56
Checking compatibility of model "example"

kodel Merample” iz not compatible with Simulink, Dezsign Yerifier
Fefer ta the Simulink Diagnostics window for more information

Save Log Cloze

It also displays the following incompatibility error in the Simulink
Diagnostics Viewer:
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i simulink Design Yerifier Errors: example Y [m]

View  Fonk Size

Message Source Reported by Summarsy
[ WCesign ver... simulink Simulink Design Yerifier can not be used ..

|0 example

Simulink Design Yerifier can not be used with a variable-step salver. You must configure
the solver options for a fixed-step solver

Qpen | Help | Close |

The error message informs you that Simulink Design Verifier does not
support variable-step solvers. To work around this incompatibility, you
must use a fixed-step solver.

2 In your Simulink model window, select Simulation > Configuration
Parameters.

Simulink displays the Configuration Parameters dialog box.

3 In the Select tree on the left side of the Configuration Parameters dialog
box, click the Solver category (if not already selected). Under Solver
options on the right side, set the Type option to Fixed-step, and then set
the Solver option to discrete (no continuous states).

The Configuration Parameters dialog box appears as follows:
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#4, Configuration Parameters: example /Configuration {Active)

Select:

- Solver

- Data Import/Export

- Dptirization

[=- Diagnostics

Sample Time
[rata Y alidity
Type Converzion
Connectivity
Compatibility

- Model Referencing

i Model Feferencing
- Hardware Implementatian

— Sirnulation time

Stark time: IEI.EI Stop time: I'I 0o

— Solver optiohz

Type:l Fiwed-step LI Su:ulver:l dizcrete [no continuous states)

Periodic zample time constraint: I Unconstrained

Fined-step size [fundamental zample time]: Iautu:u

Tazking mode for penodic zample bimes: I Ato

[~ Higher pricrity value indicates higher task priority

I~ Automatically handle data tansters between tasks

Cancel Help

Apply

Parameters dialog box.

4 Click the OK button to apply your changes and close the Configuration

5 Recheck the compatibility of your model. In your Simulink model window,
select Tools > Design Verifier > Check Model Compatibility.

Simulink Design Verifier displays the following log window, which confirms

that your model is compatible for analysis:
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=1 simulink Design Yetifier log: example x|

17-Apr-2007 18:15:41
Checking compatibility of model "example"’

Compiling model... done
Checking compatibility. .. done

kodel "example’ iz compatible with Simulink Dezign erifier.

Save Log Cloze

What to do next: Now you are ready to begin Task 3 of this example,
“Configuring Test Generation Options” on page 6-9.

Configuring Test Generation Options

This section presents Task 3 of the process that describes how to generate test
cases with Simulink Design Verifier. In this task, you configure Simulink
Design Verifier to generate test cases that achieve complete decision coverage
for the simple Simulink model that you created in a previous task (see
“Constructing the Example Model” on page 6-4). To complete this task,
perform the following steps:

1 In your Simulink model window, select Tools > Design Verifier > Options
(see “Viewing Simulink Design Verifier Options” on page 5-2 for help with
this step).
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Simulink Design Verifier displays its options in the Configuration
Parameters dialog box.

2 In the Select tree on the left side of the Configuration Parameters dialog
box, click the Design Verifier category (if not already selected). Under
Analysis options on the right side, ensure that the Mode option specifies
Test generation.

3 In the Select tree on the left side of the Configuration Parameters dialog
box, click the Test Generation category.

The Configuration Parameters dialog box displays the Test Generation
pane.

4 On the Test Generation pane, specify the value of the Model coverage
objectives parameter as Decision.

The Configuration Parameters dialog box appears as follows:
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#4, Configuration Parameters: example,/Configuration {Active) ﬂ
Select: — Test generation
gzltinelrmpurtHEHpurt Model coverage objectives: IDecisiu:un ;l
- Optimization Test conditions: ILlse lozal settings ;l
& D?agnu&tics Test objectives: ILlse local settings ;I
#Sample Time .
D ata Y alidity b airunn test caze steps: |5EIEI
Type Conwversion Test suite optimization: IEDmbined objectives LI
Cannectivity
Campatibility
i Model Feferencing
- Hardware |mplementation
- Maodel Referencing
[=- Design Yerifier
Black Replacements
i Parameters

Test Generation
Property Praving
Results

Cancel Help Apply

5 Click OK to apply your change and close the Configuration Parameters
dialog box.

Note Using the Test Generation pane, you can optionally specify values
for other parameters that control how Simulink Design Verifier generates
test cases for your model. See “Test Generation Pane” on page 5-9 for more
information.

What to do next: Now you are ready to begin Task 4 of this example,
“Analyzing the Example Model” on page 6-12.
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Analyzing the Example Model

This section presents Task 4 of the process that describes how to generate test
cases with Simulink Design Verifier. In this task, you execute the Simulink
Design Verifier analysis, which you configured in the previous task (see
“Configuring Test Generation Options” on page 6-9). Simulink Design Verifier
generates test cases for your example model and produces results for you to
interpret. To complete this task, perform the following steps:

1 In your Simulink model window, select Tools > Design
Verifier > Generate Tests.

Simulink Design Verifier begins analyzing your model to generate test
cases. During its analysis, Simulink Design Verifier displays a log window.
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=1 simulink Design Yetifier log: DefaultBlockDiagran x|

Frogress

Objectives processed 040

S atizfied 1]

Falzified 1]

Elapzed time 0.0
30-Jan-2007 18:10:00

Starting property proving for model Vexample"

Compiling rmodel...

Stop |

The Simulink Design Verifier log window updates you on the progress of
the analysis, providing information such as the number of test objectives
processed and how many of those objectives were satisfied. Also, this
dialog box includes a Stop button that you can click to terminate the proof
at anytime.

When Simulink Design Verifier completes its analysis, it displays the
following items:
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¢ Simulink Design Verifier report — Simulink Design Verifier displays an
HTML report named example_report.html.

¢ Test harness — Simulink Design Verifier displays a harness model
named example harness.mdl.

The remaining steps in this section help you interpret the results that
you obtained.

2 Review the Simulink Design Verifier report. The report includes the
following Table of Contents whose items you can click to navigate to
particular chapters and sections:

Tahle of Contents

1. Summary
2. Test/Proof Objectives

Status

example
3. Test Cases / Counterexamples

Test Case 1
Test Case 2

4. Approximations
List of Tahles

2.1, Dhjectives Satisfied

a In the Table of Contents, click Summary.

The report displays its Summary chapter, which begins as follows:
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Chapter 1. Summary

Input Model

File: Chexample. mdl

“ersion: 1.1

Time Stamp:  Tue Apr 17 18:05:49 2007
Authar, SCowan

Analysis Information

Design Yerifier Version: 1.0

Total Analysis Time: 0.1 secs

Status: Completed normally
Approximations: 1

Objectives Satisfied: 2

Objectives Proven
Unsatisfiable:

Objectives Undecided: a
Objectives Producing Errars: 0

a

The Summary chapter provides an overview of the analysis results. In
particular, Simulink Design Verifier satisfied two test objectives in your
model.

In the Summary chapter under Analysis Information, click
Objectives Satisfied.

The report displays its Objectives Satisfied table in the Test/Proof
Objectives chapter.

Tahle 2.1. Ohjectives Satisfied

#:  |Type Model ltem Description

_ . Switch "Switch”: trigger == threshold false
1 Decision Switch {output is from 3rd input port)
2 Decision Sywitch Switch "Switch": trigger == threshold true

{output is fram 1st input port)
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This table lists the test objectives that Simulink Design Verifier satisfied.
Specifically, it describes the test objectives that provide decision coverage
for a Switch block. You can locate the model item by clicking Switch;
Simulink Design Verifier highlights the corresponding Switch block in
your model window.

¢ In the Objectives Satisfied table under the # column, click 1.

The report displays additional information about test objective 1.

example
Objectives of: Switch

#: Status Test Cases|Description
1 Satisfied  |TC2 falze (output is from 3rd input port)

2 Satisfied | TCA1 true (output is fram 1st input port)

This table informs you that Simulink Design Verifier satisfied both test
objectives associated with the Switch block in your model, for which it
generated two test cases.

d Under the Test Cases column of the table, click TC 2.

The report displays its Test Case 2 section.
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Test Case 2
Summary
Length: 0.2 Seconds (2 sample periods)

Objective Count: 1
Objectives Reached At:

Step Time Objectives
1 0 1

Generated Input Data.

Time|0
Step |1
In1 -1

This section provides details about a test case that Simulink Design
Verifier generated to achieve an objective in your model. This test case
achieves test objective 1, which involves the Switch block passing its
third input. Specifically, Simulink Design Verifier determined that a
value of -1 for the Switch block control signal enables the block to pass
its third input.

3 Review the harness model named example harness.mdl, which appears as
follows:
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[! example_harness

Filz Edit

Yieww Simulation Format  Tools  Help

=10l x|

D=

HE | iR E= 4= » nfoo |[HelE s hEmE

Ready

Size-Type
% Ini I Ot 1
Outd
Inputs Test Unit(copied from example)
[
poc
Text
Test Case Explanation
[100% | | [FixedstepDiscrete

The harness model contains the following items:

¢ Signal Builder block named Inputs — Contains groups of signals that
achieve test objectives in your model.

® Subsystem block named Test Unit — Contains a copy of your model.

® DocBlock named Test Case Explanation — Provides a textual
description of the test cases that Simulink Design Verifier generates.

Note See the Simulink Reference for more information about interacting
with blocks such as the Signal Builder, Subsystem, and DocBlock.

To simulate the test harness and confirm that the test cases achieve
complete decision coverage:

a Double-click the Inputs block.

The Signal Builder dialog box displays the test case signals.
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) Signal Builder {example_harness/Inputs}) - |EI|£|

File Edit Group Signal Axes Help "

SH| BB o |~ REEREE| > 1= 2 B

fTest Case 1 \{\Test Case 2 \ | |

L e e e e e

-1

Time [sec)

Lett Point Right; Point
Hame: | Te I T I

Index: I *I s I ¥: I il | Llll

Click to =elect signal |

all
b In the Signal Builder dialog box, click the Run all button >

Simulink simulates the test harness using all the test cases, collects
model coverage information, and displays a coverage report whose
Summary section appears as follows:

Summary
bodel HierarchyComplexity: Test 1
01
1. example harness 2 100% S
.. Test Unit(copied from exampley 1 100% S
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The coverage report indicates Simulink Design Verifier generated
test cases that achieve complete decision coverage for your example
model (see “Understanding Model Coverage Reports” in the Simulink
Verification and Validation User’s Guide).

What to do next: Now you are ready to begin Task 5 of this example,
“Customizing Test Generation” on page 6-20.

Customizing Test Generation

This section presents Task 5 of the process that describes how to generate
test cases with Simulink Design Verifier. In this task, you modify the simple
Simulink model for which you attained complete decision coverage in the
previous task (see “Analyzing the Example Model” on page 6-12). Specifically,
you customize test generation by adding and configuring a Test Condition
block. To complete this task, perform the following steps:

1 In the MATLAB Command Window, enter sldvlib.

The Simulink Design Verifier library appears.
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[Z1Library: sldvlib -0 =|

File Edit “iew Formak Help

DSHE| 4 2R (=12 hEE

nie

t
3 = Test Objective: Specify signal values for
test generation

e

t
% - Test Condition: Constrain signal values
during test generation

nie

t
5 »  Froof Objective: Specify signal walues for
property proving

e
Froof Aszumption: Caonstrain signal values

t
b 2 during property proving

Ready [100% Locked v

2 Copy the Test Condition block to your model by dragging it from the
Simulink Design Verifier library to your model window.

3 In your model window, insert the Test Condition block between the Switch
and Outport blocks (see “Inserting Blocks in a Line” in the Simulink
documentation for help with this step).

Your model should look like this:
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1

Constant

true

o S

In4 i Outd
Sunitch
2
Constant

4 Double-click the Test Condition block in your model to access its attributes.
The Test Condition block parameter dialog box appears.

5 In the Values box, enter [-0.1, 0.1]. When generating test cases for this
model, Simulink Design Verifier will constrain the signal values entering
the Switch block control port to the specified interval.

The Test Condition block parameter dialog box appears.
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[=1Function Block Parameters: Test Condition x|

— Design Yerfier Test Condition [mazk.]

Congtraing zignal values in Simulink Design Yerfier test cazes. The Walues'
parameter constraing the block input zignal. Twao element vectors specify intervals.
Cell arrayz specify istz. The signal must satisfy &t least one of the values or intervalz
at every time gtep unless the 'Initial’ check box iz selected, when the constraint
applies anly to the firgt time ztep

E xample ‘Yalues:

true

{fI01], 2. [4 5], &}

{Sldv. Interval-2, -1]. Sldv. Paint[0], Sidvw.Intereal(d, 1, ()7, 1}

— Parameter

¥ Enatle
TypeIT ezt Condition ;I

Yalues
|01, 01]

I Initial
¥ Display values

[V Paszs through style [show Outport]

] Cancel Help Apply

6 Click OK to apply your changes and close the Test Condition block
parameter dialog box.

What to do next: Now you are ready to begin Task 6 of this example,
“Reanalyzing the Example Model” on page 6-24.
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Reanalyzing the Example Model

This section presents Task 6 of the process that describes how to generate test
cases with Simulink Design Verifier. In this task, you execute the Simulink
Design Verifier analysis on the simple Simulink model that you modified

in the previous task (see “Customizing Test Generation” on page 6-20). To
observe how a Test Condition block might affect test generation, compare

the result of this analysis to the result that you obtained in a previous task
(see “Analyzing the Example Model” on page 6-12). To complete this task,
perform the following steps:

1 In your Simulink model window, select Tools > Design
Verifier > Generate Tests.

Simulink Design Verifier displays a log window and begins analyzing your
model to generate test cases.

When Simulink Design Verifier completes the analysis, it displays a new
Simulink Design Verifier report named example reporti.html.

2 Review the Simulink Design Verifier report.

a In the Table of Contents, click Summary.

The report displays its Summary chapter, which begins as follows:
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Chapter 1. Summary

Input Model

File: Chexample.mdl

Wersion: 12

Time Stamp:  Tue Apr 17 18:20:04 2007
Authar: SCOwan

Analysis Information

Design “erifier Wersion: 1.0

Total Analysis Tirme: 0.11 secs

Status: Campleted narmally
Approximations: 1

Objectives Satisfied: 2

Objectives Proven
Unsatisfiable:

Ohjectives LIndecided: 1]
Objectives Producing Errors: 0O

1]

The Summary chapter indicates that Simulink Design Verifier satisfied
two test objectives in your model.

b In the Summary chapter under Analysis Information, click
Objectives Satisfied.

The report displays its Objectives Satisfied table in the Test/Proof
Objectives chapter.
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Table 2.1. Objectives Satisfied

#:  |Type Model ltem Description
- . Switch "Switch”: trigger == threshold false
1 Decision Switch {output is from 3rd input port)
2 Decision Sywitch Switch '_'Switc:h": tri_gger == threshold true
= {output is fram 1st input port)

With the fallowing active constraints:

Name

Constraint

Test Condition|[-0.1, 0.1]

This table lists the test objectives that Simulink Design Verifier satisfied.
It also identifies any active constraints that Simulink Design Verifier
encountered during its analysis. Consequently, this section lists the Test
Condition block that you added in the previous task to constrain the
value of the Switch block control signal to the interval [-0.1, 0.1].

¢ In the Objectives Satisfied table under the # column, click 1.

The report displays additional information about test objective 1, as

shown here.

example

Objectives of: Switch

#: Status

Test Cases Description

1 Satisfied | TC 2

falze (output is from 3rd input port)

2 Satisfied | TC 1

true (output is from 1st input port)

This table informs you that Simulink Design Verifier satisfied both test
objectives associated with the Switch block in your model, for which it

generated two test cases.

d Under the Test Cases column of the table, click TC 2.

The report displays its Test Case 2 section, which appears as follows:
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Test Case 2
Summary
Length: 0.2 Seconds (2 sample periods)

Objective Count: 1
Objectives Reached At:

Step Time Ohjectives
1 0 1

Generated Input Data.

Time (0
Step |1
In1 |-0.05

This section provides details about a test case that Simulink Design
Verifier generated to achieve an objective in your model. This test case
achieves test objective 1, which involves the Switch block passing its
third input. Although the Test Condition block restricted the domain
of input signals to the interval [-0.1, 0.1], Simulink Design Verifier
determined that a value of -0.05 for the Switch block control signal
satisfies the objective.

3 Simulate the harness model named example_harness1.mdl and confirm
that the test case achieves complete decision coverage:

a Double-click the Inputs block.

The Signal Builder dialog box displays the test case signals.
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i
File Edit @Group Signal Axes Help

BH|BRB| oo |—~T o #EEFREE|Y 0 -"I‘ErFl-IJ
j(Test Case 1 ‘{\Teat Case 2 \‘\ 1| Pl

.,

-1

Time [sec)

Left Foimnt Right Fomnt
Hame: | Te I Te I

Index: I 'I ¥: I ¥: I l

Click to select signal |

all
b In the Signal Builder dialog box, click the Run all button >

Simulink simulates the test harness using both test cases, collects model
coverage information, and displays a coverage report whose Summary
section appears as follows:

Summary
Model HierarchywComplexity: Tes=t 1
01
1. example harness1 3 100%
.. Test Unit(copied from another example) 2 100% S S,
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The coverage report indicates Simulink Design Verifier generated test
cases that achieve complete decision coverage for your example model.
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Proving Properties of a
Model

This chapter describes how you can use Simulink Design Verifier to prove
properties of your model. The following sections introduce the notion of
property proofs and present an example in which you prove a property of a
simple Simulink model:

About Property Proofs (p. 7-2) Brief overview of proving properties
with Simulink Design Verifier.

Basic Workflow for Proving Model Outlines a process for proving

Properties (p. 7-3) properties of your model.

Proving Model Properties Example  Provides an example that walks you
(p. 7-4) through the process of proving model
properties.
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About Property Proofs

Simulink Design Verifier can prove properties of your model. Here, the term
property refers to a logical expression of signal values in a model. For example,
you can specify that a signal in your model should attain a particular value or
range of values during simulation. You can then use Simulink Design Verifier
to prove whether such properties are valid. Simulink Design Verifier performs
a formal analysis of your model to prove or disprove the specified properties.
If Simulink Design Verifier disproves a property, it provides a counterexample
that demonstrates a property violation.

Simulink Design Verifier provides two blocks that allow you to specify
properties in your Simulink models. Use the Proof Objective block to define
the values of a signal that Simulink Design Verifier will prove. Use the
Proof Assumption block to constrain the values of a signal during the proof
Simulink Design Verifier conducts. For more information about these blocks,
refer to Chapter 10, “Blocks — Alphabetical List”.

Note Blocks from the Model Verification library in Simulink behave like a
Proof Objective block during Simulink Design Verifier proofs. Hence, you can
use Assertion blocks and other Model Verification blocks to specify properties
of your model. See “Model Verification” in the Simulink Reference for more
information about these blocks.

Simulink Design Verifier also provides two functions that extend the
Stateflow action language, allowing you to specify properties in your Stateflow
charts. These functions behave identically to the Proof Objective and Proof
Assumption blocks. Use the following syntax to invoke these functions in a
Stateflow chart:

sldv.prove(expr, "{values}")
sldv.assume(expr, "{values}")

where expr represents the objective or assumption, e.g., x > 0, and the
optional argument values specifies the intervals that comprise the proof
objective or assumption. For more information about the values argument,
see “Specifying Proof Objectives” on page 10-8 and “Specifying Proof
Assumptions” on page 10-2.
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Basic Workflow for Proving Model Properties
Here is the recommended workflow for proving properties of your model:

1 Ensure that your model is compatible for use with Simulink Design Verifier
(for an example, see “Checking Compatibility of the Example Model” on

page 7-6).

2 Instrument your model with blocks that specify proof objectives and proof
assumptions (for examples, see “Instrumenting the Example Model” on
page 7-9 and “Customizing the Example Proof” on page 7-22).

3 Specify Simulink Design Verifier options that control how it proves the
properties of your model (for an example, see “Configuring Property
Proving Options” on page 7-12).

4 Execute the Simulink Design Verifier analysis and review its results
(for examples, see “Analyzing the Example Model” on page 7-14 and
“Reanalyzing the Example Model” on page 7-24).

See “Proving Model Properties Example” on page 7-4 for an exercise that
demonstrates this workflow.
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Proving Model Properties Example

To understand the property proving capabilities of Simulink Design Verifier,
build a simple Simulink model and prove a property by completing a series
of incremental tasks. The following sections guide you through the process
of completing this example:

Constructing the Example Model Guides you through Task 1 of

(p. 7-5) the example proof, in which you
construct the example model.

Checking Compatibility of the Guides you through Task 2 of the

Example Model (p. 7-6) example proof, in which you ensure

your model’s compatibility with
Simulink Design Verifier.

Instrumenting the Example Model Guides you through Task 3 of the

(p. 7-9) example proof, in which you add a
Proof Objective block to your model
to prepare for its proof.

Configuring Property Proving Guides you through Task 4 of

Options (p. 7-12) the example proof, in which you
configure Simulink Design Verifier
to prove properties.

Analyzing the Example Model Guides you through Task 5 of the

(p. 7-14) example proof, in which you prove a
property of your model and interpret
the results.

Customizing the Example Proof Guides you through Task 6 of the

(p. 7-22) example proof, in which you add a
Proof Assumption block to customize
the proof.

Reanalyzing the Example Model Guides you through Task 7 of the

(p. 7-24) example proof, in which you prove a

property of your modified model and
interpret the results.
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Constructing the Example Model

This section presents Task 1 of the process that describes how to implement
an example proof with Simulink Design Verifier. In this task, you construct
a simple Simulink model that you use throughout the remaining tasks. To
complete this task, perform the following steps:

1 Create an empty Simulink model (see “Creating an Empty Model” in the
Simulink documentation for help with this step).

2 Copy the following blocks into your empty model window (see “Adding
Blocks” in the Simulink documentation for help with this step):

¢ An Inport block to initiate the input signal, from the Sources library

¢ A Compare To Zero block to provide simple logic, from the Logic and
Bit Operations library

¢ An Outport block to receive the output signal, from the Sinks library

3 Connect these blocks such that your model appears similar to the following

(see “Connecting the Blocks” in the Simulink documentation for help with
this step):

(1 <=0

In Ot
Campare

Ta Zaro

4 Save your model as example.mdl (see “Saving a Model” in the Simulink
documentation for help with this step).

What to do next: Now you are ready to begin Task 2 of this example,
“Checking Compatibility of the Example Model” on page 7-6.
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Checking Compatibility of the Example Model

This section presents Task 2 of the process that describes how to implement
an example proof with Simulink Design Verifier. In this task, you ensure that
a model is compatible for use with Simulink Design Verifier. Specifically,

you check the compatibility of the simple Simulink model that you created

in the previous task (see “Constructing the Example Model” on page 7-5). To
complete this task, perform the following steps:

1 In your Simulink model window, select Tools > Design Verifier > Check
Model Compatibility.

Simulink Design Verifier displays the following log window, which indicates
that your model is incompatible:

=1 simulink Design Yerifier log: example x|

16-Apr-2007 145716
Checking compatibility of model "example"

kodel Merample” iz not compatible with Simulink, Dezsign Yerifier
Fefer ta the Simulink Diagnostics window for more information

Save Log Cloze

It also displays the following incompatibility error in the Simulink
Diagnostics Viewer:
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i simulink Design Yerifier Errors: example Y [m]

View  Fonk Size

Message Source Reported by Summarsy
[ WCesign ver... simulink Simulink Design Yerifier can not be used ..

|0 example

Simulink Design Yerifier can not be used with a variable-step salver. You must configure
the solver options for a fixed-step solver

Qpen | Help | Close |

The error message informs you that Simulink Design Verifier does not
support variable-step solvers. To work around this incompatibility, you
must use a fixed-step solver.

2 In your Simulink model window, select Simulation > Configuration
Parameters.

Simulink displays the Configuration Parameters dialog box.

3 In the Select tree on the left side of the Configuration Parameters dialog
box, click the Solver category (if not already selected). Under Solver
options on the right side, set the Type option to Fixed-step, and then set
the Solver option to discrete (no continuous states).

The Configuration Parameters dialog box appears as follows:
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#4, Configuration Parameters: example /Configuration {Active)

Select:

- Solver

- Data Import/Export

- Dptirization

[=- Diagnostics

Sample Time
[rata Y alidity
Type Converzion
Connectivity
Compatibility

- Model Referencing

i Model Feferencing
- Hardware Implementatian

— Sirnulation time

Stark time: IEI.EI Stop time: I'I 0o

— Solver optiohz

Type:l Fiwed-step LI Su:ulver:l dizcrete [no continuous states)

Periodic zample time constraint: I Unconstrained

Fined-step size [fundamental zample time]: Iautu:u

Tazking mode for penodic zample bimes: I Ato

[~ Higher pricrity value indicates higher task priority

I~ Automatically handle data tansters between tasks

Cancel Help

Apply

Parameters dialog box.

4 Click the OK button to apply your changes and close the Configuration

5 Recheck the compatibility of your model. In your Simulink model window,
select Tools > Design Verifier > Check Model Compatibility.

Simulink Design Verifier displays the following log window, which confirms

that your model is compatible for analysis:
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=1 simulink Design Yetifier log: example x|

16-Apr-2007 15:21:18
Checking compatibility of model "example"’

Compiling model... done
Checking compatibility. .. done

kodel "example’ iz compatible with Simulink Dezign erifier.

Save Log Cloze

What to do next: Now you are ready to begin Task 3 of this example,
“Instrumenting the Example Model” on page 7-9.

Instrumenting the Example Model

This section presents Task 3 of the process that describes how to implement
an example proof with Simulink Design Verifier. In this task, you prepare a
model so that you can prove its properties with Simulink Design Verifier.
Specifically, you instrument the simple Simulink model that you created in a
previous task (see “Constructing the Example Model” on page 7-5) by adding
and configuring a Proof Objective block. To complete this task, perform the
following steps:

1 In the MATLAB Command Window, enter sldvlib.

The Simulink Design Verifier library appears.
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[Z1Library: sldvlib -0 =|

File Edit “iew Formak Help

DSHE| 4 2R (=12 hEE

nie

t
3 = Test Objective: Specify signal values for
test generation

e

t
% - Test Condition: Constrain signal values
during test generation

nie

t
5 »  Froof Objective: Specify signal walues for
property proving

e
Froof Aszumption: Caonstrain signal values

t
b 2 during property proving

Ready [100% Locked v

2 Copy the Proof Objective block to your model by dragging it from the
Simulink Design Verifier library to your model window.

3 In your model window, insert the Proof Objective block between the
Compare To Zero and Outport blocks (see “Inserting Blocks in a Line” in
the Simulink documentation for help with this step).

Your model should look like this:

true
1 W <=0 @
In1 Ot
Compare
Ta Eara

4 Double-click the Proof Objective block in your model to access its attributes.
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The Proof Objective block parameter dialog box appears.

5 In the Values box, enter 1. Simulink Design Verifier will attempt to prove
that the signal output by the Compare To Zero block always attains this
value for any signals that it receives.

The Proof Objective block parameter dialog box appears.

1 Function Block Parameters: Proof Dbjective x|

— Design Werfier Proof Objective [mask] [link]

Proves zighal walues uzing Simulink Design Yerfier. The Yalues' parameter specifies
input zignal walues to prove. Two element vectorz specify intervals. Cell arays
specify lists. Signals are proven to zatisfy at least one of the values or intervals at
enery time ztep.

Example W alues:
true
1,2, [4 5]}

— Parameter

¥ Enable
T_I,IpelF'n:u:uf Objective j

Yalues
[1
W Display walues

¥ Pasz through style [show Outport]

] Cancel Help Apply

6 Click OK to apply your changes and close the Proof Objective block
parameter dialog box.

What to do next: Now you are ready to begin Task 4 of this example,
“Configuring Property Proving Options” on page 7-12.
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Configuring Property Proving Options

This section presents Task 4 of the process that describes how to implement
an example proof with Simulink Design Verifier. In this task, you configure
Simulink Design Verifier to prove properties of the simple Simulink model
that you instrumented in the previous task (see “Instrumenting the Example
Model” on page 7-9). To complete this task, perform the following steps:

1 In your Simulink model window, select Tools > Design Verifier > Options
(see “Viewing Simulink Design Verifier Options” on page 5-2 for help with
this step).

Simulink Design Verifier displays its options in the Configuration
Parameters dialog box.

2 In the Select tree on the left side of the Configuration Parameters dialog
box, click the Design Verifier category (if not already selected). Under
Analysis options on the right side, set the Mode option to Property
proving.

The Configuration Parameters dialog box appears as follows:



Proving Model Properties Example

#4, Configuration Parameters: example/Configuration {(Active)

Madel Referencing

- Model Referencing
[=- Design Yerfier

Parameters

Test Generation
Property Praoving
i~ Results

Select: | — Analyziz option
- Salver Wode:
- [ata Import/Esport
- Optimization bd awimnum analysiz time: IEDEI
[~ Diagnastics W Dizplay unsatisfiable test objectives
i Sample Time
i~ Data Y alidity — Output
i Tupe Conversion )
Connectivity Output directaorny: zldv_output/Eh odeld ame$
i Compatibility v Make output file names unique by adding a suffis

- Hardware Implementatian

iBlock Replacements

Check Modsl Compatbiity |

Analyze Model |

Cancel Help Apply

o |

3 Click OK to apply your changes and close the Configuration Parameters
dialog box.

Note Using the Property Proving pane, you can optionally specify values
for other parameters that control how Simulink Design Verifier proves
properties of your model. See “Property Proving Pane” on page 5-10 for more
information.

What to do next: Now you are ready to begin Task 5 of this example,
“Analyzing the Example Model” on page 7-14.
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Analyzing the Example Model

This section presents Task 5 of the process that describes how to implement
an example proof with Simulink Design Verifier. In this task, you execute the
Simulink Design Verifier analysis, which you configured in the previous task
(see “Configuring Property Proving Options” on page 7-12). Simulink Design
Verifier proves a property of your example model and produces results for you
to interpret. To complete this task, perform the following steps:

1 In your Simulink model window, select Tools > Design Verifier > Prove
Properties.

Simulink Design Verifier begins analyzing your model to prove its
properties. During its analysis, Simulink Design Verifier displays a log
window.
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=1 simulink Design Yetifier log: DefaultBlockDiagran x|

Frogress

Objectives processed 040

S atizfied 1]

Falzified 1]

Elapzed time 0.0
30-Jan-2007 18:10:00

Starting property proving for model Vexample"

Compiling rmodel...

Stop |

The Simulink Design Verifier log window updates you on the progress of
the proof, providing information such as the number of objectives processed
and how many of those objectives were either satisfied or falsified. Also,
this dialog box includes a Stop button that you can click to terminate the
proof at anytime.

When Simulink Design Verifier completes its analysis, it displays the
following items:
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¢ Simulink Design Verifier report — Simulink Design Verifier displays an
HTML report named example_report.html.

¢ Test harness — Simulink Design Verifier displays a harness model
named example harness.mdl.

The remaining steps in this section help you interpret the results that
you obtained.

2 Review the Simulink Design Verifier report. The report includes the
following Table of Contents whose items you can click to navigate to
particular chapters and sections:

Tahle of Contents

1. Summary
2. Test/Proof Ohjectives

Status

example
3. Test Cases £ Counterexamples

Counterexample 1
4. Approximations

List of Tahles

2.1, Objectives Falsified with Counterexamples

a In the Table of Contents, click Summary.

The report displays its Summary chapter, which begins as follows:
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Chapter 1. Summary

Input Model

File: Cihexample. mdl

Yersion: 1.3

Time Stamp:  Mon Apr 16 16:55:53 2007
Authaor: SCOwan

Analysis Information

Design Yerifier Wersion: 1.0

Total Analysis Time: 0.03 secs

otatus: Completed normally
Approximations: 1

Objectives Proven Yalid: 0

Dhjectives Falsified with
Counterexamples:
Objectives Undecided: 0

Objectives Praducing Errors: 0

1

The Summary chapter provides an overview of the analysis results. In
particular, Simulink Design Verifier identified a counterexample that
falsifies an objective in your model.

In the Summary chapter under Analysis Information, click
Objectives Falsified with Counterexamples.

The report displays its Objectives Falsified with Counterexamples table
in the Test/Proof Objectives chapter.

Tahle 2.1. Objectives Falsified with Counterexamples

#:  [Type Model Item Description
Custom

1 |Proaf Proof Objective Froof Objective "Froof Objective” © 1
Objective
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d

7-18

This table lists the proof objectives that Simulink Design Verifier
disproved using a counterexample it generated. You can locate the
objective in your model window by clicking Proof Objective; Simulink
Design Verifier highlights the corresponding Proof Objective block in
your model window.

In the Objectives Falsified with Counterexamples table under the #
column, click 1.

The report displays information about proof objective 1.

example
Objectives of: Froof Objective

#: Status Test Cases Description
1 Falsified TE1 1

This table informs you that Simulink Design Verifier disproved a proof
objective that you specified in your model, for which it generated a
counterexample.

Under the Test Cases column of the table, click TC 1.

The report displays its Counterexample 1 section.
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Counterexample 1

Summary

Length: 0.2 Seconds (2 sample periods)
Ohjective Count: 1

Objectives Reached At:

Objectives Falsified
1

Generated Input Data.

Time|0
Step |1
In1 |255

This section provides details about the counterexample that Simulink
Design Verifier generated to disprove an objective in your model. In this
counterexample, a signal value of 255 falsifies the objective that you
specified using the Proof Objective block in your model. That is, 255 is
not less than or equal to 0, which causes the Compare To Zero block to
return 0 (false) instead of 1 (true).

3 Review the harness model named example harness.mdl, which appears as
follows:
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[! example_harness

=10l x|

File Edit Wwiew Simulation Format Tools Help
DSEE BBl 4 | oz(r s BBy RBE
Size-Type
% Ini l I Ot 1
Qutt
Inputs Test Unit(copied from example)
[
Loc
Text
Test Case Explanation
Ready [100% | | [FixedstepDiscrete v

The harness model contains the following items:

¢ Signal Builder block named Inputs — Contains groups of signals that
falsify proof objectives in your model.

® Subsystem block named Test Unit — Contains a copy of your model.

® DocBlock named Test Case Explanation — Provides a textual
description of the counterexamples that Simulink Design Verifier
generates.

Note See the Simulink Reference for more information about interacting
with blocks such as the Signal Builder, Subsystem, and DocBlock.

You can simulate the harness model to observe the counterexample that
falsifies the proof objective in your model:

a In the MATLAB Command Window, enter simulink to open the
Simulink library (if not already open).
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The Simulink library window appears.

b From the Sinks library, copy a Scope block into your harness model
window. The Scope block will allow you to see the value of the signal
output by the Compare To Zero block in your model.

¢ In your harness model window, connect the output signal of the Test
Unit subsystem to the Scope block.

Your model should appear similar to the following:

JRI=TEY
File Edit Wiew Simulation Format Tools Help
D@ &+ ER (e 42 sfo  (HeRed bEE
Size-Type
% In1 >l P In1 Out 1
Ot
Inputs Test Unit(copied from example)
[
Lac |:|
Text
Test Case Explanation Scope
Ready [100% | | [FizedstepDiscrete v

d In your harness model window, select Simulation > Start to begin the
simulation.

Simulink simulates the harness model.

e In your harness model window, double-click the Scope block to open its
display window.

The Scope window appears as follows:
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JScope =10l x|
SHELLL ABEBBA T -

Titme offzet: 0O

The Scope block displays the value of the signal output by the Compare
To Zero block in your model. In this example, the Compare To Zero block
returns 0 (false) throughout the simulation. Recall from a previous

step (see “Instrumenting the Example Model” on page 7-9) that you
specified that the proof objective in your model is 1 (true). Hence, the
counterexample that the Signal Builder block supplies falsifies the proof
objective.

What to do next: Now you are ready to begin Task 6 of this example,
“Customizing the Example Proof” on page 7-22.

Customizing the Example Proof

This section presents Task 6 of the process that describes how to implement
an example proof with Simulink Design Verifier. In this task, you modify
the simple Simulink model whose proof objective Simulink Design Verifier
disproved in the previous task (see “Analyzing the Example Model” on page
7-14). Specifically, you customize the proof by adding and configuring a Proof
Assumption block. To complete this task, perform the following steps:
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1 If the Simulink Design Verifier library is not already open, type sldvlib in
the MATLAB Command Window.

The Simulink Design Verifier library appears.

2 Copy the Proof Assumption block to your model (example.mdl) by dragging
it from the Simulink Design Verifier library to your model window.

3 In your model window, insert the Proof Assumption block between the
Inport and Compare To Zero blocks.

Your model should appear similar to the following:

true 1
o =0
In1 Ot
Compare
Ta Zera

4 Double-click the Proof Assumption block in your model to access its
attributes.

The Proof Assumption block parameter dialog box appears.

5 In the Values box, enter [ -1, 0]. When proving properties of this model,
Simulink Design Verifier will constrain the signal values entering the
Compare To Zero block to the specified interval.

The Proof Assumption block parameter dialog box appears.
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1 Function Block Parameters: Assumption x|

— Design Werifier Aezumption [mazk] [link]

Azzumes zighal valugs when Simulink Dezign Yerfier proves model propertiez. The
input zignal is azsumed o be ane of the values lizted in the Y alues' parameter. Twio
element vectors specify intervalz. Cell araps specify stz The zignal must match one
of the listed walues or intervalz at every ime step unlesz the 'Initial’ check box is
enabled, in which caze the azsumption iz for anly the firgt time ztep.

Example alues:
true

{1. 2. [4 5]}
{0100 12 310

— Parameter

¥ Enable
T ypel.ﬁ.ssumptinn j

Yalues

[I-1.0]

[ Irital

¥ Dizplay walues

¥ Passz through style [show Outport]

] Cancel Help Apply

6 Click OK to apply your changes and close the Proof Assumption block
parameter dialog box.

What to do next: Now you are ready to begin Task 7 of this example,
“Reanalyzing the Example Model” on page 7-24.

Reanalyzing the Example Model

This section presents Task 7 of the process that describes how to implement
an example proof with Simulink Design Verifier. In this task, you execute
the Simulink Design Verifier analysis on the simple Simulink model that
you modified in the previous task (see “Customizing the Example Proof” on
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page 7-22). To observe how Proof Assumption blocks affect proofs, compare
the result of this analysis to the result that you obtained in a previous task
(see “Analyzing the Example Model” on page 7-14). To complete this task,
perform the following steps:

1 In your Simulink model window, select Tools > Design Verifier > Prove
Properties.

Simulink Design Verifier displays a log window and begins analyzing your
model to prove its properties.

When Simulink Design Verifier completes the analysis, it displays a new
Simulink Design Verifier report named example reporti.html.

Note If Simulink Design Verifier satisfies all proof objectives in your
model, it does not generate a harness model.

2 Review the Simulink Design Verifier report.

a In the Table of Contents, click Summary.

The report displays its Summary chapter, which begins as follows:
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Chapter 1. Summary

Input Model

File: Chexarmple. mdl

Yersion: 1.4

Time Stamp:  Mon Apr 16 19:55:08 2007
Authaor: SCowan

Analysis Information

Design Yerifier YWersion: 1.0

Total Analysis Time: 0.1 secs

otatus: Completed normally
Approximations: 1

Dbjectives Proven alid: 1

Objectives Falsified with
Counterexamples:

1]
Objectives Undecided: 0
Objectives Praducing Errors: 0

The Summary chapter indicates that Simulink Design Verifier proved
an objective in your model.

b In the Summary chapter under Analysis Information, click
Objectives Proven Valid.

The report displays its Objectives Proven Valid table in the Test/Proof
Objectives chapter.
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Table 2.1. Objectives Proven Valid

#:  |Type Model Item Description
Custom

1 Proof Proof Objective Proof Objective "Froof Objective” : 1
Objective

YWyith the following active constraints:

Name Constraint
Assurnption|[-1, 0]

This table lists the proof objectives that Simulink Design Verifier proved
to be valid. It also identifies any active constraints on which the validity
of the objectives depend. Consequently, this section lists the Proof
Assumption block that you added in the previous task to constrain the
signal value to the interval [-1, 0].

In the Objectives Proven Valid table under the # column, click 1.

The report displays information about proof objective 1, as shown here.

example

Objectives of: Proof Objective

#: Status Test Cases Description
1 Froven valid|nfa 1

This table informs you that Simulink Design Verifier proved an objective
that you specified in your model. Because the Proof Assumption block
restricted the domain of the input signals to the interval [-1, 0], Simulink
Design Verifier was able to prove that this interval contains no values
that are greater than zero, thereby satisfying the proof objective.
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Reviewing the Results

Simulink Design Verifier produces several artifacts after it analyzes your
model. Depending on the analysis, Simulink Design Verifier can generate a
test harness model, a report, and a data file. The following sections illustrate
each of these items and describe their contents.

Exploring Test Harness Models Describes a basic test harness model.
(p. 8-2)

Understanding Simulink Design Describes the different parts of a
Verifier Reports (p. 8-6) Simulink Design Verifier report.

Examining Simulink Design Verifier Describes the contents of a Simulink
Data Files (p. 8-21) Design Verifier data file.
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Exploring Test Harness Models

Simulink Design Verifier generates a test harness model after it completes
its analysis. If Simulink Design Verifier’'s Mode parameter specifies

Test generation, the harness model contains test cases that achieve test
objectives. Otherwise, Simulink Design Verifier's Mode parameter specifies
Property proving and the harness model contains counterexamples that
falsify proof objectives. The following sections describe the contents of a
harness model and explain how to simulate it.

* “Anatomy of a Test Harness” on page 8-2

¢ “Simulating the Test Harness” on page 8-5

Anatomy of a Test Harness

When Simulink Design Verifier completes its analysis, it produces a test
harness model that looks like this:

[! sldvdemo_cruise_control_harness

File Edit Wiew Simulation Format Tools Help

=10l |

D& LR |c 4D r = oo fvmd =] Bes S|

Ready

enable

brake

sat

///\
L

Inputs

Loc
Text

Test Case Explanation

Size-Type

enable

brake

et

inc

dec

speed

e | (D)

throt

target

Test Unit (copied fram sldvdemao_cruise_sontral)

|100%

|FixedstepDiscrete 4

The harness model contains the following items:
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¢ Test Case Explanation — This DocBlock documents the test cases or
counterexamples that Simulink Design Verifier generates. Double-click
the Test Case Explanation block to view a description of each test case or
counterexample. The block lists either the test objectives that each test
case achieves or the proof objectives that each counterexample falsifies.

‘B Editor - C:\ TEMP' docblock-133-001586914.kxt P ] 59
File Edit Text Go Cell Tools Debug Deskiop Window Help N | A X
NS H| ¢ R2Bo o |S Ahedf | B BRE BB wl=-] BDAIO
1 Test Case 1 (8 Chjectiwves) -
2 1. Logic "Logical OperatorzZ™, MCDC expression for output with Condition 1, T BT=0
| 2. Logic "Logical Operatorl”: Condition 1, T ET=0
4 3. Logic "Logical Operator™: Condition 1, T BT=0
5 4, Logic "Logical Operator™, MCDC expression for output with Condition 2, F BT=0
=} 5. Logic "Logical Operator™: Condition 2, F BT=0
7 6. Switch "3witchl™: logical trigger input, true {output is from lst input port) BT=0
g 7. Logic "Logical OperatorZ"™: Condition 1, T @T=0
9 8. SubSystemw "PI Controller": enable logical walue, false @T=0
10
11 Test Case 2 (3 Chijectiwves)
12 1. Logic "Logical Operator™: Condition 1, F BT=0
13 2. Logie "Logical Operator™, MCDC expression for output with Condition 1, F BT=0
14 3. Logic "Logical Operatorl”: Condition 1, F ET=0
15
16 Test Case 3 (6 Chiectiwves)
17 1. Switch "3witchl™: logical trigger input, false (output iz from 3rd input port) BT=0
1a el Trreic T A cis 1 Mmaratar?fs Tanditrian 7 T RAT=N LI
| plain text file [tn 15 ol 1 O

¢ Inputs — This Signal Builder block contains signals that comprise the
test cases or counterexamples that Simulink Design Verifier generated.
Double-click the Inputs block to open the Signal Builder dialog box and
view its signals.
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Each signal group represents a unique test case or counterexample. In the
Signal Builder dialog box, select a group’s tab to view the signals associated
with a particular test case or counterexample. See “Working with Signal

Groups” in Using Simulink for more information about interacting with the
Signal Builder dialog box.

Size-Type — This Subsystem block transmits signals from the Inputs
block to the Test Unit block. It ensures that the signals are of the
appropriate size and data type, which the Test Unit block expects.

Test Unit — This Subsystem block contains a copy of the original model
that Simulink Design Verifier analyzed.
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Simulating the Test Harness

The test harness model enables you to simulate a copy of your original
model using the test cases or counterexamples that Simulink Design Verifier
generates. Using the test harness model, you can simulate

® A single test case or counterexample

e All test cases, for which Simulink collects model coverage information
To simulate a single test case or counterexample:
1 In the test harness model, double-click the Inputs block.

Simulink displays the Signal Builder dialog box.

2 In the Signal Builder dialog box, select the tab associated with a particular
test case or counterexample.

The Signal Builder dialog displays the signals that comprise the selected
test case or counterexample.
3 In the Signal Builder dialog box, click the Start simulation button ﬂ

Simulink simulates the test harness model using the signals associated
with the selected test case or counterexample.

To simulate all test cases and measure their combined model coverage:
1 In the test harness model, double-click the Inputs block.

Simulink displays the Signal Builder dialog box.

all
2 In the Signal Builder dialog box, click the Run all button )

Simulink simulates the test harness model using all test cases, collects
model coverage information, and displays a coverage report.

See “Simulating with Signal Groups” in Using Simulink for more information
about simulating models containing Signal Builder blocks.
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Understanding Simulink Design Verifier Reports

Simulink Design Verifier generates an HTML report that contains the
following sections:

* “Front Matter” on page 8-6

¢ “Summary Chapter” on page 8-7

¢ “Block Replacements Summary Chapter” on page 8-12

® “Test/Proof Objectives Chapter” on page 8-12

® “Test Cases / Counterexamples Chapter” on page 8-17

* “Approximations Chapter” on page 8-20

Front Matter

The report begins with two sections: title and table of contents.
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Simulink Design Verifier Report
sldvdemo_flipflop

scowan

05-Apr-2007 14:02:39

Table of Contents

1. Surnmary
2. Test/Proof Objectives

Status
sldvdermo_flipflap
D Flip-Flop
3 Test Cases f Counterexamples
Test Case 1
Test Case 2
Test Case 3
Test Case 4
Test Case &

4. Approximations
List of Tables

2.1. Ohjectives Satisfied

The title section lists the following information:

® Model or subsystem name that Simulink Design Verifier analyzed
® User name associated with the current MATLAB session
® Date and time that Simulink Design Verifier generated the report

The table of contents follows the title section. Clicking items in the table of
contents allows you to navigate quickly to particular chapters and sections.

Summary Chapter

The Summary chapter provides an overview of the Simulink Design Verifier
analysis. It contains the following sections:

® “Input Model” on page 8-8
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® “Analysis Information” on page 8-8
e “Output Files” on page 8-10
® “Options” on page 8-10

Input Model

The Input Model section provides information about the current version of

the model.
Input Model
File: CAMATLABM oolbox\sldvisldvdemostsldvdemo_cruise_contral. mdl
“ersion: 1.46
Tirme Stamp:  Sat Mar 3 02:53:32 2007
Author:

The Input Model section lists the following:

¢ Path and file name of the model that Simulink Design Verifier analyzed
® Model version

¢ Date and time that the model was last saved

® Name of the person who last saved the model

See “Managing Model Versions” in Using Simulink for details about specifying
this information for your models.

Analysis Information

The Analysis Information section summarizes the results of the Simulink
Design Verifier analysis. It looks like the following when Simulink Design
Verifier generates test cases for a model:
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Analysis Information

Design Yerifier Version: 1.0

Total Analysis Time: 1.57 secs

Status: Completed normally
Approximations: 1

Dbjectives Satisfied: 34

Objectives Satisfied - Mo Test Case:
Objectives Proven Unsatisfiable:
Objectives Undecided:

1]
1]
1]
Ohjectives Producing Errors: 0

The Analysis Information section lists the following information for all
analyses:

e Version of Simulink Design Verifier

e Total time Simulink Design Verifier spent to complete its analysis

¢ Completion status of the Simulink Design Verifier analysis

¢ Total number of different approximation schemes Simulink Design Verifier
used in its analysis (see “Approximations Chapter” on page 8-20)

¢ Total number of test or proof objectives for which Simulink Design Verifier
was unable to decide an outcome

¢ Total number of test or proof objectives that produced errors
If Simulink Design Verifier’'s Mode parameter specifies Test generation,
the Analysis Information section also lists:

e Total number of test objectives that Simulink Design Verifier satisfied

¢ Total number of test objectives that Simulink Design Verifier satisfied
without generating test cases

e Total number of test objectives that Simulink Design Verifier determined to
be unsatisfiable

Otherwise, if Simulink Design Verifier's Mode parameter specifies Property
proving, the Analysis Information section lists:



8 Reviewing the Results

8-10

¢ Total number of proof objectives that Simulink Design Verifier proved valid

® Total number of proof objectives that Simulink Design Verifier disproved,
for which it generated counterexamples that falsify each objective

¢ Total number of proof objectives that Simulink Design Verifier disproved
without generating counterexamples

See “Test/Proof Objectives Chapter” on page 8-12 for more information related
to the status of test and proof objectives.

Output Files
The Output Files section provides information about the artifacts Simulink
Design Verifier produced after it analyzed a model.

Output Files

Harness model: Chsldy_outputisldvdemo_cruise_controlsldvdemo_cruise_control_harness. mdl
Data file: Chsldy outputisldvderno_cruise controlisldvdemo_cruise_control_sldvdata.mat
Report: Cisldv_outputhsldvderno_cruise_controhsldvdemno_cruise_control_report. html

The Output Files section lists the following:
¢ Path and file name of the test harness model (see “Exploring Test Harness
Models” on page 8-2)

¢ Path and file name of the Simulink Design Verifier data file (see
“Examining Simulink Design Verifier Data Files” on page 8-21)

¢ Path and file name of the Simulink Design Verifier report

Options
The Options section provides information about the Simulink Design Verifier
analysis settings.
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Options.

Parameter Setting

Mode TestGeneration
MaxProcessTime B0

DisplayUnsatisfiableObjectives| an

CutputDir sldv_output/fhodelMamed
MakeQutputFilesUnigue off
BlockReplacement off
Parameters on

ParametersConfigFileMame sldv_params_template.m

ModelCoverageObjectives MCDC

TestConditions UselocalSettings
TestObjectives UselocalSettings
MaxTestCaseSteps 500
TestSuiteOptimization CombinedObjectives
SaveHarnesshaodel an
HarnesshodelFileMame thodelMame$_hamess
SaveDataFile an

DataFileMame ihodelMamed_sidvdata
SawveReport on

ReportFileMame fhodelMamed_report
ReportincludeGraphics off

DisplayReport on

The Options section lists the names of parameters that affected the Simulink
Design Verifier analysis, as well as the values those parameters specified. See
“sldvoptions Object Parameters” on page 9-8 for more information about the
parameters that this section displays.

8-11
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Block Replacements Summary Chapter

The Block Replacements Summary chapter provides an overview of the block
replacements that Simulink Design Verifier executed. It appears only if
Simulink Design Verifier replaced any blocks in a model. The chapter displays

a table that looks like the following:

#: |Replacement Rule / Block Type

1 blkrep_rule_lookup_normal.m fLookup

blkrep_rule_mpswitch2_narmal.m
MultiPortSwitch

Rule Description Replaced Blocks

Inserts test objectives for
each interval of 1-0
lookup table blocks.

JLookup Table

Constrains the first input
to a Z-input Multiport
switch block to prevent
simulation errars.

JAhlultiport Switch

Each row of the table corresponds to a particular block replacement rule that
Simulink Design Verifier applied to the model. The table lists the following:

® Name of the M-file that represents the block replacement rule, and the
value of the BlockType parameter the rule specifies

® Description of the rule, which the MaskDescription parameter of the

replacement block specifies

® Name of the block(s) that Simulink Design Verifier replaced in the model

See Chapter 3, “Working with Block Replacements” for more information.

Test/Proof Objectives Chapter

The Test/Proof Objectives chapter provides an overview of a model’s objectives.
It contains sections similar to the following:

® “Status” on page 8-13
e “Model Hierarchy” on page 8-16
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Status

The Status section summarizes all test or proof objectives in a model,
including an objective’s type, the model item to which it corresponds, and its
description. This section displays each objective in one of the following tables
associated with the objective’s status:

¢ Objectives Undecided — Lists the test or proof objectives for which
Simulink Design Verifier was unable to determine an outcome in the
allotted time. In this case, either Simulink Design Verifier exceeded its
analysis time limit (which the Maximum analysis time parameter
specifies) or you aborted the analysis before it completed processing these
objectives.

Table 2.3. Objectives Undecided

#:  |Type Model Item Description

Switch "Switch”, trigger ==

3 |Decision |[Switch threshold, F

¢ Objectives Producing Errors — Lists the test or proof objectives for
which Simulink Design Verifier encountered errors during its analysis. In
this case, analyzing these objectives involves nonlinear arithmetic, which
Simulink Design Verifier does not support.

Tahle 2.4. Objectives Producing Errors

#:  |Type Model Item Description

5 |Decision |Saturation Sat_urate Saturation", input = lower
= lirnit, F

8 |Decision |Saturation Saturat_e _Saturatlon ,Input ==
E— upper limit, T

If Simulink Design Verifier’'s Mode parameter specifies Test generation,
the Status section also includes the following tables:

¢ Objectives Proven Unsatisfiable — Lists the test objectives that
Simulink Design Verifier determined to be unsatisfiable. In this case,
Simulink Design Verifier determined that there are no test cases that
achieve these objectives.

8-13
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Tahle 2.1. Objectives Proven Unsatisfiable

#:  |Type Model ltem Description
Custom Test - L e T
) Objective Test Objective Test Objective "Test Objective”:1

* Objectives Satisfied — Lists test objectives that Simulink Design Verifier
satisfied. In this case, Simulink Design Verifier generated test cases that
achieve these objectives.

Tabhle 2.2. Objectives Satisfied

#: | Type Model Item Description

1 |Decision |Abs Abs "Abs" input <0, F

2 |Decision |Abs Abs "Abs" input <=0, T

- . Switch "Switch", trigger >=

4 |Decision |Switch threshold, T

6 |Decision |Saturation Sat_urate Saturation”, input = lower
= limit, T

7 |Decision |Saturation Saturat_e _Saturatlon ,Input ==
- upper limit, F

® Objectives Satisfied - No Test Case — Lists test objectives that
Simulink Design Verifier satisfied without generating test cases. In this
case, you might have specified a test objective on a signal whose value
Simulink Design Verifier cannot control; or Simulink Design Verifier might
have encountered a divide-by-zero error when instantiating a test case.

Table 2.1. Objectives Satisfied - No Test Case

#:  |Type Model ltem Description

i Cu_stnm Test Test Obisctive Test Objective "Test Objective” :
DOhjective -85 hIEElve 0.9

7 Cu_stu:ur_n Test Test Obisctive Test Objective "Test Objective” :
Objective st hleciive 1.1

Otherwise, if Simulink Design Verifier's Mode parameter specifies Property
proving, the Status section includes:

8-14
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® Objectives Proven Valid — Lists the proof objectives that Simulink
Design Verifier proved valid.

Tahle 2.1. Objectives Proven Valid

#: | Type Model ltem Description
Custom . R
1 |Praof Proof Obisctive F'runthJectwe Proof Objective

Ohjective !

¢ Objectives Falsified with Counterexamples — Lists the proof
objectives that Simulink Design Verifier disproved. In this case, Simulink
Design Verifier generated counterexamples that falsify these objectives.

Tahle 2.1. Objectives Falsified with Counterexamples

#:  |Type Model ltem Description
Custom S L
2 |Proof Proof Obisctive 1F'ru:uofObjeu:twe Proof Objective” :
Ohjective

® Objectives Falsified - No Counterexample — Lists the proof
objectives that Simulink Design Verifier disproved without generating
counterexamples. In this case, you might have specified a proof objective on
a signal whose value Simulink Design Verifier cannot control; or Simulink
Design Verifier might have encountered a divide-by-zero error when
instantiating a counterexample.

Tahle 2.1. Objectives Falsified - No Counterexample

#: | Type Model ltem Description
Custom o o
1 |Praof Proof Obisctive Proof Objective "Proof Objective”
I Croothjeclive n.a
Ohjective
Custom o o
> |Praof Proof Obisctive Proof Objective "Proof Objective”
I Croothjeclive 1.1
Ohjective
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Note The Status section displays only the tables that contain one or more
objectives.

Model Hierarchy

Following the Status section is a series of sections that represent the model
hierarchy—from the root level to the model’s subsystems and Stateflow
charts. Each section summarizes all the test or proof objectives that a
particular hierarchical level of the model contains.

For example, suppose a model named my_model contains Abs and Switch
blocks in its root level. If you use Simulink Design Verifier to generate tests
for this model, the report displays a section that lists only the test objectives
associated with the root-level model:

my_model
Objectives of: Abs

#: Status Test Cases Description
1 Satisfied TC 1 input <0, F

2 Satisfied z3 input <0, T

Objectives of: Switch

#: |Status Test Cases|Description
3 Undecidable|n/a trigger == threshold, F
4 Satisfied TC1 trigger == threshold, T

Further, suppose that the root level of this same model includes a subsystem
named my_subsystem, which contains a Test Objective block. In another
section, the report lists the test objective associated with this subsystem:

8-16
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my_subsystem
Objectives of: Test Objective

i Status Test Cases|Description
5 Satisfied |[TC 2 1

Each section lists objectives that correspond to particular model items in a
model hierarchy. This includes the following information:

e Status of a test or proof objective

® Test case that achieves a test objective, or counterexample that falsifies
a proof objective

® Description of a test of proof objective

Test Cases / Counterexamples Chapter

The Test Cases / Counterexamples chapter provides an overview of the test
cases or counterexamples that Simulink Design Verifier generated during its
analysis. Depending on whether Simulink Design Verifier’'s Mode parameter
specifies Test generation or Property proving, this chapter includes
sections associated with the following:

* “Test Cases” on page 8-17

* “Counterexamples” on page 8-19

Test Cases

If Simulink Design Verifier’s Mode parameter specifies Test generation,
the Test Cases / Counterexamples chapter includes a series of sections that
summarize the test cases Simulink Design Verifier generated.

8-17
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Test Case 1
Summary
Length: 0.2 Seconds (3 sample periods)

Objective Count: 4

Objectives Reached At:

Step Time Objectives

I M= =

—
L]

Generated Input Data.

Time |0 0.1
Step 1 2
signal_AjD 1
signal_B|1 0
signal_C|0 1

Each section lists the following information about a test case:

¢ Length of the signals that comprise the test case
¢ Total number of test objectives that the test case achieves

¢ Time step and corresponding time at which the test case achieves particular
test objectives

¢ Values of the signals that comprise the test case

Note The Generated Input Data table can display a dash (-) instead of a
number as a signal value. In this case, the value of the signal at that time
step does not affect the test objective. In the test harness model, the Inputs
block represents these values with zeros.
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Counterexamples

If Simulink Design Verifier’s Mode parameter specifies Property proving,
the Test Cases / Counterexamples chapter includes a series of sections that
summarize the counterexamples Simulink Design Verifier generated.

Counterexample 1

Summary
Length: 0.2 Seconds (2 sample periods)
Objective Count: 1

Objectives Reached At:

Objectives Falsified
2

Generated Input Data.

Time |0
Step |1
Ind |0
In1

Each section lists the following information about a counterexample:

¢ Length of the signals that comprise the counterexample
¢ Total number of proof objectives that the counterexample falsifies
¢ Particular proof objectives that the counterexample falsifies

e Values of the signals that comprise the counterexample

Note The Generated Input Data table can display a dash (-) instead of a
number as a signal value. In this case, the value of the signal at that time
step does not affect the proof objective. In the test harness model, the Inputs
block represents these values with zeros.

8-19
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Approximations Chapter

The Approximations chapter provides an overview of the approximations that
Simulink Design Verifier uses. It displays a table that appears like this:

#: Type Description

Wodel includes floating point arithmetic that Simulink Design

“erifier approximates with rational nurmber arithrmetic.

MWodel includes 2-D lookup tables. Simulink Design “erifier

2 Lookup table (2-D) linearization approxirmates nonlinear 2-0 interpolation with linear
interpolation by fitting planes to each interpolation interval.

1 Rational approximation

Each row of the table describes a specific type of approximation that Simulink
Design Verifier used during its analysis of the model.

Note Review the analysis results carefully when Simulink Design Verifier
uses approximations. In rare cases, an approximation can result in test cases
that fail to achieve test objectives or counterexamples that fail to falsify
proof objectives. For example, suppose Simulink Design Verifier generates

a test case signal that should achieve an objective by exceeding a threshold;
however, a floating-point-roundoff error might prevent that signal from
attaining the threshold value.
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Examining Simulink Design Verifier Data Files

Simulink Design Verifier generates a data file after it completes its analysis.
The data file is a MAT-file that contains a structure named sldvData. This
structure stores all the data that Simulink Design Verifier gathers and
produces during its analysis of a model. Although Simulink Design Verifier
displays the same data graphically in the test harness model and report,
you might like to use the data file to conduct your own analysis or generate
a custom report.

The following sections describe the contents of the sldvData structure and
explain a method for simulating your model using a data file.

* “Anatomy of the sldvData Structure” on page 8-21
* “Simulating Models with Simulink Design Verifier Data Files” on page 8-25

Anatomy of the sldvData Structure

When Simulink Design Verifier completes its analysis, it produces a MAT-file
that contains a structure named sldvData. To explore the contents of the
sldvData structure:

1 Generate test cases for the sldvdemo_flipflop model (see “Running a
Demo Model” on page 1-6).

Simulink Design Verifier produces a data file
named sldvdemo_flipflop_sldvdata.mat in the
sldv_output\sldvdemo flipflop directory.

2 At the MATLAB prompt, enter the following command:

load('sldv_output\sldvdemo_flipflop\sldvdemo_flipflop_sldvdata.mat')

MATLAB loads the sldvData structure into its workspace. This
structure contains the Simulink Design Verifier analysis results of the
sldvdemo_flipflop model.

3 At the MATLAB prompt, enter sldvData.

MATLAB displays the following field names that constitute the structure:
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sldvData =

ModelObjects: [1x2 struct]
Objectives: [1x12 struct]
TestCases: [1x5 struct]

See “Structures” in the MATLAB documentation for more information
about working with structures.

The following sections describe the contents of each primary field in the
sldvData structure:

* “ModelObjects Field” on page 8-22

® “Objectives Field” on page 8-23

e “TestCases Field” on page 8-23

ModelObjects Field

In the sldvData structure, the ModelObjects field lists the model items and
their associated objectives. The following table describes each subfield of the
ModelObjects field.

Subfield Name | Description

descr String specifying the full path to a model object,
including objects in a Stateflow chart.

slPath String specifying the full path to a Simulink model
object.

sfObjType String specifying the type of a Stateflow object, e.g., S

for state and T for transition.

sfObjNum Integer representing the unique identifier of a
Stateflow object.

objectives Vector of integers representing the indices of objectives
associated with a model object.

handle Real number specifying the handle of a model object.
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Objectives Field

In the sldvData structure, the Objectives field lists information about
each objective, such as its type, status, and description. The following table
describes each subfield of the Objectives field.

Subfield Name

Description

type String specifying the type of an objective.

status String specifying the status of an objective.

descr String specifying the description of an objective.

label String specifying the label of an objective.

outcomeValue Integer specifying an objective’s outcome.

coveragePointIdx | Integer representing the index of a coverage point
with which an objective is associated.

modelObjectIdx Integer representing the index of a model object with
which an objective is associated.

testCaseldx Integer representing the index of a test case or

counterexample that addresses an objective.

TestCases Field

In the sldvData structure, the TestCases field lists information about each
test case or counterexample, such as its signal values and either the test
objectives that it achieves or the proof objectives that it falsifies. The following
table describes each subfield of the TestCases field.

Subfield Name

Description

timeValues Vector specifying the time values associated with
signals in a test case or counterexample.
dataValues Cell array specifying the data values associated with

signals in a test case or counterexample.

8-23



8 Reviewing the Results

Subfield Name

Description

paramValues

Structure specifying the parameter values associated
with a test case or counterexample. Its fields include:

name — String specifying the name of a parameter.
value — Number specifying the value of a parameter.

noEffect — Logical value specifying whether a
parameter’s value affects an objective.

stepValues

Vector specifying the number of time steps that
comprise signals in a test case or counterexample.

objectives

Structure specifying objectives that a test case or a
counterexample addresses. Its fields include:

objectiveIdx — Integer representing the index of an
objective that a test case achieves or a counterexample
falsifies.

atTime — Time value at which either a test case
achieves an objective or a counterexample falsifies an
objective.

atStep — Time step at which either a test case
achieves an objective or a counterexample falsifies an
objective.

dataNoEffect

Cell array of logical vectors specifying whether a
signal’s data values affect an objective. The vector
uses 1 to indicate that a signal’s data value does not
affect an objective; otherwise, it uses 0.

signallabels

Cell array of strings specifying the labels of signals in
a test case or counterexample.

portdimensions

Cell array of vectors specifying the dimensions of
signals in a test case or counterexample.
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Simulating Models with Simulink Design Verifier
Data Files

The sldvruntest function enables you to simulate a model using test
cases or counterexamples that reside in a Simulink Design Verifier data
file. For example, suppose the following command specifies the location of
the data file that Simulink Design Verifier produced after analyzing the
sldvdemo_flipflop model (see “Running a Demo Model” on page 1-6).:

sldvDataFile = 'sldv_output\sldvdemo_flipflop\sldvdemo_flipflop_sldvdata.mat'

Use the sldvruntest function to simulate the sldvdemo flipflop model
using test case 2 in the data file:

output = sldvruntest('sldvdemo_flipflop', sldvDataFile, 2)

See sldvruntest in Chapter 9, “Functions — Alphabetical List” for more
information.
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Analyzing Large Models
and Improving Performance

This chapter describes some practical strategies for analyzing larger models
with Simulink Design Verifier and troubleshooting errors and warnings.
These strategies will help you to get the most benefit from Simulink Design
Verifier.

In general, you will see improved performance by breaking your model into
smaller components and running Simulink Design Verifier on them. The
strategies in this chapter compliment a divide-and-conquer approach so you
can run Simulink Design Verifier on larger portions of your system.

¢ “How Simulink Design Verifier Works” on page A-2

® “Sources of Model Complexity in Simulink Design Verifier” on page A-5

¢ “Handling Models with Large Numbers of Inputs” on page A-6

¢ “Reducing Complexity from Floating-Point Operations and Nonlinear
Arithmetic” on page A-7

e “Partitioning Inputs and Generating Tests Incrementally” on page A-9
¢ “Handling Models with Large State Spaces” on page A-11
¢ “Handling Problems with Counters and Timers” on page A-12

® “Special Strategies for Proving Properties of Larger Models” on page A-13
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A-2

How Simulink Design Verifier Works

Simulink Design Verifier is a very efficient search tool that explores the
simulation behavior of a model. It searches the possible values of model
inputs to find a simulation that satisfies an objective. The exact definition of
these search objectives comes from the Simulink Design Verifier configuration
options and your model’s structure.

The search always begins with the initial configuration of the model (at t=0)
and can span an arbitrary number of time steps. Generally, there are an
infinite number of search paths because the values of inputs are independent
from one time step to the next, and there is no fixed limit to the number of
time steps. If there were no way to reduce the search space, Simulink Design
Verifier would never be able to stop its analysis.

The search is fundamentally limited by tracking the persistent information
in the model such as discrete states, data-store memories, and persistent
variables. Once a search has explored all possible inputs from all possible
configurations, the results are equivalent to having performed a complete
search of every possible infinite sequence of inputs.

Consider a simple Simulink model with two Logical Operator blocks and
a Memory block:

» b
AHD | boclean
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Logical Mmooy
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The persistent information in this model is limited to the Boolean value of the
Memory block. The input to the model is a single Boolean value. Therefore the
complete behavior of the model, including the behavior that would result from
an arbitrarily long sequence of inputs, is described by the following table:



How Simulink Design Verifier Works

# | Input Memory Output Next Memory
Value Value

1 false false false false

2 true false false true

3 false true false true

4 true true true false

If you run Simulink Design Verifier to find a test case with a true output, it
looks through this table to see if such a scenario is possible.

Once Simulink Design Verifier discovers a configuration that satisfies an
objective, it needs to find a path to reach this configuration from the initial
conditions. If the initial memory value is true, the test case would only need
to be a single time step where the input was true. If the initial value of the
memory is false, the test case would need to force the memory to be true and
the test case would be a sequence of row 2 followed by row 4.

There are an infinite number of test cases that will cause the output to be
true, and regardless of the state value, the output can be held false for

an arbitrary time before making it true. When Simulink Design Verifier
searches, it returns the first case it encounters that satisfies the objective.
This will invariably be the simulation with the fewest time steps. Sometimes
this result is undesirable because it is unrealistic or does not satisfy some
other test requirement.

The same basic principles from this example apply to property proving

and test generation. During test generation the search criteria is explicitly
specified from the options. During property proving the objective is the
opposite of the proof to be satisfied. If that objective is satisfied the path is
returned as a counterexample of the proof. If the search is completed without
finding a satisfying path the proof completes successfully.

In larger more complicated models, Simulink Design Verifier uses
mathematical techniques to simplify the search problem. It can identify
portions of the model that do not affect the objectives of interest. It can
discover relationships within the model that reduce the complexity of the
search, and it can reuse the intermediate results from one objective to another.
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Ultimately the problem is reduced to a search though the logical values that
describe your model.

Simulink Design Verifier is particularly efficient at simplifying linear
arithmetic of floating point numbers by approximating them with rational
numbers. Simulink Design Verifier discovers how the logical relationships
between these variables affect the proof and test objectives. This enables
Simulink Design Verifier to support supervisory logic that is commonly found
in embedded controls designs.



Sources of Model Complexity in Simulink Design Verifier

Sources of Model Complexity in Simulink Design Verifier
A model can complicate the search process in the following ways:

® Size of inputs
® Number of possible configurations
® Ability to reach one configuration from another

You need to understand these sources of complexity and the strategies to
reduce their impact to get the best performance from Simulink Design Verifier.
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Handling Models with Large Numbers of Inputs

Input complexity comes from the number of inputs, the type of the inputs, and
the way the inputs affect the model state and the objectives of the analysis.
Because the search is performed on a logical simplification of your model,
Simulink Design Verifier is more efficient at handling logical inputs than
integer or floating-point inputs.

Floating-point inputs can be efficiently handled when their values impact the
design through linear inequalities such as x <y or a > 0. Nonlinear arithmetic
of floating-point numbers is not supported by Simulink Design Verifier, as
occurs with multiplication or division unless one of the multiply operands

or the divisor is a constant.

Input complexity can also result from certain cast operations. For example,
casting a double to an int8 can introduce a nonlinearity in certain situations.

You can reduce input complexity by separating the logical and arithmetic
portions of a design and restricting Simulink Design Verifier to the logical
portion.



Reducing Complexity from Floating-Point Operations and Nonlinear Arithmetic

Reducing Complexity from Floating-Point Operations and
Nonlinear Arithmetic

Another very effective strategy is to restrict the floating-point inputs to a set
of representative values or, ideally, a single constant value. This process,
called discretization, treats the free floating-point input as though it were

an enumeration. Discretization is the simplest way to handle nonlinear
arithmetic from multiplication and division.

Consider the following model with a Product block feeding a Saturation block:

)
®
x >
"

I Saturation

hultiply

Simulink Design Verifier generates errors when attempting to satisfy the
upper and lower limits of the Saturation block. You can work around these
errors by restricting one of the inputs to be a range of values. For example, if

you restrict the second input (y) to be either 1, 2, 5, or 10, Simulink Design
Verifier will produce test cases for all inputs:

-, o
"
1, 2,5, 10} % -
iz - Saturation aut
hultiply

You can also constrain signals that are intermediate or output values of the
model. Sometimes this makes it easier to work around multiplication or
divisions that are contained inside lower-level subsystems and do not depend
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on input values. In these situations you must be careful to avoid creating
constraints that contradict with the model. This occurs when a constraint can
never be satisfied because it contradicts some aspect of the model or some
other constraint. Here is a simple example of a contradictory model:

(1 >
*
2.5, 10} # >

out

1 > Saturation

hultiply

When you work with very large models that have many multiplication
and division operations, it is often easier to add constraints to all of the
floating-point inputs rather than to identify the precise set of inputs that
require constraints.

As you create large models you should identify sets of values for each Input
port that are required to satisfy your testing needs. For example, if you have
an input for model speed, and within your design there are paths of execution
that are conditioned on speed being above or below thresholds of 80, 150, 600
and 8000 RPM, you might choose to restrict speed values to be either 50, 100,
200, 1000, 5000 or 10000 RPM so that every threshold can be either active
or inactive.



Partitioning Inputs and Generating Tests Incrementally

Partitioning Inputs and Generating Tests Incrementally

Like other Simulink parameters, constraint values can be shared across
several blocks by referencing a common workspace variable and they can be
initialized from M-files. If you have several inputs related to speed, such
as desired speed, measured speed, and average speed, you might choose to
constrain all of them to the same set of values.

You can use parameterized constraints and successive runs of Simulink
Design Verifier to implement an incremental test generation strategy:

1 Partition inputs so that some are held constant, some are restricted to
sets of constants, and some are free.

2 Generate test cases and run those test cases to collect model coverage.
3 Choose new values and new partitions of inputs.

4 Generate tests for missing coverage using sldvgencov and the current
test coverage.

5 Repeat steps 3 and 4 until sufficient coverage is generated.
You should choose partitions of inputs that enable further simplification when

Simulink Design Verifier runs. Consider the following model, which has three
mutually independent enabled subsystems:
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You can incrementally generate test cases for each of these subsystems by
constraining the first input to the appropriate constant value before running
Simulink Design Verifier. In this way, as tests are created for each of the
subsystems, the complexity of the other two is ignored.
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Handling Models with Large State Spaces

Persistent variables in the design impact the complexity of analysis in much
the same way as input complexity. As such, many of the same strategies can
be used to simplify the complexity of the state space that must be searched.
States that are delayed values of inputs can be simplified by applying
constraints to the input signal that is delayed. States that are contained
within conditionally executed subsystems can be simplified by constraining
the input so the system does not execute.

States that are computed from previous state values present a special
challenge. For example, the integrator value in a PID controller can be
restricted only to a set of values if that set includes all reachable values from
the initial value or the input is forced to be 0. Both of these limitations are
usually not practical and would probably make test generation less complete.

An alternative strategy is to leverage any existing simulation data to help
satisfy your testing needs. If you have existing test data, you can run this
on your model and collect model coverage. Using the sldvgencov function,
you can ignore model coverage objectives that have already been satisfied in
simulation when you supply a coverage data object.
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Handling Problems with Counters and Timers

Complexity from states occurs from both the size of the state representation
and the number of time steps that are required to transition from one state
to another. Simulink Design Verifier searches through sequences of time
steps, starting from the default configuration, to find input values that
reach a state that satisfies an objective. The search process proceeds in a
breadth-first manner. All configurations that can be reached in a single time
step are investigated before any of the configurations that can be reached
in two time steps. Likewise, all configurations that can be reached in two
time steps are investigated before any configuration that requires three or
more time steps, etc.

Models that contain time delays, such as countdown timers, hinder Simulink
Design Verifier by forcing the search to span large numbers of time steps. By
design, the value of a counter can reach n only when its previous value is n-1.

Similar effects can also occur when systems use extensive averaging and
filtering to delay the response to a change in inputs. Any aspect of the design
that delays the response will cause the test sequences to contain more time
steps and longer test cases that are more difficult to identify.

There are some basic strategies you can use to improve performance in models
that have delays:

1 Make time delays calibratible parameters and choose very small values
when running Simulink Design Verifier. It is likely that a system with a
logical error when a time delay is set to 2000 steps will still demonstrate
that error if the time delay is changed to 2 steps. If your system has several
delays, you might want to choose small but unique values for each of them
so that your delays will be progressively satisfied.

2 Choose higher frequency cutoffs for filters and fewer samples to average so
that filtering delays are minimized.
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Special Strategies for Proving Properties of Larger Models

Property proving uses the same underlying techniques as test generation and
suffers from the same performance limitations; but unlike test generation, it
is often impossible to simplify the problem without compromising the validity
of the results. Simple proof objectives that are not affected by model dynamics
can often be quickly proven, but otherwise a successful proof requires that
Simulink Design Verifier search through all the reachable configurations of
your model, even the ones that are only reached after long time delays. The
computation time and memory required to search a model completely often
make an exhaustive proof impractical.

Alternatively, you can use the bounded model checking capability within
Simulink Design Verifier to examine properties in larger, more complicated
models. Using bounded model checking, you restrict the search for property
violations to a predefined limit of time steps. If a violation is not detected, you
can be confident that it is impossible to violate the property with any input
sequence having fewer time steps than the specified limit; however, you will
not prove that the property is true because there might be a counterexample
having more time steps than the specified limit.

To configure Simulink Design Verifier for bounded model checking, on the
Design Verifier > Property Proving pane of the Configuration Parameters
dialog box, specify the value of the Strategy parameter as Find violation.
When you use this strategy, the Maximum violation steps parameter
becomes active so that you can specify an upper bound for the number of
time steps in the search. See “Property Proving Pane” on page 5-10 for more
information.

An effective strategy for proving properties combines proving and violation
searching to get the most benefit from Simulink Design Verifier that is
practical for the properties and models under investigation:

1 Start with the Proving strategy and use a relatively short processing time
limit, such as 5-10 minutes. If there are trivial counterexamples or if your
properties do not depend on model dynamics, Simulink Design Verifier
should complete the analysis in that amount of time.

A-13



A Analyzing Large Models and Improving Performance

A-14

2 Switch to the Find violation strategy and choose a small bound on the
number of violation steps, such as 4-6. If your properties have simple
counterexamples, Simulink Design Verifier should discover them.

3 If you do not find any violations with a small bound, increase the bound and
look for longer counterexamples. You probably will want to increase the
bound in several increments and observe the processing time and memory
consumption. System resources might limit the length of violation that can
be searched. You should also consider the dynamics of your model and the
number of time steps that are needed to transition between an arbitrary
pair of configurations. If you choose too large of a bound, the violation
search can be more complex than the unbounded proof.

4 If you are able to run violation searches with relatively large bounds, e.g.,
30-50 time steps, you can switch back to the Proving strategy and use a
longer time limit, such as several hours.
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sldvblockreplacement

Purpose

Syntax

Description

Synopsis

Replace model blocks to support Simulink Design Verifier

[status, newmodel] = sldvblockreplacement(model)
[status, newmodel] sldvblockreplacement (model, options)

[status, newmodel] sldvblockreplacement(model) copies model
and replaces specified model blocks and other model components to
prepare the model for Simulink Design Verifier analysis. This function
replaces the blocks of the model according to the block replacement
rules specified in the configuration settings associated with model.
This function returns a handle to the new model in newmodel. The
sldvblockreplacement function returns 1 upon successful completion
and O otherwise.

[status, newmodel] = sldvblockreplacement(model, options)
copies model and replaces specified model blocks and other model
components to prepare the model for Simulink Design Verifier analysis.
This function replaces the blocks of the model according to the block
replacement rules using the sldvoptions object specified by options.
This function returns a handle to the new model in newmodel.

sldvoptions



sldvcompat

Purpose

Syntax

Description

Examples

Check model for compatibility with Simulink Design Verifier

status = sldvcompat(model)

status = sldvcompat(block)
status = sldvcompat(model, options)
status = sldvcompat(model) returns 1 if model is compatible

with Simulink Design Verifier and 0 otherwise. When checking for
compatibility, Simulink Design Verifier replaces model blocks if this
option has been enabled.

Note Ifyou call this function without specifying a model, the function
operates on the current system.

status = sldvcompat(block) converts the Simulink block into a
temporary model, then checks the compatibility of that model with
Simulink Design Verifier. The function destroys the temporary model
after the compatibility check.

status = sldvcompat(model, options) checks the subsystem
specified by model for compatibility with Simulink Design Verifier using
the sldvoptions object specified by options.

The following commands open the vdp demo model and check for its
compatibility with Simulink Design Verifier:

vdp
status = sldvcompat('vdp')



sldvcompat

Simulink Design Verifier displays the result as follows:

Checking compatibility of model "vdp"
Model "vdp" is not compatible with Simulink Design Verifier
status =

0

The following commands open sldvdemo_flipflop and check for its
compatibility with Simulink Design Verifier:

sldvdemo_flipflop
status = sldvcompat('sldvdemo_flipflop')

Simulink Design Verifier displays the results as follows:
Checking compatibility of model "sldvdemo_flipflop"

Compiling model...done
Checking compatibility...done

Model "sldvdemo_flipflop" is compatible with
Simulink Design Verifier.

ans =

See Also sldvoptions, sldvrun



sldvextract

Purpose

Syntax

Description

Run Simulink Design Verifier to extract subsystem contents into new
model

[status, modelH] = sldvextract(blockH)

[status, modelH] = sldvextract(blockH) runs the Simulink Design
Verifier on the model that contains the subsystem blockH and extracts
the contents of blockH into a new model. It returns the handle of

the new model in modelH. The sldvextract function returns 1 upon
successful completion and 0 otherwise.



sldvgencov

Purpose
Syntax

Description

See Also

Run Simulink Design Verifier to obtain missing model coverage
[status, cvdo] = sldvgencov(model, options, startcov)

[status, cvdo] = sldvgencov(model, options, startcov) runs
Simulink Design Verifier on the specified model using the sldvoptions
object specified by options. Simulink Design Verifier ignores all model
coverage objects that are satisfied in the cvdata object specified by
startcov. It returns 1 for status if Simulink Design Verifier was
successful or 0 otherwise. It also measures the coverage in the new tests
and returns the resulting cvdata object cvdo.

sldvoptions, sldvrun



sldvharnessmerge

Purpose

Syntax

Description

See Also

Merge test cases and initializations into one model

status = sldvharnessmerge(name, models,
inititialization_commands)

status = sldvharnessmerge(name, models,

inititialization_commands) collects the test data and

initialization commands from each test harness model listed in models
and saves them in name. This function assumes that you have created
each test harness model with Simulink Design Verifier, either with the
sldvrun function or the Design Verifier > Generate Tests menu item.

If name does not exist, this function creates it as a copy of the first model
in models. This function then copies the data from the other models
into this model. If name was created from a previous sldvharnessmerge
run, subsequent runs of this function for name will maintain the correct
structure and initialization from that earlier run. If name matches

an existing Simulink model, this function merges the test data from
models into name.

® models can be a cell array of model names or an array of model
handles.

® initialization_commands must be a cell array of strings the same
length as models. initialization_commands define parameter
settings for the test cases of each test harness model. Each time a
model test case executes, the associated initialization command is
evaluated in the base workspace.

Consider using sldvharnessmerge with sldvgencov to combine test
cases that use different sets of parameter values.

sldvgencov



sldvoptions

Purpose Access a Simulink Design Verifier options object
Syntax options = sldvoptions
options = sldvoptions(model)
Description options = sldvoptions returns a Simulink Design Verifier options
object that contains default values for its parameters (see “sldvoptions
Object Parameters” on page 9-8).
options = sldvoptions(model) returns the Simulink Design Verifier
options object attached to model.
sldvoptions The following table lists and describes parameters that comprise a
Obiect Simulink Design Verifier options object.
Parameters
Parameter Description Values
Assertions Set by the Assertion "EnableAll' | 'DisableAll' |
blocks option on the {'UseLocalSettings'}
Design Verifier >
Property Proving pane
of the Configuration
Parameters dialog box.
BlockReplacement Set by the Apply block ‘on' | {'off'}

replacements option on
the Design Verifier >
Block Replacements
pane of the Configuration
Parameters dialog box.




sldvoptions

Parameter Description Values
BlockReplacementModel- | Set by the File path of | string
FileName the output model option | {'$ModelName$ replacement'}

on the Design Verifier
> Block Replacements
pane of the Configuration
Parameters dialog box.

BlockReplacementRules-
List

Set by the List of block
replacement rules
option on the Design
Verifier > Block
Replacements pane

of the Configuration

1 1 1

string
{'<FactoryDefaultRules>"'}

DataFileName

Set by the Data file
name option on the
Design Verifier

> Results pane of
the Configuration
Parameters dialog box.

string
{'$ModelName$_sldvdata'}

DisplayReport

Set by the Display
report option on
the Design Verifier
> Report pane of
the Configuration

{'on'} | 'off'

DisplayUnsatisfiable-
Objectives

Set by the Display
unsatisfiable test
objectives option on
the Design Verifier
pane of the Configuration
Parameters dialog box.

{'on'} | 'off'




sldvoptions
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Parameter

Description

Values

HarnessModelFileName

Set by the Harness
model file name
option on the Design
Verifier > Results pane
of the Configuration

string {'$ModelName$ harness'}

MakeOutputFilesUnique

Set by the Make
output file names
unique by adding a
suffix check box on the
Design Verifier pane
of the Configuration
Parameters dialog box.

{'on'} | 'off'

MaxProcessTime

Set by the Maximum
analysis time option

on the Design Verifier
pane of the Configuration
Parameters dialog box.

double {'600'}

MaxTestCaseSteps

Set by the Maximum
test case steps option
on the Design Verifier
> Test Generation pane
of the Configuration
Parameters dialog box.

int32 {'500'}

MaxViolationSteps

Set by the Maximum
violation steps option
on the Design Verifier
> Property Proving
pane of the Configuration
Parameters dialog box.

int32 {'20"'}

Mode

Set by the Mode option
on the Design Verifier
pane of the Configuration
Parameters dialog box.

{'TestGeneration'} |
'"PropertyProving’




sldvoptions

Parameter

Description

Values

ModelCoverageObjective

5 Set by the Model

coverage objectives
option on the Design
Verifier > Test
Generation pane

of the Configuration
Parameters dialog box.

‘None' | 'Decision' |
‘ConditionDecision’' |
{'MCDC"}

OQutputDir

Set by the Output
directory option on the
Design Verifier pane
of the Configuration
Parameters dialog box.

string
{'sldv_output/$ModelName$'}

Parameters

Set by the Apply
parameters option

on the Design Verifier
> Parameters pane

of the Configuration
Parameters dialog box.

{'on'} | 'off'

ParametersConfigFile-
Name

Set by the Parameter
configuration file
option on the Design
Verifier > Parameters
pane of the Configuration
Parameters dialog box.

string
{'sldv_params_template.m'}

ProofAssumptions

Set by the Proof
assumptions option

on the Design Verifier
> Property Proving
pane of the Configuration
Parameters dialog box.

'EnableAll' | 'DisableAll' |
{'UseLocalSettings'}

9-11



sldvoptions

Parameter Description Values
ProvingStrategy Set by the Strategy 'FindViolation'
option on the Design | {'Prove'} |
Verifier > Property '"ProveWithViolationDetection'
Proving pane of
the Configuration
Parameters dialog box.
ReportFileName Set by the Report string {'$ModelName$ report'}

file name option on
the Design Verifier
> Report pane of
the Configuration
Parameters dialog box.

ReportIncludeGraphics

Set by the Include
screen shots and plots
option on the Design
Verifier > Report pane
of the Configuration
Parameters dialog box.

‘on' | {'off'}

SaveDataFile

Set by the Save test
data to file option on
the Design Verifier
> Results pane of
the Configuration
Parameters dialog box.

{'on'} | 'off'

SaveHarnessModel

Set by the Save test
harness as model
option on the Design
Verifier > Results pane
of the Configuration
Parameters dialog box.

{'on'} | 'off'




sldvoptions

Parameter

Description

Values

SaveReport

Set by the Generate
report of the results
option on the Design
Verifier > Report pane
of the Configuration
Parameters dialog box.

{'on'} | 'off'

TestConditions

Set by the Test
conditions option on
the Design Verifier >
Test Generation pane
of the Configuration
Parameters dialog box.

'"EnableAll' | 'DisableAll’' |
{'UselLocalSettings'}

TestObjectives

Set by the Test
objectives option on
the Design Verifier >
Test Generation pane
of the Configuration
Parameters dialog box.

'"EnableAll' | 'DisableAll' |
{'UseLocalSettings'}

TestSuiteOptimization

Set by the Test suite
optimization option on
the Design Verifier >
Test Generation pane
of the Configuration
Parameters dialog box.

{'CombinedObjectives'} |
'IndividualObjectives'

See Also

sldvblockreplacement, sldvcompat, sldvgencov, sldvrun
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Purpose

Syntax

Description

Run Simulink Design Verifier on model or system

status = sldvrun(model)

status = sldvrun(block)

status = sldvrun(model, options)

[status, filenames] = sldvrun(model, options)

status = sldvrun(model) runs Simulink Design Verifier on the
specified model. Simulink Design Verifier uses the configuration
settings associated with model (if available); otherwise, Simulink
Design Verifier uses its default configuration settings. Upon completion,
sldvrun returns one of the following values for status:

® -1 — Maximum processing time was exceeded.
® 0 — An error occurred.

® 1 — Preprocessing completed normally.

Note Ifyou call this function without specifying a model, the function
operates on the current system.

status = sldvrun(block) converts the Simulink block into a new
model, then runs Simulink Design Verifier on the new model. Simulink
Design Verifier uses the configuration settings associated with the
parent model of block (if available); otherwise, Simulink Design
Verifier uses its default configuration settings.

status = sldvrun(model, options) runs Simulink Design Verifier
on the model specified by model. Simulink Design Verifier uses the
sldvoptions object specified by options.

[status, filenames] = sldvrun(model, options) runs Simulink

Design Verifier on the model specified by model. This function returns
status and filenames, a structure whose fields list the names of the

files that Simulink Design Verifier generates:



sldvrun

® HarnessModel — Simulink harness model.
® DataFile — MAT-file that contains raw input data.
® Report — HTML report that documents the results.

® ExtractedModel — Simulink model extracted from subsystem.

See Also sldvcompat, sldvgencov, sldvoptions
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Purpose

Syntax

Description

See Also

Simulate model using test case in Simulink Design Verifier data file

data = sldvruntest(model, sldvDataFile, testIdx)

data = sldvruntest(model, sldvDataFile)

[data, cvdo] = sldvruntest(model, sldvDataFile, testIdx,
true)

[data, cvdo] = sldvruntest(model, sldvDataFile, [], true)

data = sldvruntest(model, sldvDataFile, testIdx) simulates
model using input signals associated with a single test case that
Simulink Design Verifier generated. testIdx specifies the index of
the test case that the MAT-file, sldvDataFile, contains. This function
returns data, a structure whose fields list the simulation results:

e T — Contains the simulation time vector.
e X — Contains the simulation state matrix.

® Y — Contains the simulation output matrix.

data = sldvruntest(model, sldvDataFile) simulates model using
all test cases that the MAT-file, sldvDataFile, contains.

[data, cvdo] = sldvruntest(model, sldvDataFile, testIdx,
true) simulates model using the test case that testIdx indexes in the
MAT-file sldvDataFile. Simulink collects model coverage information
during the simulation, which the function returns in the cvdata object
cvdo.

[data, cvdo] = sldvruntest(model, sldvDataFile, [], true)
simulates model using all test cases that the MAT-file, sldvDataFile,
contains. Simulink collects model coverage information during the
simulation, which the function returns in the cvdata object cvdo.

cvsim (in the Simulink Verification and Validation User’s Guide), sim
(in the Simulink Reference)
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Proof Assumption
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Purpose
Library

Description

true

¥ E

Constrain signal values when proving model properties
Simulink Design Verifier

When operating in property proving mode, Simulink Design Verifier
proves that properties of your model satisfy specified criteria (see
Chapter 7, “Proving Properties of a Model”). In this mode, you can use
Proof Assumption blocks to define assumptions for signals in your
model. The Values parameter lets you specify constraints on signal
values during a property proof. Use the Initial parameter to specify
whether the constraint applies throughout the entire proof or only at
its beginning. The block applies the specified Values parameter to its
input signal, and Simulink Design Verifier proves or disproves that the
properties of your model satisfy specified criteria.

The block’s parameter dialog box also allows you to

* Enable or disable the assumption.

® Specify that the block should display its Values parameter in the
model editor.

® Specify that the block should display its output port.

Note Simulink and Real-Time Workshop® ignore the Proof Assumption
block during model simulation and code generation, respectively.
Simulink Design Verifier uses the Proof Assumption block only when
proving model properties.

Specifying Proof Assumptions

Use the Values parameter to constrain signal values in property proofs.
Specify any combination of scalars and intervals in the form of a
MATLAB cell array (see “Cell Arrays” in the MATLAB documentation
for information about working with cell arrays).



Proof Assumption

Tip If the Values parameter specifies only one scalar value, you do not
need to enter it in the form of a MATLAB cell array.

Scalar values each comprise a single cell in the array, for example:
{0, 5}

A closed interval comprises a two-element vector as a cell in the array,
where each element specifies an interval endpoint:

{1, 21}

Alternatively, you can specify scalar values using the S1dv.Point
constructor, which accepts a single value as its argument. You can
specify intervals using the S1dv.Interval constructor, which requires
two input arguments, i.e., a lower bound and an upper bound for the
interval. Optionally, you can provide one of the following strings as a
third input argument that specifies inclusion or exclusion of the interval
endpoints:

e '()' — Defines an open interval.

® '[]' — Defines a closed interval.

e '(]' — Defines a left-open interval.
e '[)' — Defines a right-open interval.

Note By default, S1dv.Interval considers an interval to be closed if
you omit its third input argument.

As an example, the Values parameter
{0, [1, 3]}

specifies:
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® 0 — a scalar

e [1, 3] — a closed interval

The Values parameter

{Sldv.Interval(0, 1, '[)'), Sldv.Point(1)}

specifies:

® Sldv.Interval(0, 1, '[)') — the right-open interval [0, 1)

® Sldv.Point(1) — a scalar

If you specify multiple scalars and intervals for a Proof Assumption
block, Simulink Design Verifier combines them using a logical OR
operation during the property proof. In this case, Simulink Design
Verifier considers the entire assumption to be satisfied if any single
scalar or interval is satisfied.

Data Type The Proof Assumption block accepts signals of all built-in data types

Suppori‘ supported by Simulink. For a discussion on the data types supported
by Simulink, see “Data Types Supported by Simulink” in the Simulink
documentation.
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Parameters
and

Dialog

Box

E! Function Block Parameters: Assumption x|

— Dezign Yerfier &zsumption [mazk]

Azzumes zignal values when Simulink Dezign Wenfier proves model propertiez. The
input zignal is azzumed to be one of the values listed in the " alues' parameter. Twio
element vectors specify intervalz. Cell araps zpecify liztz. The signal must match one
of the lizted values or intervalz at every time step unlezs the ‘Inibal' check box iz
enabled, in which caze the azsumption iz for only the first ime step.

Example alues:

true

{I01]. 2. [4 5]. &}

{5Idv. Interval(-2, -1]. Sldv. Paint(0), Sldv. Intervalld, 1. ', 1}

— Parameter
¥ Enable
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Walues

Itrue
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W Dizplay values

W Pass through style [zhow Outpart]

0k I Cancel Help Apply

Enable

Specify whether the block is enabled. If selected (the default),
Simulink Design Verifier uses the block when proving properties
of a model. Clearing this option disables the block, that is, causes
Simulink Design Verifier to behave as if the Proof Assumption
block did not exist. If this option is not selected, the block appears

grayed out in the model editor.
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Type
Specify whether the block behaves as a Proof Assumption or Test
Condition block. Select Test Condition to transform the Proof
Assumption block into a Test Condition block.

Values
Specify the proof assumption (see “Specifying Proof Assumptions”
on page 10-2).

Initial
Specify whether the Values parameter applies at the beginning of
or throughout the entire proof. If selected, the block constrains
only the initial value of its input signal at the start of a proof
analysis (t=0). If not selected (the default), the block constrains
its signal value for the entire proof.

Display values
Specify whether the block displays the contents of its Values
parameter in the model editor. By default, this option is selected.

Pass through style
Specify whether the block displays an output port in the model
editor. If selected (the default), the block displays its output port,
allowing its input signal to pass through as the block output. If
not selected, the block hides its output port and terminates the
input signal. The following figure illustrates the appearance of
the block in each case.
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See Also Proof Objective, Test Condition
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Purpose

Library

Description

true

¥ E

Define objectives that signals must satisfy when proving model
properties

Simulink Design Verifier

When operating in property proving mode, Simulink Design Verifier
proves that properties of your model satisfy specified criteria (see
Chapter 7, “Proving Properties of a Model”). In this mode, you can use
Proof Objective blocks to define proof objectives for signals in your
model. The Values parameter lets you specify values that a signal must
achieve for at least one time step during a proof. The block applies the
specified Values parameter to its input signal, and Simulink Design
Verifier proves or disproves that the properties of your model satisfy
specified criteria.

The block’s parameter dialog box also allows you to

e Enable or disable the objective.

® Specify that the block should display its Values parameter in the
model editor.

® Specify that the block should display its output port.

Note Simulink and Real-Time Workshop ignore the Proof Objective
block during model simulation and code generation, respectively.
Simulink Design Verifier uses the Proof Objective block only when
proving model properties.

Specifying Proof Objectives

Use the Values parameter to define values that a signal must achieve
during a proof simulation. Specify any combination of scalars and
intervals in the form of a MATLAB cell array (see “Cell Arrays” in
the MATLAB documentation for information about working with cell
arrays).



Proof Objective

Tip If the Values parameter specifies only one scalar value, you do not
need to enter it in the form of a MATLAB cell array.

Scalar values each comprise a single cell in the array, for example:
{0, 5}

A closed interval comprises a two-element vector as a cell in the array,
where each element specifies an interval endpoint:

{1, 21}

Alternatively, you can specify scalar values using the S1dv.Point
constructor, which accepts a single value as its argument. You can
specify intervals using the S1dv.Interval constructor, which requires
two input arguments, i.e., a lower bound and an upper bound for the
interval. Optionally, you can provide one of the following strings as a
third input argument that specifies inclusion or exclusion of the interval
endpoints:

e '()' — Defines an open interval.

® '[]' — Defines a closed interval.

e '(]' — Defines a left-open interval.
e '[)' — Defines a right-open interval.

Note By default, S1dv.Interval considers an interval to be closed if
you omit its third input argument.

As an example, the Values parameter
{0, [1, 3]}

specifies:
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Data Type
Support

10-10

® 0 — a scalar

e [1, 3] — a closed interval

The Values parameter

{Sldv.Interval(0, 1, '[)'), Sldv.Point(1)}

specifies:

® Sldv.Interval(0, 1, '[)') — the right-open interval [0, 1)

® Sldv.Point(1) — a scalar

If you specify multiple scalars and intervals for a Proof Objective block,
Simulink Design Verifier combines them using a logical OR operation
during the property proof. In this case, Simulink Design Verifier
considers the entire proof objective to be satisfied if any single scalar or
interval is satisfied.

The Proof Objective block accepts signals of all built-in data types
supported by Simulink. For a discussion on the data types supported
by Simulink, see “Data Types Supported by Simulink” in the Simulink
documentation.
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Parameters
and

Dialog

Box

E! Function Block Parameters: Proof Dbjective x|

— Design Yenhier Proaf Objective [mask)

Froves signal walues using Simulink. D'eszign Yenfier. The “alues' parameter zpecifies
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every bime step.

Example Values:

true
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{5Idv. Interval[-2, -1], Sldv. Paint(0), Sldv. Intervall0, 1, 1. 1}

— Parameter
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0k I Cancel Help Apply

Enable

Specify whether the block is enabled. If selected (the default),
Simulink Design Verifier uses the block when proving properties
of a model. Clearing this option disables the block, that is, causes
Simulink Design Verifier to behave as if the Proof Objective block
did not exist. If this option is not selected, the block appears

grayed out in the model editor.
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See Also
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Type
Specify whether the block behaves as a Proof Objective or Test
Objective block. Select Test Objective to transform the Proof
Objective block into a Test Objective block.

Values
Specify the proof objective (see “Specifying Proof Objectives” on
page 10-8).

Display values
Specify whether the block displays the contents of its Values
parameter in the model editor. By default, this option is selected.

Pass through style
Specify whether the block displays an output port in the model
editor. If selected (the default), the block displays its output port,
allowing its input signal to pass through as the block output. If
not selected, the block hides its output port and terminates the
input signal. The following figure illustrates the appearance of
the block in each case.

Ind In1
i AND AND
Cut Out
—
InZ InZ o
Lagical Lagical
Operatar Operatar
Pass through style: selected Pass through style: deselected

Proof Assumption, Test Objective
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Purpose
Library

Description

true

¥ E

Constrain signal values in test cases
Simulink Design Verifier

When operating in test generation mode, Simulink Design Verifier
produces test cases that satisfy specified criteria (see Chapter 6,
“Generating Test Cases”). In this mode, you can use Test Condition
blocks to define test conditions for signals in your model. The Values
parameter lets you specify constraints on signal values during a test
case simulation. Use the Initial parameter to specify whether the
constraint applies throughout the entire test case simulation or only at
its beginning. The block applies the specified Values parameter to its
input signal, and Simulink Design Verifier attempts to produce test
cases that satisfy the condition.

The block’s parameter dialog box also allows you to

e Enable or disable the condition.

® Specify that the block should display its Values parameter in the
model editor.

® Specify that the block should display its output port.

Note Simulink and Real-Time Workshop ignore the Test Condition
block during model simulation and code generation, respectively.
Simulink Design Verifier uses the Test Condition block only when
generating test cases for a model.

Specifying Test Conditions

Use the Values parameter to constrain signal values in test cases.
Specify any combination of scalars and intervals in the form of a
MATLAB cell array (see “Cell Arrays” in the MATLAB documentation
for information about working with cell arrays).
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Tip If the Values parameter specifies only one scalar value, you do not
need to enter it in the form of a MATLAB cell array.

Scalar values each comprise a single cell in the array, for example:
{0, 5}

A closed interval comprises a two-element vector as a cell in the array,
where each element specifies an interval endpoint:

{1, 21}

Alternatively, you can specify scalar values using the S1dv.Point
constructor, which accepts a single value as its argument. You can
specify intervals using the S1dv.Interval constructor, which requires
two input arguments, i.e., a lower bound and an upper bound for the
interval. Optionally, you can provide one of the following strings as a
third input argument that specifies inclusion or exclusion of the interval
endpoints:

e '()' — Defines an open interval.

® '[]' — Defines a closed interval.

e '(]' — Defines a left-open interval.
e '[)' — Defines a right-open interval.

Note By default, S1dv.Interval considers an interval to be closed if
you omit its third input argument.

As an example, the Values parameter
{0, [1, 3]}

specifies:



Test Condition

Data Type
Support

® 0 — a scalar

e [1, 3] — a closed interval

The Values parameter

{Sldv.Interval(0, 1, '[)'), Sldv.Point(1)}

specifies:

® Sldv.Interval(0, 1, '[)') — the right-open interval [0, 1)

® Sldv.Point(1) — a scalar

If you specify multiple scalars and intervals for a Test Condition block,
Simulink Design Verifier combines them using a logical OR operation
when generating test cases. Consequently, Simulink Design Verifier
considers the entire test condition to be satisfied if any single scalar or
interval is satisfied.

The Test Condition block accepts signals of all built-in data types
supported by Simulink. For a discussion on the data types supported
by Simulink, see “Data Types Supported by Simulink” in the Simulink
documentation.
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Parameters
and

Dialog

Box
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E! Function Block Parameters: Test Condition x|

— Design Verfier Test Condition [mazk)]

Conztrainz zignal values in Simulink Design Yenfhier test cazez. The Walues'
parameter constraing the block input gsignal. Two element vectors specify intervals.
Cell arayz zpecify listz. The zignal muzt zatisfy at least one of the values or interyals
at every hime step unless the Initial' check box iz zselected, when the conztraint
applies only to the first time step

Example ' aluss:
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— Parameter.

¥ Enable
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¥ Display values

¥ Paszz through style [show Outpart)

0k I Cancel Help Apply

Enable

Specify whether the block is enabled. If selected (the default),
Simulink Design Verifier uses the block when generating tests for
a model. Clearing this option disables the block, that is, causes
Simulink Design Verifier to behave as if the Test Condition block
did not exist. If this option is not selected, the block appears

grayed out in the model editor.
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Type
Specify whether the block behaves as a Test Condition or Proof
Assumption block. Select Assumption to transform the Test
Condition block into a Proof Assumption block.

Values
Specify the test condition (see “Specifying Test Conditions” on
page 10-13).

Initial
Specify whether the Values parameter applies at the beginning of
or throughout the entire test case simulation. If selected, the block
constrains only the initial value of its input signal at the start of a
test case simulation (t=0). If not selected (the default), the block
constrains its signal value for the entire test case simulation.

Display values
Specify whether the block displays the contents of its Values
parameter in the model editor. By default, this option is selected.

Pass through style
Specify whether the block displays an output port in the model
editor. If selected (the default), the block displays its output port,
allowing its input signal to pass through as the block output. If
not selected, the block hides its output port and terminates the
input signal. The following figure illustrates the appearance of
the block in each case.

10-17



Test Condition

In4 In1
o
Out Out
—
InZ InZ o
Lagical Lagical
Operatar Operatar
Pass through style: selected Pass through style: deselected
See Also Proof Assumption, Test Objective
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Purpose
Library

Description

true

¥ E

Define custom objectives that signals must satisfy in test cases
Simulink Design Verifier

When operating in test generation mode, Simulink Design Verifier
produces test cases that satisfy specified criteria (see Chapter 6,
“Generating Test Cases”). In this mode, you can use Test Objective
blocks to define custom test objectives for signals in your model. The
Values parameter lets you specify values that a signal must achieve for
at least one time step during a test case simulation. The block applies
the specified Values parameter to its input signal, and Simulink Design
Verifier attempts to produce test cases that satisfy the objective.

The block’s parameter dialog box also allows you to

e Enable or disable the objective.

® Specify that the block should display its Values parameter in the
model editor.

® Specify that the block should display its output port.

Note Simulink and Real-Time Workshop ignore the Test Objective
block during model simulation and code generation, respectively.
Simulink Design Verifier uses the Test Objective block only when
generating test cases for a model.

Specifying Test Obijectives

Use the Values parameter to define custom objectives that signals must
satisfy in test cases. Specify any combination of scalars and intervals
in the form of a MATLAB cell array (see “Cell Arrays” in the MATLAB
documentation for information about working with cell arrays).
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Tip If the Values parameter specifies only one scalar value, you do not
need to enter it in the form of a MATLAB cell array.

Scalar values each comprise a single cell in the array, for example:
{0, 5}

A closed interval comprises a two-element vector as a cell in the array,
where each element specifies an interval endpoint:

{1, 21}

Alternatively, you can specify scalar values using the S1dv.Point
constructor, which accepts a single value as its argument. You can
specify intervals using the S1dv.Interval constructor, which requires
two input arguments, i.e., a lower bound and an upper bound for the
interval. Optionally, you can provide one of the following strings as a
third input argument that specifies inclusion or exclusion of the interval
endpoints:

e '()' — Defines an open interval.

® '[]' — Defines a closed interval.

e '(]' — Defines a left-open interval.
e '[)' — Defines a right-open interval.

Note By default, S1dv.Interval considers an interval to be closed if
you omit its third input argument.

As an example, the Values parameter
{0, [1, 3]}

specifies:



Test Objective

Data Type
Support

® 0 — a scalar

e [1, 3] — a closed interval

The Values parameter

{Sldv.Interval(0, 1, '[)'), Sldv.Point(1)}

specifies:

® Sldv.Interval(0, 1, '[)') — the right-open interval [0, 1)

® Sldv.Point(1) — a scalar

The Test Objective block accepts signals of all built-in data types
supported by Simulink. For a discussion on the data types supported

by Simulink, see “Data Types Supported by Simulink” in the Simulink
documentation.
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Parameters E! Function Block Parameters: Test Objective x|
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Enable
Specify whether the block is enabled. If selected (the default),
Simulink Design Verifier uses the block when generating tests for
a model. Clearing this option disables the block, that is, causes
Simulink Design Verifier to behave as if the Test Objective block
did not exist. If this option is not selected, the block appears
grayed out in the model editor.

Type
Specify whether the block behaves as a Test Objective or Proof
Objective block. Select Proof Objective to transform the Test
Objective block into a Proof Objective block.
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See Also

Values
Specify the test objective (see “Specifying Test Objectives” on page
10-19).

Display values
Specify whether the block displays the contents of its Values
parameter in the model editor. By default, this option is selected.

Pass through style
Specify whether the block displays an output port in the model
editor. If selected (the default), the block displays its output port,
allowing its input signal to pass through as the block output. If
not selected, the block hides its output port and terminates the
input signal. The following figure illustrates the appearance of
the block in each case.
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Cut Out
—
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Pass through style: selected Pass through style: deselected

Proof Objective, Test Constraint
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Verification Subsystem

Purpose Represent subsystem that specifies proof or test objectives without
impacting simulation results or generated code
Librclry Simulink Design Verifier
Description This block is a Subsystem block that is preconfigured to serve as a
starting point for creating a subsystem that specifies proof or test
= objectives for use with Simulink Design Verifier. Real-Time Workshop
ignores Verification Subsystem blocks during code generation, behaving

Verification Gubsystem @S if the subsystems do not exist. A Verification Subsystem block allows
you to add Simulink Design Verifier components to a model without
affecting its generated code.

To create a Verification Subsystem in your model:

1 Copy the Verification Subsystem block from the Simulink Design
Verifier library into your model.

2 Open the Verification Subsystem block by double-clicking it.

3 In the Verification Subsystem window, add blocks that specify proof
or test objectives. Use Inport blocks to represent input from outside
the subsystem.

The Verification Subsystem block in the Simulink Design Verifier
library is preconfigured to work correctly. For correct behavior, a
Verification Subsystem block must

¢ Contain no Outport blocks.

¢ Enable its Treat as Atomic Unit parameter.

® Specify its Mask type parameter as VerificationSubsystem.

Note If you alter a Verification Subsystem block so that it no longer
behaves correctly, Simulink Design Verifier displays a warning.
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See the Subsystem block in the Simulink Reference and “Creating
Subsystems” in Using Simulink for more information.

Examples The sldvdemo_debounce_validprop demo model includes a Verification

Subsystem that specifies two proof objectives, as shown in the following
figure.
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Verification Subsystem

See Also Proof Assumption, Proof Objective, Test Constraint, Test Objective
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l 1 Configuration Parameters

The following table lists parameters that you can use to configure the behavior
of Simulink Design Verifier. Use the get param and set_param functions to
retrieve and specify values for these parameters programmatically.

For each parameter listed in the table, the Description column indicates

where you can set its value on the Configuration Parameters dialog box.
The Values column shows the type of value required, the possible values
(separated with a vertical line), and the default value (enclosed in braces).

Parameter

Description

Values

DVAssertions

Set by the Assertion blocks
option on the Design
Verifier > Property
Proving pane of the
Configuration Parameters
dialog box.

'EnableAll' | 'DisableAll’
{'UselLocalSettings'}

DVBlockReplacement

Set by the Apply block
replacements option on the
Design Verifier > Block
Replacements pane of the
Configuration Parameters
dialog box.

‘on' | {'off'}

DVBlockReplacementModel-
FileName

Set by the File path of the
output model option on the
Design Verifier > Block
Replacements pane of the
Configuration Parameters
dialog box.

string

{'$ModelName$ replacement'}

DVBlockReplacementRules-
List

Set by the List of block
replacement rules option
on the Design Verifier

> Block Replacements
pane of the Configuration
Parameters dialog box.

string
{'<FactoryDefaultRules>"'}




Parameter

Description

Values

DVDataFileName

Set by the Data file name
option on the Design
Verifier > Results pane
of the Configuration
Parameters dialog box.

string
{'$ModelName$_sldvdata'}

DVDisplayReport

Set by the Display report
option on the Design
Verifier > Report pane
of the Configuration
Parameters dialog box.

{'on'} | 'off'

DVDisplayUnsatisfiable-
Objectives

Set by the Display
unsatisfiable test
objectives option on the
Design Verifier pane of the
Configuration Parameters
dialog box.

{'on'} | 'off'

DVHarnessModelFileName

Set by the Harness model
file name option on the
Design Verifier > Results
pane of the Configuration
Parameters dialog box.

string
{'$ModelName$ harness'}

DVMakeOutputFilesUnique

Set by the Make output file
names unique by adding
a suffix check box on the
Design Verifier pane of the
Configuration Parameters
dialog box.

{'on'} | 'off'

DVMaxProcessTime

Set by the Maximum
analysis time option on the
Design Verifier pane of the
Configuration Parameters
dialog box.

double {'600'}
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Parameter Description Values

DVMaxTestCaseSteps Set by the Maximum test int32 {'500'}
case steps option on the
Design Verifier > Test
Generation pane of the
Configuration Parameters
dialog box.

DVMaxViolationSteps Set by the Maximum int32 {'20'}
violation steps option
on the Design Verifier
> Property Proving
pane of the Configuration
Parameters dialog box.

DVMode Set by the Mode option {'TestGeneration'} |
on the Design Verifier '"PropertyProving'
pane of the Configuration
Parameters dialog box.

DVModelCoverageObjectives| Set by the Model coverage | 'None' | 'Decision' |
objectives option on the 'ConditionDecision' |
Design Verifier > Test {'MCDC '}

Generation pane of the
Configuration Parameters

dialog box.
DVOutputDir Set by the Output directory | string
option on the Design {'sldv_output/$ModelName$'}

Verifier pane of the
Configuration Parameters
dialog box.

DVParameters Set by the Apply {'on'} | 'off'
parameters option on
the Design Verifier >
Parameters pane of the
Configuration Parameters
dialog box.
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Parameter

Description

Values

DVParametersConfigFile-
Name

Set by the Parameter
configuration file option
on the Design Verifier >
Parameters pane of the
Configuration Parameters
dialog box.

string
{'sldv_params_template.m'}

DVProofAssumptions Set by the Proof 'EnableAll' | 'DisableAll’ |
assumptions option on {'UselLocalSettings'}
the Design Verifier
> Property Proving
pane of the Configuration
Parameters dialog box.
DVProvingStrategy Set by the Strategy option 'FindViolation'
on the Design Verifier | {'Prove'} |
> Property Proving 'ProveWithViolationDetection'
pane of the Configuration
Parameters dialog box.
DVReportFileName Set by the Report file string {'$ModelName$ report'}

name option on the
Design Verifier > Report
pane of the Configuration
Parameters dialog box.

DVReportIncludeGraphics

Set by the Include screen
shots and plots option
on the Design Verifier

> Report pane of the
Configuration Parameters
dialog box.

‘on' | {'off'}

DVSaveDataFile

Set by the Save test

data to file option on the
Design Verifier > Results
pane of the Configuration
Parameters dialog box.

{'on'} | 'off'
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Parameter

Description

Values

DVSaveHarnessModel

Set by the Save test harness
as model option on the
Design Verifier > Results
pane of the Configuration
Parameters dialog box.

{'on'} | 'off'

DVSaveReport

Set by the Generate report
of the results option on the
Design Verifier > Report
pane of the Configuration
Parameters dialog box.

{'on'} | 'off'

DVTestConditions

Set by the Test conditions
option on the Design
Verifier > Test Generation
pane of the Configuration
Parameters dialog box.

'EnableAll' | 'DisableAll’
{'UseLocalSettings'}

DVTestObjectives

Set by the Test objectives
option on the Design
Verifier > Test Generation
pane of the Configuration
Parameters dialog box.

'EnableAll' | 'DisableAll’
{'UselLocalSettings'}

DVTestSuiteOptimization

Set by the Test suite
optimization option on the
Design Verifier > Test
Generation pane of the
Configuration Parameters
dialog box.

{'CombinedObjectives'} |
‘IndividualObjectives’
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12 Simulink Block Support

The following table summarizes Simulink Design Verifier support for
Simulink blocks. For each block, the third column indicates any support notes
(SNs), which provide information you will need when using the block with
Simulink Design Verifier. All support notes appear at the end of the table.

Sublibrary Block Support Notes
Additional Math and | Fixed-Point State-Space Not supported
D%screte: sdlefioan Transfer Fen Direct Form 11 Not supported
Discrete

Transfer Fen Direct Form II Time Varying Not supported

Unit Delay Enabled —

Unit Delay Enabled External IC —

Unit Delay Enabled Resettable —

Unit Delay Enabled Resettable External IC —

Unit Delay External IC —

Unit Delay Resettable =

Unit Delay Resettable External IC —

Unit Delay With Preview Enabled —

Unit Delay With Preview Enabled Resettable | —

Unit Delay With Preview Enabled Resettable | —
External RV

Unit Delay With Preview Resettable —

Unit Delay With Preview Resettable External | —

RV
Additional Math Decrement Real World —
and Discrete:
Increment/Docrement Decrement Stored Integer

Decrement Time To Zero Not supported

Decrement To Zero —

Increment Real World —

Increment Stored Integer —

12-2



Sublibrary Block Support Notes

Continuous Derivative Not supported
Integrator Not supported
State-Space Not supported
Transfer Fen Not supported
Transport Delay Not supported
Variable Time Delay Not supported
Variable Transport Delay Not supported
Zero-Pole Not supported

Discontinuities Backlash Not supported

Coulomb & Viscous Friction

Not supported

Dead Zone

Not supported

Dead Zone Dynamic

Hit Crossing

Quantizer

Rate Limiter

Rate Limiter Dynamic

Relay

Not supported

Saturation

Saturation Dynamic

Wrap To Zero
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Sublibrary

Block

Support Notes

Discrete

Difference

Discrete Derivative

Discrete Filter

Not supported

Discrete State-Space

Not supported

Discrete Transfer Fen

Not supported

Discrete Zero-Pole

Not supported

Discrete-Time Integrator

First-Order Hold

Integer Delay

Not supported

Memory

Tapped Delay

Not supported

Transfer Fen First Order

Transfer Fcn Lead or Lag

Transfer Fen Real Zero

Unit Delay

Weighted Moving Average

Not supported

Zero-Order Hold




Sublibrary Block Support Notes
Logic and Bit Bit Clear —
Operations Bit Set _

Bitwise Operator

Combinatorial Logic

Not supported

Compare To Constant

Compare To Zero

Detect Change

Detect Decrease

Detect Fall Negative

Detect Fall Nonpositive

Detect Increase

Detect Rise Nonnegative

Detect Rise Positive

Extract Bits

Interval Test

Interval Test Dynamic

Logical Operator

Relational Operator

Shift Arithmetic

Not supported
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Sublibrary Block Support Notes
Lookup Tables Cosine Not supported
Direct Lookup Table (n-D) Not supported
Interpolation Using Prelookup Not supported
Lookup Table SN1
Lookup Table (2-D) SN1
Lookup Table (n-D) SN1, SN2, SN5
Lookup Table Dynamic Not supported
Prelookup Not supported
Sine Not supported
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Block

Support Notes

Math Operations

Abs

Add

Algebraic Constraint

Not supported

Assignment

Bias

Complex to Magnitude-Angle

Complex to Real-Imag

Divide

Dot Product

Not supported

Gain

Magnitude-Angle to Complex

Not supported

Math Function

SN3

Matrix Concatenate

MinMax

MinMax Running Resettable

Permute Dimensions

Polynomial

Product

Product of Elements

Real-Imag to Complex

Not supported

Reshape

Rounding Function

Sign
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Sublibrary

Block

Support Notes

Math Operations
(continued)

Sine Wave Function

Not supported

Slider Gain

Squeeze

Subtract

Sum

Sum of Elements

Trigometric Function

Not supported

Unary Minus

Not supported

Vector Concatenate

Weighted Sample Time Math

Not supported

Model Verification

Assertion

Check Discrete Gradient

Check Dynamic Gap

Check Dynamic Lower Bound

Check Dynamic Range

Check Dynamic Upper Bound

Check Input Resolution

Check Static Gap

Check Static Lower Bound

Check Static Range

Check Static Upper Bound




Sublibrary

Block

Support Notes

Ports & Subsystems

Atomic Subsystem

Code Reuse Subsystem

Configurable Subsystem

Enabled Subsystem

Enabled and Triggered Subsystem

For Iterator Subsystem

Function-Call Generator

Function-Call Subsystem SN7

If —

If Action Subsystem =

Model Not supported
Subsystem —

Switch Case

Switch Case Action Subsystem

Triggered Subsystem

While Iterator Subsystem
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Sublibrary

Block

Support Notes

Signal Attributes

Bus to Vector

Data Type Conversion

Data Type Conversion Inherited

Data Type Duplicate

Data Type Propogation

Data Type Scaling Strip

IC

Probe

Not supported

Rate Transition

Signal Conversion

Signal Specification

Weighted Sample Time

Not supported

Width

Not supported
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Signal Routing

Block Support Notes
Bus Assignment SN6
Bus Creator SN6
Bus Selector SN6

Data Store Memory

Data Store Read

Data Store Write

Demux

Environment Controller

From

Goto

Goto Tag Visibility

Index Vector

Manual Switch

Merge

Multiport Switch

Mux

Selector

Switch
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Sublibrary

Block

Support Notes

Sinks

Display

Floating Scope

Outport (Outl)

Scope

Stop Simulation

Not supported

Terminator

To File

To Workspace

XY Graph
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Block

Support Notes

Sources

Band-Limited White Noise

Not supported

Chirp Signal

Not supported

Clock

Constant

Counter Free-Running

Counter Limited

Digital Clock

From File

Not supported

From Workspace

Not supported

Ground

Inport (In1)

Pulse Generator

Not supported

Ramp

Random Number

Not supported

Repeating Sequence

Not supported

Repeating Sequence Interpolated

Not supported

Repeating Sequence Stair

Signal Builder

Not supported

Signal Generator

Not supported

Sine Wave

Not supported

Step

Uniform Random Number

Not supported
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Sublibrary Block Support Notes
User-Defined Embedded MATLAB Function Not supported
Fen SN4
Level-2 M-file S-Function Not supported
MATLAB Fcn Not supported
S-Function Not supported
S-Function Builder Not supported
Symbol Note
— Simulink Design Verifier supports the block and requires no special notes.
SN1 Input and output must have the same data type, either single or double.
SN2 Cannot specify either the Interpolation method or the Extrapolation method
parameter as Cubic Spline.
SN3 Supports only mod and reciprocal options for Function parameter.
SN4 Supports all operators except *, and supports only the mathematical functions
abs, ceil, fabs, and floor.
SN5 Supports only Number of table dimensions that specify either 1 or 2.
SN6 Supports only virtual signal buses.
SN7 Supports only scalar signals that trigger execution of Function-Call Subsystems.
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analysis model
The target model for a Simulink Design Verifier analysis. If you select
an atomic subsystem for analysis, the analysis model is generated by
extracting the subsystem to a new model.

assumption
A property that is assumed to be true during a property proof. The proof
result holds only when the assumption is true.

block replacement rule
A rule that is registered with Simulink Design Verifier and defines
how instances of specific blocks will be replaced by an alternate
implementation. Simulink Design Verifier uses M-code to define when
and how to apply a block replacement rule (see Chapter 3, “Working
with Block Replacements”).

condition coverage
Measures the percentage of the total number of logic conditions
associated with logical model objects that the simulation actually
exercised. See “Using Model Coverage” in the Simulink Verification
and Validation User’s Guide.

constraint
A property that is forced to be true during test case generation.

counterexample
A test case that demonstrates a property violation.

coverage objective
A test objective that defines when a coverage point results in a
particular outcome.

coverage point
A decision, condition, or MCDC expression associated with a model
object. Each coverage point has a fixed number of mutually exclusive
outcomes.
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decision coverage
Measures the percentage of the total number of simulation paths
through model objects that the simulation actually traversed. See
“Using Model Coverage” in the Simulink Verification and Validation
User’s Guide.

floating-point approximation
The process of approximating floating-point numbers using rational
numbers (i.e., fractions whose numerator and denominator are
small integers). Simulink Design Verifier performs floating-point
approximations during its analysis. It can generate invalid test cases
that result from numerical differences. For example, given a sufficiently
large floating-point number x, the expression x==(x+1) will be true;
however, this expression will never hold if x is a rational number.

invalid test case
A test case that does not satisfy its objectives.

Modified Condition/Decision Coverage (MCDC)
Measures the independence of logical block inputs and transition
conditions associated with logical model objects during the simulation.
See “Using Model Coverage” in the Simulink Verification and Validation
User’s Guide.

nonlinear arithmetic
A computation in the model that cannot be expressed as a combination
of mutually exclusive linear expressions. Nonlinear arithmetic can
affect a property or test objective, and it can cause the analysis to return
an error. In this case, you should apply simplifying approximations
and abstractions.

property
A logical expression of the signals and data values, within a model, that
is intended to be proven true during simulation. Properties evaluate at
specific points in the model.

property violation
The condition during a simulation when a property is false.
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test case
A sequence of numeric values and input data time that you input to a
model during its simulation.

test harness
A model that runs test cases on an analysis model.

test objective
A logical expression of the signals and data values, within a model, that
is intended to be true at least once in the resulting test case during
simulation. Test objectives evaluate at specific points in the model.

Test Objective block
The block that you add to a model to define test objectives. In the block
mask, define test objectives as values or ranges that an input signal
must satisfy during a test case.

unsatisfiable test objective
The status of a test objective that indicates a test case cannot be
generated for the specified approximations. This includes floating-point
approximations and maximum-step limitations specified in the Test
Generation pane of the Configuration Parameters dialog box.

validated property
The status of a property that indicates no counterexample exists,

subject to floating-point approximations and the settings specified in the
Property Proving pane of the Configuration Parameters dialog box.
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Use this list to find examples in the documentation.



B Examples

Working with Block Replacements

“Constructing Replacement Blocks” on page 3-7
“Writing Block Replacement Rules” on page 3-10
“Configuring Block Replacements” on page 3-14

Specifying Parameter Configurations

“Constructing the Example Model” on page 4-7
“Parameterizing the Constant Block” on page 4-9
“Specifying a Parameter Configuration” on page 4-11
“Analyzing the Example Model” on page 4-12
“Simulating the Test Cases” on page 4-14

Generating Test Cases

“Constructing the Example Model” on page 6-4

“Checking Compatibility of the Example Model” on page 6-6
“Configuring Test Generation Options” on page 6-9
“Analyzing the Example Model” on page 6-12

“Customizing Test Generation” on page 6-20

“Reanalyzing the Example Model” on page 6-24

Proving Properties of a Model

“Constructing the Example Model” on page 7-5
“Instrumenting the Example Model” on page 7-9
“Configuring Property Proving Options” on page 7-12
“Analyzing the Example Model” on page 7-14
“Customizing the Example Proof” on page 7-22
“Reanalyzing the Example Model” on page 7-24



block replacements
configuration 3-14
example 3-7
execution 3-15
factory defaults 3-3
introduction 3-2
template 3-6

block support
limitations 2-2
summary 12-2

C

configuration parameters
block replacements 5-6
Design Verifier 5-5
parameters 5-8
property proving 5-10
report 5-14
results 5-12
summary 11-2
test generation 5-9

M

model compatibility
checking 2-5

P

parameter configurations
example 4-7
introduction 4-2
syntax 4-4
template 4-3
Proof Assumption block 10-2
Proof Objective block 10-8
property proofs
example 7-4

introduction 7-2
Stateflow actions 7-2
workflow 7-3

S

Simulink Design Verifier
model parameters 11-2
running demo 1-6
workflow 1-17
Simulink Design Verifier data files
anatomy 8-21
simulation 8-25
Simulink Design Verifier options
saving 5-15
viewing 5-2
Simulink Design Verifier report
table of contents 8-6
Simulink Design Verifier reports
approximations 8-20
block replacements summary 8-12
summary 8-7
test cases/counterexamples 8-17
test/proof objectives 8-12
title 8-6
sldvblockreplacement function 9-2
sldvcompat function 9-3
sldvextract function 9-5
sldvgencov function 9-6
sldvharnessmerge function 9-7
sldvoptions function 9-8
sldvrun function 9-14
sldvruntest function 9-16
system requirements 1-3

T

test case generation
example 6-4
introduction 6-2
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Stateflow actions 6-2 U
workflow 6-3 unsupported features
Test Condition block 10-13 Simulink 2-2
test harness models Stateflow 2-3
anatomy 8-2
simulation 8-5
\"4

Test Objective block 10-19
Verification Subsystem block 10-24
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